USER'S GUIDE

Step-by-step instructions for:
Managing your workspace
Working with files and disks
Using applications
Working with text and graphics
Sending mail and faxes
Plus: A complete reference

NEXTSTEP
Object-Oriented Software
We at NeXT have tried to make the information contained in this manual as accurate and reliable as possible. Nevertheless, NeXT disclaims any warranty of any kind, whether express or implied, as to any matter whatsoever relating to this manual, including without limitation the merchantability or fitness for any particular purpose. NeXT will from time to time revise the software described in this manual and reserves the right to make such changes without obligation to notify the purchaser. In no event shall NeXT be liable for any indirect, special, incidental, or consequential damages arising out of purchase or use of this manual or the information contained herein.

Copyright © 1992–1994 NeXT Computer, Inc., 900 Chesapeake Drive, Redwood City, CA 94063. All rights reserved.

NEXTSTEP Release 3 copyright © 1988–1994 NeXT Computer, Inc. All rights reserved.

Certain portions of the software are copyrighted by third parties.

NeXT, the NeXT logo, NEXTSTEP, the NEXTSTEP logo, NeXTmail, Digital Librarian, Digital Webster, Lip Service, and Workspace Manager are trademarks of NeXT Computer, Inc. PostScript is a registered trademark of Adobe Systems, Inc. Macintosh is a registered trademark of Apple Computer, Inc. VT100 is a trademark of Digital Equipment Corporation. Webster’s Ninth New Collegiate Dictionary, Collegiate, and Wreath & Monogram are registered trademarks of Merriam-Webster Inc. and used herein pursuant to license. Novell and NetWare are registered trademarks of Novell, Inc. Helvetica and Times are registered trademarks of Linotype AG and/or its subsidiaries. PANTONE is a registered trademark of Pantone, Inc. UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Limited. All other trademarks mentioned belong to their respective owners.

U.S. Pat. No. 4,982,343. Other patents pending.

Restricted Rights Legend: Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 [or, if applicable, similar clauses at FAR 52.227-19 or NASA FAR Supp. 52.227-86].

PANTONE® Computer Video simulations used in this product may not match PANTONE-identified solid color standards. Use current PANTONE Color Reference Manuals for accurate color.

*Pantone, Inc.’s check-standard trademark for color.

Written and edited by Helen Casabona, Kathleen Vian, and Roy West
Book design by Jeff Yaksick
Illustrations by Nancy Serpiello and Jeff Yaksick
Production by Jennifer Sherer and Adrienne Wong
Localization management by Jennifer Yu
With help from John Hammett and Chona Reyes
User publications management by Gary Miller
Cover design by CKS Partners, San Francisco, California

This manual was designed, written, and produced with NEXTSTEP. Proofs were printed on a NeXT 400 dpi Laser Printer. Final pages were transferred directly from NEXTSTEP files to film using NEXTSTEP computers and an electronic imagesetter.
Emily Bright releases first album:

*Git on down the road*

Bright’s first album is a bright spot on a stormy horizon. The ten-year-old singer from the streets of Chicago combines the aching old-time blues with a searing message from her generation. But ice—full of energy and open-throated passion—doesn’t let you stay in despair. It makes you want to make a difference.

The cut is a tribute to old-time blues legend, Skip James, but Bright is becoming a legend in her own right. Bright learned her craft hanging outside the backdoors of bars and clubs on Chicago’s South Side. The message from kids like herself, kids living on the streets. The age is not what you might expect. These kids are not just looking for a dealer or a dealer. They’re looking for a future, not only for themselves but the planet. And Bright sings the message loud and clear.
You’ve got all the pieces put together. Now you want to know how to do something, anything. Just turn the page.

Or maybe you want to start fast, learn the basics, and get on with your work. See the *Quick Start* book.

You want to learn as you go? Choose Info from the main menu and then choose Help.

Wait a minute. You haven’t even got the thing out of the box? You need set-up instructions. See the owner’s guide for your computer and, if necessary, *Installing and Configuring NEXTSTEP*.

*The NEXTSTEP workspace is a complete environment with color, sound, graphics, text, and the intelligence to support the most extraordinary tasks—as well as your day-to-day work.*
The Workspace

It's like learning anything. You start with the basics. In this case, the basics are the work session and the space you do it in—the workspace. And then, of course, there's Workspace Manager.

Workspace Manager, well, manages. It opens and closes windows to get you from one task to another. It starts up applications—the tools you use to do your work. And it keeps track of files and folders, which contain the fruits of your labors.

Sure, you'll be churning out works of genius in no time. You just need to settle into your workspace first.

Chapter 1: Starting and Ending a Work Session

3

Chapter 2: Working with Windows

19

Types of Windows 20

Selecting a window to work in

22

Reordering windows that overlap

23

More Ways to Reorder Windows 23

Moving a window

24

Resizing a window

25

Scrolling to see more

26

Ways to Scroll—A Summary 26

Miniaturizing a window

28

Closing a window

29
<table>
<thead>
<tr>
<th>Chapter 3: Using the File Viewer</th>
<th>Chapter 4: Working with Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>55</td>
</tr>
<tr>
<td>Opening a folder</td>
<td>Starting up an application from the dock</td>
</tr>
<tr>
<td>34</td>
<td>56</td>
</tr>
<tr>
<td>Opening a file</td>
<td>Running several applications</td>
</tr>
<tr>
<td>36</td>
<td>57</td>
</tr>
<tr>
<td>Which Application Opens a File</td>
<td>Switching to another application</td>
</tr>
<tr>
<td>38</td>
<td>58</td>
</tr>
<tr>
<td>Icons in the File System</td>
<td>Hiding an application</td>
</tr>
<tr>
<td>39</td>
<td>59</td>
</tr>
<tr>
<td>Browsing files and folders</td>
<td>Customizing the application dock</td>
</tr>
<tr>
<td>40</td>
<td>60</td>
</tr>
<tr>
<td>Listing files and folders</td>
<td>When You Want to Locate a Docked Application</td>
</tr>
<tr>
<td>41</td>
<td>61</td>
</tr>
<tr>
<td>What You Find Out in Listing View</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>62</td>
</tr>
<tr>
<td>Stocking the shelf</td>
<td>Starting up an application automatically</td>
</tr>
<tr>
<td>43</td>
<td>63</td>
</tr>
<tr>
<td>Opening folders and files by typing</td>
<td>Requesting the service of another application</td>
</tr>
<tr>
<td>44</td>
<td>64</td>
</tr>
<tr>
<td>Selecting several files and folders</td>
<td>Quitting an application</td>
</tr>
<tr>
<td>46</td>
<td></td>
</tr>
<tr>
<td>Opening a folder in its own window</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
</tr>
<tr>
<td>File Packages—Files That Are Really Folders</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
</tr>
<tr>
<td>Finding files and folders</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
</tr>
<tr>
<td>Shortcuts to Typing Pathnames</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Personalizing your File Viewer</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
</tr>
<tr>
<td>Life on a Network</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
</tr>
<tr>
<td>NetWare Networks</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
</tr>
<tr>
<td>The File System, As Seen in the File Viewer</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
</tr>
</tbody>
</table>
Files, Folders, and Disks

You have to put the stuff somewhere. Preferably where you'll be able to find it the next time you need it.

So you start with files, creating documents in them, saving them, opening and closing them.

Then it's on to folders. Files in folders. Folders in other folders. You move them around. Copy them. Merge them. Replace them.

And disks. Floppy or CD-ROM. For more space, more information, more mobility.

Creating, organizing, tracking. You know the principles. Now you have the tools.
79  Chapter 6: Organizing Your Work
    Permissions Granted  80
79  Creating a folder
81  Renaming a file or folder
    What You Shouldn’t Rename  82
83  Copying a file or folder
84  Moving a file or folder
    When It’s a Copy or a Move  85
86  Replacing a file or folder
87  Merging two folders
    How Merging Saves Time  87
88  Creating a link
    What Is a Link?  89
90  Setting options for copying links
    Options for Copying Links  90
91  Compressing and decompressing a file or folder
92  Deleting a file or folder
93  Retrieving a file or folder from the recycler
94  Handling several files and folders at once
95  Managing several file operations
96  Solving file and folder problems
    The Repeat Box  97
99  Chapter 7: Inspecting Files and Folders
100  Getting information about a file or folder
    When a File Isn’t a File  100
101  Previewing the contents of a file
102  Sorting files and folders
103  Changing the application that opens a file
104  Assigning a file or folder to a new group
105  Changing permissions for a file or folder
107  Chapter 8: Working with Disks
108  Inserting a floppy disk
    What Disks Look Like  109
110  Preparing a new floppy disk
111  Creating a folder window for a disk
    Other Disk Options  111
112  Copying files to or from a disk
    DOS and Macintosh Disks  113
    When a File or Folder Doesn’t Fit on One Floppy Disk  114
115  Reusing a disk
    When You Run Out of Room on Your Hard Disk  116
117  Ejecting a disk
118  Opening and saving files on a floppy disk
Sometimes it seems like things never change. You start out learning the alphabet, shaping those letters, oh, so carefully. Coloring in circles and triangles and squares. And here you are, years later, still worrying about letters and shapes and colors on a page.

But things do change. Now you don’t struggle with pencils, leaky pens, and grubby crayons. Maybe you don’t like the way a letter is shaped. So you just choose a different font. You don’t like the color of a triangle? Click, you’ve got another one.

You wonder what it all means? You look it up in the on-line dictionary.
Maybe your father was a postman.
Maybe you feel a little disloyal. But, oh man, it’s so efficient.

Instant mail delivery anywhere in the world. And not just quick little notes either. These things can be works of art with designer fonts, designer colors, and designer graphics. And voices—you can even send your voice along.

It’s not ordinary mail, you tell yourself. Not the sort of thing your father delivered. They should call it something different. Something like NeXTmail."
Chapter 14: Managing the Mail Application

Deleting messages
Ways to Select Messages 214

Compacting a mailbox to free disk space

Looking up Mail addresses
The Types Column 216
Shortcuts Selecting Addresses 217

Creating a Mail address book

Creating your own group address

Organizing messages in mailboxes
A Mailbox Is a File Package 221

Finding a message

Focusing on a group of messages

Tailoring how you get new messages

Setting a sound to announce new messages

Creating headers for messages you send
Guidelines for Naming Headers 227

Tailoring headers in messages you receive
Preferences for Messages You Send 229
Expert Preferences 230
Printing and Faxing

There are all those little electrical signals running around like crazy in your machine. Your information. You know it's there, right at your fingertips.

Still, sometimes you really want something you can hold in your hands. Printed pages you can stack up to see what you've accomplished in the last ten months. To show others what you've accomplished in the last ten months.

And faxing, well, that's a natural extension of printing, isn't it? Same little electrical signals jogging along the phone lines and landing in formation on a piece of paper at the other end.

Uh-huh. Now where's that Print command?

<table>
<thead>
<tr>
<th>Chapter 15: Printing</th>
<th>233</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing a file for printing</td>
<td>234</td>
</tr>
<tr>
<td>Printing a file</td>
<td>236</td>
</tr>
<tr>
<td>Print Panel Options</td>
<td>237</td>
</tr>
<tr>
<td>Checking the print queue</td>
<td>238</td>
</tr>
<tr>
<td>Managing the print queue</td>
<td>239</td>
</tr>
<tr>
<td>What Happens When You Pause</td>
<td>239</td>
</tr>
<tr>
<td>Saving your pages as a PostScript file</td>
<td>240</td>
</tr>
<tr>
<td>What Is a PostScript File?</td>
<td>240</td>
</tr>
<tr>
<td>Why Save PostScript Files?</td>
<td>241</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 16: Sending Faxes</th>
<th>243</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending a fax</td>
<td>244</td>
</tr>
<tr>
<td>About Fax Phone Numbers</td>
<td>244</td>
</tr>
<tr>
<td>Fax Panel Options</td>
<td>245</td>
</tr>
<tr>
<td>Including a cover sheet</td>
<td>246</td>
</tr>
<tr>
<td>Custom Fax Cover Sheets</td>
<td>247</td>
</tr>
<tr>
<td>Choosing a fax modem</td>
<td>248</td>
</tr>
<tr>
<td>Sending a scheduled fax</td>
<td>249</td>
</tr>
<tr>
<td>Managing the fax queue</td>
<td>250</td>
</tr>
<tr>
<td>Updating fax addresses</td>
<td>251</td>
</tr>
</tbody>
</table>
Your Choice

It's your choice.

You know what software you need on your computer. You know how you want to arrange your workspace, whether or not you want menus hanging around—and which fonts you want in your menus when they are hanging around.

Other things, too. Units of measurement. Language. Keyboard arrangement. System beeps. Mouse options. Who has access and who doesn't. Dozens of choices no one has made for you.

Yeah, you think. This is the way it should be.
Chapter 20: Personalizing Your Workspace

- Starting up the Preferences application
- Hiding menus
- Working in your own language
- Choosing units of measure and paper size
- Working in your own language
- Setting the date
- Changing the fonts on the screen
- Creating Command-key equivalents
- Customizing the Services menu
- Displaying large file systems
- Displaying UNIX files

Chapter 21: Managing Hardware

- Selecting a keyboard arrangement
  - The NeXTUSA Keyboard Arrangement
- Setting the rate for repeating characters
- Changing the responsiveness of the mouse
- Setting the automatic screen dimmer
- Changing the background color of the display
- Adjusting volume and input gain
- Selecting system beeps and warnings
- Managing power consumption
- Setting the computer to turn on automatically
  - Why Turn the Computer On Automatically

Chapter 22: Controlling Access to Your Computer

- Setting a password
  - What Makes a Password Secure
- Setting permissions for new files and folders
- Sharing your workspace
- Sharing your sound system
- Displaying PostScript images securely
- Setting login window options
  - Advanced Login Window Preferences
You could just click for help. But you’ve already got the book in your hand, and it’s sort of nice to see the whole list—menus, commands, and buttons—all summarized, application by application, in a few pages.

Besides, you might want to see all the standard character positions for your keyboard in a single diagram. Or check those nitty-gritty details about transferring NEXTSTEP™ files to a Macintosh or DOS file system.

And then there’s the glossary. What was it you wanted to look up? Was it key window? Or main window?
THE WORKSPACE
When you work with NEXTSTEP, you start your work session by entering the workspace. Once you're in the workspace, you use a mouse and a keyboard to do most of your work—to choose commands from menus, open and close files, start up applications, and get on-line help.
Starting and Ending a Work Session

It’s just you and your new computer. The screen is shiny and dark, waiting for your first move. Closing your eyes, you see prizewinning magazine spreads, earth-shattering breakthroughs in molecular modeling, full-color three-dimensional animations, and vast networks of linked business systems.

All right, so you have to take care of a few other things, first—like selecting a language, checking out the workspace, getting the hang of the mouse. Stuff that will take just a few minutes.

You hold on to your thoughts, open your eyes, and press the power switch. It’s time to begin.
Turning on your computer

1 If your display and other peripheral devices have power switches, turn them on.

2 Press the power switch on your computer.

3 If a message asks you to, type n and press Return to choose NEXTSTEP.

As the computer starts up, various messages appear on the screen. If you have any operating system in your computer in addition to NEXTSTEP, a message asks you to type n and press Return to run NEXTSTEP.

Caution: Don’t turn on the computer when a floppy disk is in the computer’s disk drive, or else NEXTSTEP won’t start up.

If you’re turning on the computer for the first time, you then have to select a language. Otherwise, you either log in or enter your workspace.

While the Computer Is Starting Up

After you turn on the computer, it searches for a set of files known as system files, which it needs in order to operate. It gets these files from a startup disk (or boot disk), and loads them into its internal memory. The startup disk is usually a hard disk in your computer.

While the files are being loaded, the computer displays a list of messages that inform you of its progress.

If the computer is on a network, and it reports a problem with the network or simply doesn’t keep loading the system files, it may not be properly connected to the network. For help, see your system administrator—the person in charge of the computer or network.
Selecting your language

1 Move the mouse to position the cursor over the language you want and click a mouse button.

2 Position the cursor over the name of the keyboard arrangement you want, and click again.

3 Press the Return key.

4 When a second window asks you to confirm your selection, press Return to confirm. Or click the Cancel button in the window and select another language and keyboard.

The first time you turn on your computer after NEXTSTEP is installed, the large window shown below appears. Use it to select the language and keyboard arrangement you want to use.

Caution: If your hard disk or NEXTSTEP partition is 300 megabytes or smaller, select the language you plan to work in. Other languages are deleted from your disk.

If your hard disk or NEXTSTEP partition is larger than 300 megabytes, you can select languages to use later. After clicking your primary language, hold down the Shift key and click the button for each additional language. Your primary language is then marked with an underline.

Try the NeXTUSA Keyboard Arrangement

Instead of the USA keyboard arrangement, you can choose NeXTUSA and get these benefits:

- Keys for adjusting screen brightness and speaker volume.
- A key that turns the computer off.
- An extra Command and Alternate key, making certain tasks easier.

Logging in

1. **Type your user name in the login window.**

   If you work on a network or share your computer with other people, you must log in to use the computer. The login process prevents unauthorized people from using your computer. It also protects your work by allowing only you to access it.

2. **Press Return.**

3. **If you have a password, type it and press Return.**

   When NEXTSTEP finishes starting up, the window shown below appears on your screen. You log in by typing your *user name*, which is either me or one your system administrator gives you. Your system administrator may also give you a temporary password.

   If you make a mistake while typing your user name or password, you can press the Backspace key to back up over the characters you want to retype.

   ![Login Window Diagram]

   **Type your user name here.**

   **The blinking vertical bar shows where you type.**

   If you don’t have a password, you need only to type your user name and press Return to log in. The login window goes away and you enter the workspace.

   If you don’t enter the correct information, the login window shakes and you must try typing your user name again.
If you have a password, pressing Return moves the insertion point to the Password field and you must type your password to log in.

After you enter the correct information, the login window goes away and you enter your workspace. If you don’t enter the correct information, the login window shakes and you must try typing your user name and password again.

If your computer doesn’t initially require logging in, you can make it require logging in by creating a password. Once you have a password, you should change it periodically to reduce the risk of anyone else being able to log in with your user name.

If you leave the computer on while the login window is showing, but you don’t use the mouse or keyboard for a while, the screen’s contents are replaced by the NeXT™ logo. The contents reappear as soon as you start working.

You create and change your password using the Preferences application. See “Setting a Password” in Chapter 22.
Your Workspace

The *workspace* is where you do all your work on your computer. It’s where you both create and organize your creations. When you first enter the workspace, it contains the elements shown below.

Most icons in the application dock represent applications such as *Edit*—a text processor for creating formatted documents—or the electronic *Mail* application. The dock makes it easy to start up applications you use frequently.

Applications present information in windows, which open and close in your workspace. The *File Viewer* is a window that belongs to the Workspace Manager application. The *File Viewer* gives you access to your files, including all your applications.

The Workspace Manager has a menu titled *Workspace*, which lists commands you can choose to make the application do something.

The *cursor* is usually an arrow for pointing to objects, but it can change depending on what you’re doing. Other common forms are:

- An I-beam for editing text
- A spinning disk, or *busy cursor*, which means the application you’re working in is busy and you have to either wait or switch to another application
- A question mark for pointing to something you want to find out about

A menu lists commands you choose to make an application do something.

The cursor is the small black arrow that moves when you move the mouse.

An icon is a small pictorial representation of something, such as a file or application.

The *File Viewer* provides access to your files.

This column of icons is the application dock, or dock, for short.
Using the mouse

1 Move the cursor by sliding the mouse over a smooth, flat surface.

2 Position the cursor on an item such as a button, slider, or icon.

3 Use a mouse button to click, press, drag, or double-click.

Except for typing text, you can do almost everything on the computer with the mouse (or whatever pointing device you’re using). The mouse controls the movement of the cursor. You slide the mouse on your desk or any other smooth, flat surface to point the cursor at something on the screen.

You can normally use either the left or right mouse button—they each have the same effect.

If you run out of room while sliding the mouse, you can lift it and put it back down somewhere else without moving the cursor. No matter how far you move the mouse, the cursor stays on the screen.

Basic Mouse Actions

Once the cursor is pointing to something—it’s over an icon or word, for example—you use a mouse button to perform one of these actions:

**Click** Without moving the mouse, press and release a mouse button.

**Press** Without moving the mouse, press a mouse button and hold it down. Pressing usually has the same effect as repeated clicking.

**Drag** Press and hold down a mouse button. Then move the cursor by sliding the mouse. Finally, release the mouse button.

**Double-click** Click twice in quick succession. This often extends the action caused by a single click. In text editing, for example, clicking once selects a location between characters and clicking twice selects a word. An application may even use triple-clicking, for example, to select a paragraph.

You can use the Preferences application to make one mouse button have a special effect, to adjust the responsiveness of the computer to multiple-clicking, and to adjust the responsiveness of the cursor to mouse movement. See “Hiding Menus” in Chapter 20 and “Changing the Responsiveness of the Mouse” in Chapter 21.
Buttons, Text Fields, and Sliders

Buttons  You often use the mouse to operate buttons in windows to make something happen in an application. Buttons come in all shapes and sizes. They’re labeled with text or graphics to indicate what they do. You click or press a button with the mouse, and the button responds visually—it’s usually highlighted in white until its function is completed.

If you decide that you don’t want to click a button after all, you can move the cursor out of the button before releasing the mouse button.

Clicking a button might turn something on. To turn it off again, you may need to click the button again. A visual clue tells you whether it’s on or off. For example, clicking a button with the image of a book on it may open or close the book.

Clicking a check box button places or removes a check mark in the box.

Pressing a button with a on it displays a pop-up list of options that you can choose from. When printing, for example, you use such a button to choose between automatic paper feed from a cassette or manual paper feed.

Pressing a button with a on it displays a pull-down list of commands that cause actions to occur. You drag the cursor through the list to the option you want and then release the mouse button.

You can click a check box in its label or in the box.
When buttons are grouped together, clicking one to select it might deselect another. Often you can drag through the group and operate one button by releasing the mouse button when the cursor is in it. You can do this in the Preferences application, for example, when selecting one of four rates at which character keys on the keyboard repeat when you hold them down.

A **dimmed** button—shown in gray rather than in black—is currently unavailable for use. For example, the Save button in a panel is dimmed when you haven’t yet typed a name for a file you’re saving.

The \( \text{←} \) symbol in a button means you can operate the button (when it’s not dimmed) by pressing the Return key on the keyboard.

**Text fields** Sometimes telling an application what to do involves typing in a white area called a **text field**. A label indicates the text field’s function.

When you work in a window that contains text fields, an insertion point often appears in the first field, indicating that you can insert text there.

To move the insertion point to another text field, click in the other field. You can also press the Tab key to move to the next field in a window. Or hold down the Shift key and press Tab to go to the previous field.

If you type more than can fit in a text field, text you’ve already typed moves to the left, out of view, so you can see what you’re typing.

**Find:** `creative/grey/Festival/Blue Planet Festival/

You can type past the edge of a text field.

**Find:** `Net/creative/grey/Festival/Blue Planet Festival/

Drag back to the left to see what you already typed.

**Sliders** You sometimes use a slider to specify a setting in a range. Simply move a knob back and forth in a bar by dragging it. Or click in the bar to make the knob jump to the position under the cursor.

If a **text field** next to the slider shows a value representing the current setting, you can type in the field to change the setting.
Choosing commands

To tell an application what to do, you often use commands. Commands appear in menus. Each application has a main menu that appears when you’re working in the application.

Some commands perform an action on something you’ve selected, such as text, an icon, or a window. Other commands open a panel—a small window that may ask for more instructions. Still other commands open another menu, called a submenu.

To find out which is your keyboard’s Command key, see “Keyboard Basics” in Chapter 9.

You can use the Preferences application to make pressing one mouse button put a copy of the main menu under the cursor that you can then drag into to choose a command. See “Hiding Menus” in Chapter 20.
You can also choose a command while dragging through a menu. Start with the cursor pointing to any command, drag to the one you want, and release the mouse button. As you drag through a menu, each command is highlighted in turn. If a command opens a submenu, the submenu stays open until you move to another command.

A submenu normally closes when you choose a command from another menu. If you don't want the submenu to keep closing, you can detach it. The submenu remains open until you close it yourself.

If you press and hold down the mouse button in the command that opened a detached submenu, a copy of the submenu appears that you can drag into to choose a command. When you complete the drag, the copy of the submenu closes.

A dimmed command, shown in gray rather than in black, is currently unavailable. This happens, for example, when the command doesn't apply to what you're currently doing in an application.
Clicking for help

Hold down the F1 key and click any command, window, or panel.

In some applications, you can find out about an item by clicking it with the question mark cursor. You get this cursor by holding down the F1 key.

Clicking with the question mark cursor usually provides help on a command, window, or panel. In some cases, however, you can find out about a specific button or icon in a window by using the question mark to click it.

If your keyboard doesn’t have an F1 key, you can try getting the question mark cursor by holding down the Alternate and Control keys at the same time.
Getting help by topic

1 Choose Info from the application's main menu. You can find out how to do something in an application by selecting a topic from the table of contents in the Help panel.

2 Choose Help from the Info menu.

3 Click a topic in the Help panel.

Click a topic in the table of contents.

To see all topics, you can drag this knob up or down.

Drag this knob to resize the two areas in the panel.

The topic appears here.

You can also click a button to see a related topic.

Buttons in the Help Panel

Three buttons in the Help panel provide other ways to find a topic.

Find You can type a keyword in the text field at the top of the Help panel. Then click Find to view the next topic that contains the keyword. Help is organized like a stack of topics. The Find button searches through the stack starting from the current topic. You can click Find again and again until you find the topic you want.

Index Click this button to view an index of topics in the application. Then click the index entry you want to find out about.

Backtrack Click this button to see the topic you viewed last. Click it again to see the topic before that.
Ending your work session

To log out, choose Log Out from the Workspace menu and click the Log Out button.

To turn off your computer, choose Log Out and click the Power Off button. When a message says it's OK, press the power switch on your computer.

To restart the computer, log out and click the restart button.

At the end of a work session, you can log out to put all your work away. Or if you don't expect to use the computer for a while—such as a day or two—you should turn it off. Before doing either of these things, make sure to save any work you've done in an application.

You log out or turn off the computer with the Log Out command in the menu titled Workspace. If this menu isn't visible, you can make it appear by clicking in the File Viewer, or by double-clicking the NeXT icon at the top of the dock.

When you choose Log Out, a panel opens. If you click Log Out by accident, click Cancel in the panel to make the panel close so you can keep working.

Logging out quits all running applications. If you have unsaved work, another panel asks if you want to save. The login window then appears and you must log in again to reenter the workspace. (If you're not required to log in, logging out just quits all applications, and you reenter the workspace automatically.)

Choosing to turn off the computer first logs you out—if you have any unsaved work, a panel asks if you want to save. After a few moments, a message tells you it's OK to turn off the power.

**Caution:** Don't turn off the power to your computer before a message says it's OK to. Otherwise you might damage your startup disk.

On some computers, power goes off automatically after you click Power Off. If the computer has a floppy disk in its disk drive, logging out, turning off the computer, or restarting removes the disk's contents from the file system. You should then remove the disk from its drive.

If you're using the NeXTUSA keyboard arrangement, you can press a key to turn off the computer. See “The NeXTUSA Keyboard Arrangement” in Chapter 21.

For information on how to save work before logging out or turning off the computer, see Chapter 5, “Creating and Saving Files.”

For some computers, you can use the Preferences application to make the computer turn on automatically after a power failure. See “Setting the Computer to Turn On Automatically” in Chapter 21.
You should restart your computer every few days to free up space on its disk. A panel may even warn you when it’s time to do so. See “When You Run Out of Room on Your Hard Disk” in Chapter 8.

You can also turn the computer off or restart it from the login window.

Restarting the computer reloads its system files, just as when you turn on the computer. You might have to do this after installing new software. When you click the Restart button, a panel asks you to confirm that you really want to restart. It also gives you the choice to restart in another operating system, if one is installed on your startup disk.

**When the Log Out Command Doesn’t Work**

On rare occasions, the computer may have a problem and your actions may have no effect. The cursor might not move and you may not be able to choose commands or operate buttons. Try restarting the computer by holding down the Alternate key and pressing the upper-left key on the numeric keypad (often labeled Num Lock).

This message appears:

Restart or halt? Type r to restart or type h to halt. Type n to cancel.

If you type r, the screen clears and the computer restarts by loading its system files. This method is “safe” for your startup disk, but unsaved work is lost.
In the workspace, you work in windows. Some windows show what's in your files and folders. Others show what options you have. You can have lots of windows open at once—and move from one to another as you work.

Emily Bright's first album is a bright eighteen-year-old singer from the sound of old-time blues with a searing voice—full of energy and open
Working with Windows

You're window shopping—you know, walking down the street to catch a glimpse of the wares in all the stores. A velvet Elvis and the shoulder of a nude in the art gallery. A stack of titles in a bookstore. Pens and palettes in a writing shop. Envelopes in the post office.

Your feet start to ache. You sit on a bench and think about it. What you need are windows that come to you. Windows that you can move around. You’d want to change the view in them, too, to see more goods. Make them larger or smaller. Make them go away.

You shake your head. Then you shake it again when you see the gallery window. Wasn’t it just next to the bookstore? And did that picture of the nude... move? You certainly didn’t see that before.
Types of Windows

Windows can look different from one another, but they generally have a few things in common.

A title bar at the top of the window shows the window's name.

You use scrollers—shaded areas along the left side and sometimes the bottom of a window—to adjust the view in the window when there’s more there than you can currently see.

A resize bar at the bottom of many windows is for changing the window's size.

There are two types of windows: standard windows and panels.

A standard window is where the action in an application occurs. If you’re creating a document, you type in a standard window like the Edit window shown below. The File Viewer is also a standard window—it’s where you do Workspace Manager tasks such as organizing files.

The title bar usually contains one or two buttons for miniaturizing or closing the window.

Scrollers adjust the view when there’s more to see.

A resize bar changes the window's size.
Panels are windows where you tell an application what to do. Often they open when you choose a command, asking you for more instructions or to confirm the command. When you choose to quit an application, for example, a panel might ask if you want to save the changes you just made to the document you were working in.

Some panels act on the contents of a standard window. For example, a Find panel locates specific text in a document.

A panel might also just contain a message.

A panel with a blank title bar (no title or buttons) is an attention panel. When one of these panels opens, you have to respond to it before you can do anything else in the application.
Selecting a window to work in

- **Click in the window where you want to work.**

To work in a window, you make it the *key window*—the window where you type, or that accepts your keystrokes. There's only one key window at a time.

If a panel opens that applies to the standard window you're working in, the panel becomes the key window—its title bar becomes black. So you can tell which window the panel applies to, your standard window then gets a dark gray title bar and is known as the *main window*.

A standard window with a black title bar is both the key window and the main window.
Reordering windows that overlap

- To bring a window forward, click in it.

Or

- Choose Windows from the Workspace menu and then choose the window from the Windows menu.

Like sheets of paper on your desk, windows can overlap or completely cover each other. You bring a window forward so you can work in it by clicking in it.

No windows can cover an attention panel, and menus stay in front of standard windows and ordinary panels.

More Ways to Reorder Windows

You can use keys on the keyboard to reorder windows in special ways. (To find out which are your computer’s Alternate and Command keys, see “Keyboard Basics” in Chapter 9.)

<table>
<thead>
<tr>
<th>Action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold down the Alternate key and click in the window’s title bar</td>
<td>Brings the window forward without making it the key window</td>
</tr>
<tr>
<td>Hold down the Command key and click in the window’s title bar</td>
<td>Sends the window to the back of other windows</td>
</tr>
<tr>
<td>Hold down the Command key and press the up arrow key</td>
<td>Brings the backmost window to the front</td>
</tr>
<tr>
<td>Hold down the Command key and press the down arrow key</td>
<td>Sends the frontmost window to the back</td>
</tr>
</tbody>
</table>

For more information about the Windows menu, see “Standard Commands” in the Reference at the end of this book.
Moving a window

- **Drag the title bar of the window you want to move.**

You can move a window around the screen by dragging its title bar (but don’t press a title bar button). As you drag, the entire window follows the cursor. When the window is where you want it, release the mouse button.

Dragging a window brings it to the front of other windows. It also makes it the key window (unless you hold down the Alternate key while you drag).

You can drag a window anywhere on the screen, even partially off its edge. Since the cursor can’t leave the screen, part of the window’s title bar—the part where the cursor is—always remains visible, and you can drag the window back into full view.
Resizing a window

- To change the width of a window, drag horizontally from either end region of its resize bar.
- To change its height, drag vertically from the middle region.
- To change width and height at the same time, drag diagonally from an end region.

You can make a window larger to see more of its contents or smaller so it takes up less space. You drag its *resize bar*—the narrow gray border along the bottom of most windows.

---

Emily Bright releases first album: Git on down the road

Emily Bright's first album is a bright spot on a stormy horizon. The eighteen-year-old singer from the streets of Chicago combines the aching sound of old-time blues with a soaring message from her generation. But her voice—full of energy and open-hearted passion—doesn't let you wallow in despair. It makes you want to make a difference.
Scrolling to see more

- To scroll one line or other increment, click the scroll button that points in the direction you want to scroll.
- To scroll a “windowful,” hold down the Alternate key and click a scroll button.
- To scroll to an approximate location, drag the scroll knob or click in the bar.

Often there’s more in a window than you can see at once. To see what isn’t visible, you *scroll*. If only one page of a 25-page document is showing, for example, you can scroll to see the other pages. You use a *scroller*.

A scroller works like a slider—you move a knob up and down or back and forth in a bar. You can also click a *scroll button*. Press the button to scroll continuously.

### Ways to Scroll—A Summary

<table>
<thead>
<tr>
<th>Action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click a scroll button</td>
<td>Scrolls an increment</td>
</tr>
<tr>
<td>Press a scroll button</td>
<td>Scrolls continuously by increments</td>
</tr>
<tr>
<td>Alternate-click a scroll button</td>
<td>Scrolls a “windowful”</td>
</tr>
<tr>
<td>Click in the scroll bar</td>
<td>Scrolls directly to any location</td>
</tr>
<tr>
<td>Drag the scroll knob</td>
<td>Scrolls gradually to any location</td>
</tr>
<tr>
<td>Alternate-drag the scroll knob</td>
<td>Scrolls more gradually to any location</td>
</tr>
</tbody>
</table>

To find out which is your keyboard’s Alternate key, see “Keyboard Basics” in Chapter 9.

Some applications have their own buttons for scrolling a page at a time. See the user’s guide that comes with the application.
You can hold down the Alternate key while clicking a scroll button to scroll by just less than the height or width of the current view, showing some of the previous view for context. Other ways to scroll are shown below.

Drag the scroll knob to scan contents as they go by. Hold down the Alternate key while dragging to scroll more gradually.

Click in the scroll bar. The scroll knob jumps to where the cursor is and contents scroll accordingly.

Press and hold down a mouse button in the bar and keep dragging.

The scroll knob’s size and position show how much and what part of the total contents you’re viewing: The scroller represents the length or width of the contents, and the knob represents the portion and location of the current view.

This window shows the middle third of a document.

When you type more, the knob gets shorter.

The size of the scroll knob also changes when you resize the window.
Miniaturizing a window

To miniaturize a window, click the miniaturize button at the left of its title bar.

To get the window back, double-click its miniwindow.

If you want to put a window aside without actually closing it, you can miniaturize it. When you do this, the window shrinks into a miniwindow—an icon that appears at the bottom of the screen.

You can move the miniwindow by dragging it, or click it to bring it to the front. You can’t however, drag it into the dock (as you can an application icon) or into the File Viewer (as you might a file or folder icon).

When you double-click the miniwindow to get the window back, the miniwindow goes away and the window returns as you left it—in its same size and location as though it had never been miniaturized. Unsaved work is still there, too.
Closing a window

- Click the close button at the right of the window's title bar.

When you’re finished with a window, you can close it to get rid of it completely. Unlike miniaturizing, closing a window makes it disappear from the screen.

A partially drawn close button usually means that the window contains unsaved work. When you save, the button returns to normal. If you click the button while it’s partially drawn, a panel asks if you want to save your work. After you respond to the panel, the window closes.

If you close a window without saving changes, the changes won’t be there the next time you open the window.

For information on saving work before closing the window it’s in, see Chapter 5, “Creating and Saving Files.”

You can also close a window by choosing Close Window from the Windows menu. See “Standard Commands” in the Reference at the end of this book.
You keep your work in files and folders. You use the File Viewer to find and open them. The File Viewer shows you files and folders on your own computer as well as those available to you on a network.
You’re wandering through a maze of towering filing cabinets. Gargantuan drawers contain folders stuffed inside folders inside other folders.

Of the thousands of documents stored here, you’re looking for two. One is a newsletter. Another is an illustration for the front page. You point to the folder of newsletters on an electronic map, and—pfffff—you’re whisked through the complex. Seconds later, you’re scanning a list of the folder’s contents.

You open the file with your newsletter. It comes with all the tools you need to edit it. You open the file with the illustration and get tools for working with it. You marvel at how easy it is to find things here.

Now if this whole filing system could just fit on your desk.
Your computer keeps information in files and folders. A file might be a magazine article you write, an illustration you create with a graphics application, or the application itself. A folder can contain other folders, which can contain yet more folders, down to as many levels as you want.

The files and folders in your computer make up its file system. You can think of the computer’s file system as an upside-down tree with a root folder at the top and branches that grow downward.

Each file and folder has a name that identifies its contents. For example, a folder containing applications that come with your computer is named NextApps. A file might be called My diary.rtf.

A file or folder also has a pathname that identifies its location. Its pathname lists the folders along its branch of the file system. Each name is separated by a slash (/). A slash at the beginning of a pathname represents the root folder.

In the tree below, the pathname /Net represents the Net folder. /Net/repertoire/Charts/Billboard.rtf represents the file named Billboard.rtf.

You often identify a file or folder by its pathname. You might type a pathname or read it in a panel.
To get to the files and folders in your computer, you use the File Viewer. The File Viewer is part of the Workspace Manager application. It appears when you enter the workspace and can stay open the whole time you're working.

Files and folders appear as icons. Different areas of the File Viewer have these uses:

- Icons on the **shelf** can provide a shortcut to files and folders you access frequently. The shelf always contains your **home folder**, which is where you keep your own work. You can add or remove other files and folders.

- The **icon path** shows where you are in the file system. This row of icons shows the selected file or folder and the folders above it in its branch of the file system.

- The **bottom area** displays the contents of the **current folder**—the one you're currently working in. When you use your computer for the first time, files and folders here are shown as icons.

When you enter the workspace, you see the contents of your home folder. Your home folder has the icon of a house. Its name is your user name.
Opening a folder

- **Click a folder on the shelf or in the icon path.**
- **Or**
- **Double-click a folder in the current view.**

You open a folder to see its contents. Its contents appear in the bottom area of the File Viewer. When you first use your computer, files and folders here appear as large icons. To see them as large icons if you don’t currently, open the View menu and choose Icon.

With the icon view, you can select a folder without opening it by clicking it in the current view instead of double-clicking it.
The way you move through the file system when you open a folder depends on what part of the File Viewer you open it from.

**Opening a folder from the shelf goes directly to that folder.**

**Opening a folder from the icon path moves up the branch of the file system.**

**Opening a folder that's in the current view moves down the branch.**

Your computer contains UNIX® files that don't appear in the File Viewer unless you make them. See "Displaying UNIX Files" in Chapter 20.
Opening a file

Double-click the file on the shelf, in the icon path, or in the current view.

You open a file to see its contents. The application associated with the file starts up, if it's not already running. It then shows the contents of the file in a window.

If you open a file that is an application, the application simply starts up.

Which Application Opens a File

You can tell which application opens a file by the file icon. Usually, it resembles the application icon. You can also tell by the file name extension—the last period in the name and the characters that follow. The extension describes the type of information in the file. For example, a file in Rich Text Format (RTF) has the extension .rtf. A file with Encapsulated PostScript has an .eps extension. A plain text file has no extension.

For more information, see "Changing the Application that Opens a File" in Chapter 7.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>File Icon</th>
<th>Application Icon</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>.eps</td>
<td>EPS</td>
<td>Preview</td>
<td></td>
</tr>
<tr>
<td>.rtf</td>
<td></td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>
When an application that isn’t in the dock starts up, its icon appears at the bottom of the screen.

If an application is not in the dock, you can drag it to an empty area of the dock.
### Icons in the File System

Different kinds of files and folders have different icons. There are also icons for disks, disk drives, or any other devices that might appear in your file system. Below are some common icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>A general-purpose folder that you can create.</td>
</tr>
<tr>
<td>![Network Folder]</td>
<td>A folder that's on another computer on the network whose contents you can access by opening this folder.</td>
</tr>
<tr>
<td>![Home]</td>
<td>Your root folder.</td>
</tr>
<tr>
<td>![Home]</td>
<td>Your home folder.</td>
</tr>
<tr>
<td>![Other Home]</td>
<td>Someone else's home folder, which you might see if you're working on a network or sharing your computer with other people.</td>
</tr>
<tr>
<td>![Net]</td>
<td>The Net folder, which contains folders on other computers, if your computer is on a network.</td>
</tr>
<tr>
<td>![RTF]</td>
<td>A file in Rich Text Format® (often called an RTF file), which contains text with font and formatting properties, such as bold or italic.</td>
</tr>
<tr>
<td>![RTF]</td>
<td>An RTF file that contains one or more graphic images.</td>
</tr>
<tr>
<td>![Text]</td>
<td>A file that contains only plain text—text with no font or formatting properties.</td>
</tr>
<tr>
<td>![EPS]</td>
<td>A file that contains a graphic image in Encapsulated PostScript® format, often called an EPS file.</td>
</tr>
<tr>
<td>![TIFF]</td>
<td>A file with a graphic image in Tag Image File Format, often called a TIFF file.</td>
</tr>
<tr>
<td>![Application]</td>
<td>An application that doesn't have its own icon.</td>
</tr>
<tr>
<td>![Address Book]</td>
<td>An address book that you can create with the Workspace Manager. See “Looking Up an On-Line Address” in Chapter 12.</td>
</tr>
<tr>
<td>![Compressed]</td>
<td>A file or folder that's been compressed. See “Compressing and Decompressing a File or Folder” in Chapter 6.</td>
</tr>
<tr>
<td>![Installer]</td>
<td>An Installer package—a set of files and folders that you install with the Installer application. See Chapter 19, “Installing New Software.”</td>
</tr>
<tr>
<td>![Folder Dimmed]</td>
<td>A folder is dimmed when you don’t have permission to open it. If you try to open it, no contents appear even if it has some.</td>
</tr>
<tr>
<td>![Broken Link]</td>
<td>A broken link to a file or folder (see Chapter 6 for information on links).</td>
</tr>
<tr>
<td>![Not Running]</td>
<td>An application that can’t be run—for example, because it isn’t configured to run on your type of computer. In the dock, it might be an application that was moved, renamed, or that no longer exists.</td>
</tr>
</tbody>
</table>

For information on other icons, see “NEXTSTEP Applications” in Chapter 4 and “What Disks Look Like” in Chapter 8. You also may see icons for applications you buy or create yourself.
Browsing files and folders

- To see the contents of several folders at once, choose View from the Workspace menu and then choose Browser from the View menu.

- To open a folder, click its name in the browser.

- To open a file, double-click its name in the browser.

Browsing is a way to move quickly through the files and folders in your computer. When you choose Browser, the current view becomes a browser, which lists the contents of each folder in the icon path. The contents are listed by name in the column below the icon.

When you click a folder in a browser, the contents of the folder appear in the column to the right.

You can also open files and folders from the shelf and icon path, just as you can when you're working with other views.
Listing files and folders

- To change to the listing view, choose View from the Workspace menu and then choose Listing from the View menu.

- To open a file or folder, double-click the icon next to its name.

You can list the contents of the current folder to show the size, history, and permissions for files and folders. When you choose Listing, the view changes to show this information.

In the listing view, the icon next to a name indicates whether it's a file, folder, or application:

- marks a folder.
- marks an application.
- marks any other file.

You can also open a file or folder from the shelf or icon path, just as you can when working with other views.

To find out the size of a folder, you have to use the Inspector command. See “Getting Information about a File or Folder” in Chapter 7.
What You Find Out in Listing View

When you display the contents of a folder in the listing view, columns next to each file and folder name provide the following information:

**Size**  The size, in bytes, for files. In a plain text file, for instance, each character occupies one byte.

**Last Changed**  The date and time (based on a 24-hour clock) that the file or folder was created, or that changes were last made to it. Older files list the year instead of the time.

**Permissions**  The read (r), write (w), and execute (x) permissions, successively, for the person who owns the file or folder, a group of people who may have special access to it, and anyone else who has access to the file system. A listing of r-x for the group, for example, means the group has read and execute permissions but not write permission.

**Owner**  The user name of the person who owns the file or folder.

**Group**  The group of users who have the group permissions.

For more information on permissions, see “Changing Permissions for a File or Folder” in Chapter 7.
Stocking the shelf

- To add a folder or file to the shelf, select the folder or file. Then drag it from the icon path to an empty space on the shelf.

- To remove a folder or file from the shelf, drag it out of the File Viewer into the workspace.

You can stock your shelf with folders or files you use frequently. Just drag them from the icon path.

Drag a file or folder into the workspace to remove it from the shelf.

Caution: When you drag a file or folder to add it to the shelf or remove it, don't release the mouse button while the icon you're dragging is over another folder. If you do, you might accidently copy or move the file or folder you're dragging.

You can make more room on your shelf by resizing the File Viewer so it's wider.

You can adjust the number of rows on your shelf. See "Personalizing Your File Viewer" in this chapter.
Opening folders and files by typing

- To move along the current branch of the file system, press the left or right arrow key.
- To move through the contents of a folder in the browser or listing view, press the up or down arrow key.
- To select a specific file or folder in the current folder, type the first few characters of its name.
- To open the selected file or folder, press Return.

You can put your mouse aside and select and open folders and files from the keyboard.

If you make a mistake or change your mind while typing a file or folder name, pause for a moment to start over.

With the browser or listing view, you can use the up and down arrow keys to move through the contents of a folder.

You can locate any file or folder by typing its pathname. As soon as you type a / or ~ to begin the pathname, the Finder opens. See “Options for Searching” in this chapter.
Selecting several files and folders

You can select several files and folders in the current folder and then do something with all of them. For example, you can open several files at the same time by selecting them and double-clicking the selection icon.

You can also hold down the Shift key while dragging around several icons to add all of them to your selection.

To find out which is your keyboard's Alternate key, see "Keyboard Basics" in Chapter 9.
You can drag and use the Shift key to make multiple selections in the browser or listing view, too.

In either the browser or listing view, you can hold down the Shift key while you click a selected file or folder, or while you drag over several, to remove files or folders from the selection.
Opening a folder in its own window

1. Select the folder you want to open.

2. Choose File from the Workspace menu.

3. Choose Open as Folder from the File menu.

You can open a folder in its own window, for example, to keep an eye on the folder’s contents while opening other folders in the File Viewer.

This window is just like the File Viewer except it can show only the contents of the folder you selected. Within this folder, you can open files and folders, drag them to the shelf, and do anything else you do with the File Viewer.
A file package is a special kind of folder whose contents aren't normally shown in the File Viewer or any other folder window. Instead, file packages look and behave like regular files. Double-clicking a file package, for example, starts up an application or shows the contents of a file in a window.

File packages keep together information that shouldn't be separated. When you add a graphic image to an Edit document, for example, Edit puts the graphic in its own file and stores it in a file package along with a file containing the document's text. Most applications are also file packages. They consist of a file containing the actual application and other files that the application uses, such as the clicking sound for the camera in Grab.

You rarely need to see the contents of a file package, and you shouldn't normally change its contents. But to look inside one—for example, to copy something from it—select it in the File Viewer and choose Open as Folder from the File menu.

You can tell that a file is really a file package if:
- The Open as Folder command isn't dimmed when the file is selected. When you select a regular file, this command is dimmed.
- When you inspect the file with the Inspector command, the file is treated as a folder. See “Getting Information about a File or Folder” in Chapter 7.
- The file is an RTF file with an .rtfd extension.
- The file is an application with an .app extension.
Finding files and folders

1 Choose Tools from the Workspace menu.

2 Choose Finder from the Tools menu.

3 Select a target from the Finder’s shelf.

4 Use the pop-up list to choose to search for files and folders by name or for files by content.

5 Type text that’s in the name or contents of what you’re looking for.

6 Click Find or press Return.

You can search for files and folders based on any part of their name. You can also search for files based on a string of text that’s in the file. You tell the Finder where to search by selecting a target. You can drag any folder from the File Viewer to the Finder’s shelf and use it as a target.

You can search for a single file or folder by name—regardless of the target—by typing its entire pathname in the Finder, such as /Net/repertoire/starr or ~starr/Apps. The file or folder is selected in the File Viewer.

During a search, the Find button changes to a stop sign that you can click to interrupt the search.

Shortcuts to Typing Pathnames

Here are a few shortcuts you can use to enter a pathname in the Finder.

- You can specify your home folder with a tilde (~), for example, by typing ~ or ~/Apps. To specify someone else’s home folder, type ~ followed by the name of that person’s home folder, as in ~starr.

- You can type a few characters of a name in a pathname and press the Escape key to fill in the name. To enter /NextApps/Grab, type /NextAp and press Escape, then type /G and press Escape. If more than one name matches what you’ve typed so far, the Finder lists all possible matches each time you press Escape.
To narrow down your search, you can select from the files and folders you find and then search on the selection.

When you search by name, you can double-click a file or folder listed in the Finder to select it in the File Viewer—even while the search is still going on. When you search by content, double-clicking a file listed in the Finder opens the file and selects the text you’re searching for. In either mode, you can also select a file in the Finder and then double-click its icon to open it.

Options for Searching

You can find any file or folder while working in the File Viewer by typing its full pathname. As soon as you type a / or ~, the Finder opens and shows your typing. Complete the pathname and press Return. The file or folder is selected in the File Viewer and the Finder goes away.

You can also press Escape in the File Viewer to enter the pathname of the current selection in the Finder.

If you want the Finder to list a file or folder without selecting it in the File Viewer—for example, so you can drag it to the Finder’s shelf to use as a target—enter the pathname and press Escape instead of Return.

You can Shift-click an item on the shelf to add it to your target. If you forget what’s in a target that consists of a multiple selection, press Escape to list the selection’s contents.

When searching by name, you can use an asterisk (*) as a wildcard. For example, to find all TIFF files within a target, type *.tiff.

To search for names that contain a ~ or *, enclose your text in quotation marks, as in "~oldfile".
Personalizing your File Viewer

1. Choose Info from the Workspace menu.
2. Choose Preferences from the Info menu.
3. Choose the Icon View, Browser, or Shelf option from the pop-up list at the top of the Workspace Manager Preferences panel.
4. Make settings in the panel to adjust spacing between icons or the width of browser columns.

You can adjust spacing in the File Viewer. With the Icon View option, you can adjust the spacing between icons shown in the icon view.

Choose the Icon View option.

Drag an arrow to adjust spacing between icons.

The white field shows the space available for text beneath an icon.

With the Browser option, you can adjust the width of columns in the browser view.

Choose the Browser option.

Drag the arrow inward or outward to adjust column width.
With the Shelf option, you can adjust spacing between icons on the shelf.

You can also add rows to the shelf. When you check the Resizable Shelf box, a resize knob appears at the bottom center of the shelf.

You can click the Use Default Setting button in the Preferences panel to return to the settings that came with the computer.
When your computer is part of a network, you can exchange electronic mail with other people and share their files—all within seconds and without ever leaving your desk.

A network can consist of two computers or two thousand. Some of the computers have people like you working at them. Other computers—called servers—contain files and folders that everyone on the network can share.

You access the servers and the files they contain through /Net—the Net folder in your root folder. Your home folder is probably on a server along with other peoples' home folders, so you'll be somewhere in /Net when you log in.

Files and folders that aren't accessed through /Net, such as /NextApps or /NextLibrary, are usually on the hard disk in your computer.

You work the same in files and folders whether they're in your computer or in another one. But while only you can access the other folders in your root folder, everyone can access the folders in /Net.

When your home folder is on a server and therefore accessible from any computer, you can log into any computer on the network. As long as you log in with your user name and password, you enter your own workspace and have access to the files in your home folder.

---

Only starr can access his computer's root folder.

Only grey can access hers.

But they both can access everything in Net.
If any NetWare® servers are connected to your network, you can access file systems on those servers in your File Viewer. Just open the NetWare folder in /Net. When you click a server in this folder, a panel asks you to enter a name and password. You obtain these from the NetWare system administrator. When you enter the right information and click OK, the contents of the server appear.

You can work with files in the NetWare file system, or you can copy them to your NEXTSTEP file system—for example, to your home folder. When you copy a file to the NEXTSTEP file system, make sure it has an appropriate extension before you try to open it. In some cases you might have to change the extension to have the file open in the application you want.

Also, file and folder names on some NetWare networks are limited to eight characters plus a three-character extension. Before you copy a file or folder to such a network, make sure its name isn’t any longer. For information on changing names or extensions, see “Renaming a File or Folder” in Chapter 6.

To make the NetWare folder appear, start up the NetWareManager application, located in /NextAdmin, and then click the Enable button. For more information, see your system administrator.

For more information on differences between files in your NEXTSTEP file system and in other file systems, see “DOS and Macintosh Files” in the Reference at the end of this book.
Applications are the tools you use to work in the NEXTSTEP workspace. You use them to create documents, send and receive messages, look up information, and manage your computer system. Some applications are available in the application dock. All are available in the File Viewer.
Starting up an application from the dock
Running several applications
Switching to another application
Hiding an application
Customizing the application dock
Starting up an application automatically
Requesting the service of another application
Quitting an application

You remember remodeling your kitchen last summer. Tools scattered everywhere. You could never find the one you needed. It was inevitably in the other room. Or on a shelf. Or maybe you were sitting on it.

You sigh. It ought to be easier. Power tools, lathes, levels, squares, gadgets for every nook and cranny—all at your fingertips within seconds and neatly put away—out of your way—when you’re done.

You sigh again. Good thing the remodel is over. Good thing your next project is right here on the computer.
Starting up an application from the dock

- Double-click the application icon in the dock.

Your computer comes with several applications, and you may add others that you buy or create yourself. You can keep icons representing applications in the application dock—the column of icons lining the right side of the screen.

When you double-click an application icon in the dock, the icon is highlighted for a moment. Then the application’s main menu appears, often along with another window.

Before you start up an application, its icon has an ellipsis \[\ldots\]. When the application is running, the ellipsis goes away.

The recycler is described in “Deleting a File or Folder” in Chapter 6.
Running several applications

- Start up each application you want to run.

You can run several applications at once, for instance, to view a Mail message while typing in an Edit document. Although several applications can be running, you work in only one at a time—the active application.

When you start up an application, it becomes the active application. Its main menu replaces any other menus on the screen.

*The active application is the one with a menu showing.*

It also contains the key window.

You might also do something that causes an application to start up automatically. For example, choosing a command from the Services menu can start up Digital Librarian™.
Switching to another application

- Click in one of the application windows.
- Double-click its icon.

When you want to work in another application, just click in one of its windows. If no windows are showing, double-click the application icon.

Click in a window to bring the window forward and activate its application. Or double-click its application icon.

When you leave one application to work in another, the standard windows that belong to the application you leave stay on your screen. If an attention panel is open, it stays, too. The application’s menus and all other panels go away. When you switch back to the application, its menus and panels reappear, just as you left them.
Hiding an application

- To hide an application, choose Hide from its main menu.
- To unhide the application, double-click its icon.

If you’re through working with an application for now but plan to use it later in the same work session, you can hide it to get its windows out of the way. All its windows disappear from view, but the application continues to run.

By hiding applications, you can have several running and easily accessible while your workspace remains free of windows you’re not currently using.

When a docked application is hidden—as opposed to not running—there’s no ellipsis [•••] in its icon.

When you unhide an application, all its windows reappear, and the application is activated, just as though it had never been hidden.

**Tip:** You can hold down the Command key and double-click an application icon to hide all applications except the one you double-click.

When you hide an application, no unsaved work is lost. Nor is it saved. For information on saving your work, see Chapter 5, “Creating and Saving Files.”
Customizing the application dock

- To add an application to the dock, select the application in the File Viewer and drag it into an empty space in the dock.
- To remove an application from the dock, drag it into the workspace while it isn’t running.
- To reorder applications in the dock, drag one from its current location to an empty space in the dock.

You can fill your dock with applications you use frequently. Then to start up a docked application, you just double-click it.

Applications that come with NEXTSTEP are in the /NextApps, /NextDeveloper/Demos, and /NextAdmin folders.

![Drag an application from the File Viewer to an empty space in the dock. You can also drag a freestanding application icon into the dock. Release the mouse button when a ghost image of the icon appears.]

Normally, no windows or menus can cover the dock. However, if you hold down the Alternate key and click the NeXT icon in the dock, the dock can be covered. To bring the dock back to the front, Alternate-click the NeXT icon again.

**Tip:** Alternate-clicking the NeXT icon to send the dock to the back increases the area of the screen that you can work in.

To find out which is your keyboard’s Alternate key, see “Keyboard Basics” in Chapter 9.
If your dock fills up, you must remove an icon from it to add any others.

The NeXT icon always remains at the top of the dock. The recycler appears in the dock, or if there's no room there, at the lower left of the screen.

**Tip:** You can remove a running application from the dock by holding down the Command key and dragging it out of the dock. You can also do this to remove the recycler.

### When You Want to Locate a Docked Application

If you forget where a docked application is in the file system, you can see its pathname in the Workspace Manager Preferences panel. Choose the Preferences command from the Info menu. Then choose Dock from the pop-up list at the top of the panel.
Starting up an application automatically

1. Put the application in the dock.

2. Choose Info from the Workspace menu.

3. Choose Preferences from the Info menu.

4. Choose Dock from the pop-up list at the top of the Preferences panel.

5. Click the application in the list.

6. Check the "Start up at login" box.

You can set any application that's in the dock to start up automatically when you enter the workspace. If you regularly exchange electronic mail with other people on a network, for instance, you can set the Mail application to start up when you log in.

The Preferences application is set to start up automatically when you first use NEXTSTEP. You can change this by selecting the application and unchecking the "Start up at login" box.

**Tip:** If you don't usually use the File Viewer when you log in, you can have it hidden at login. The login process is quicker that way, too. Just uncheck the Workspace Manager in the Dock preferences. The next time you log in, all you see is the dock. To see the File Viewer, you must double-click the NeXT icon in the dock.
Requesting the service of another application

1. Select the text or file you want serviced.

2. Choose Services from the application's main menu.

3. Choose a command from the Services menu.

You can request the service of one application while you're working in another. A service provides a shortcut to starting up or switching to an application and requesting a specific action from it. Available services are listed in the Services menu. Here's one example:

```
Mail I Services
Info f' Charts mlth
Message f' Edit
Compose f' Grab
Edit f' Librarian
Format f' Open in Workspace
Windows f' Tracker
Print p
Services h
Hide h
Quit q
```

Select a file pathname you receive in a Mail message. Choose Open in Workspace from the Services menu.

The file opens without your having to locate it first in the File Viewer.

Services menu commands for NEXTSTEP applications are described in "Standard Commands" in the Reference at the end of this book.

You can use the Preferences application to remove commands you don't need from the Services menu. See "Customizing the Services Menu" in Chapter 20.

The exact commands in the Services menu depend on which applications you have. Several NEXTSTEP applications provide services. If you have other applications, you might see other services in the menu, too.
Quitting an application

► Choose Quit from the application’s main menu.

When you’re completely finished with your work in an application, you can quit the application to put away all its windows and any work they contain.

When you quit an application that’s in the dock, the ellipsis \[\ldots\] reappears in its icon.

If any window in the application contains unsaved work, a panel asks if you want to save before quitting the application (and closing the window).

Tip: If you think you may use the application later in your work session and just want its windows out of the way, it’s better to hide the application rather than quit it—it takes less time to unhide an application than it does to start it up again.

For information on saving your work before quitting an application, see Chapter 5, “Creating and Saving Files.”
When the Quit Command Doesn’t Work

On rare occasions, your actions in an application may have no effect due to a software problem. You can usually solve the problem simply by quitting the application and starting it up again.

If choosing the Quit command has no effect, you may be able to quit the application by using the Workspace Manager Processes command.

Switch to the Workspace Manager—for instance, by clicking in the File Viewer. Open the Tools menu and choose the Processes command. Then choose Applications from the pop-up list at the top of the Processes panel. Select the application you want to quit and click the Kill button.

The application quits running, but any unsaved work in the application is lost. You should use the Processes command to quit an application only as a last resort.
Your computer comes with several applications in the /NextApps folder. These applications are briefly described below along with their icons.

Edit is a Rich Text editor you can use to create formatted documents with graphics. See Chapter 9, "Typing and Editing," and Chapter 11, "Working with Graphics."

Mail (also called NeXTmail) is a multimedia electronic mail application for communicating with others on a network. You can send text, graphics, sound, and even files and folders. See Chapters 13 and 14.

Preferences is an application you can use to set personal preferences for using the computer, such as key repeat speed or an application language. When it’s running, its icon in the dock shows the date and time. See Chapters 20 through 22.

Preview displays the contents of PostScript, EPS, and TIFF files as images. See Chapter 11, “Working with Graphics.”

Grab is an application you can use to create a TIFF image from a window, a selection on the screen, or the entire screen. See Chapter 11, “Working with Graphics.”

Digital Webther™, which you may need to install from the NEXTSTEP CD-ROM, is for looking up words in Webster's Ninth New Collegiate Dictionary® and in Webster's Collegiate® Thesaurus. See Chapter 12, "Using On-line References."

PrintManager is for monitoring and managing printing and faxing, for example, by checking the print queue or adding a fax modem. See Chapters 15 through 18.

FaxReader is for reading faxes you receive, printing them, and working with them in other ways. See Chapter 17, "Getting Faxes."

Installer is for adding new software to your computer. It's a system administration application that's located in /NextAdmin. See Chapter 19.

Terminal is for working on the computer directly with UNIX by entering UNIX commands and running UNIX programs. Terminal can also run programs that require VT100™ terminal support. It's documented in NEXTSTEP Development Tools and Techniques.
FILES, FOLDERS, AND DISKS
Whenever you create a document—a text report, an illustration, or a spreadsheet, for example—you start by creating a file. All the work you do is kept in that file when you save it. You can change it and save the changes, or you can save different versions of the file.

---

**Legends of the Blues**

*Where it all began...*

**Bessie Smith**

The Empress of the Blues, she was born in poverty only to become one of the most renowned—and highest paid—blues performers of her day.

**Memphis Slim**

Over the course of half a century, this Arkansas pianist took the Blues from the barrelhouses and dives of Beale street, to the big-name blues world of Chicago, and across the ocean to the world.
Creating and Saving Files

You sit down to create a masterpiece. Before you, a new empty canvas. With brush in hand, you make the first mark. It’s brilliant, so you give it a name. *Self Portrait.* Then as you try to capture the eyes, disaster strikes. You miss a stroke, and the work is ruined.

If only you could retrace your steps. Turn back the clock and avoid that fateful blunder. Try the eyes again. Try them several times. Pure and innocent the first time and then maybe with a glint of aged wisdom.

You emerge from this reverie and tuck the portrait away. It’s time to move on to something else. You turn to a blank page and begin to write. Prose. The first paragraph is riveting, so you give it a name....
Creating a file

1. **Start up the application you want to use.** When you want to create something new, you start up the application you want to use, open a new window, and begin to work in it.

2. **Choose the command that opens the document menu.** You open the window with the New command in the document menu. This menu might be called Document, Image, Project, or whatever describes what you create with the application.

3. **Choose New.**

   ![Menu with commands](image)

   The command directly below Info opens the document menu, named File here.

   Choose New to open a new window.

   A new window's title bar contains a temporary title.

   You can begin working in the window right away, for example, by typing.

   ![Untitled window](image)

   Legends of the Blues
   Where it all began...

   Bessie Smith
   The Empress of the Blues, she was born in poverty only to become one of the most renowned.

   You store the work you do in a file. You name the new file and put it in a folder when you first save the contents of the new window.

   If you close the window without saving, no file is created and work you've done in the window is lost.

   Some applications give you a new window automatically when you start them up from the dock or when you open their file from the File Viewer.
Opening an existing file

1. Choose the command that opens the document menu.

2. Choose Open.

3. In the Open panel, select the file or files you want to open.

4. Click OK.

You can open a file while you’re working in an application. You use the Open panel, which contains a small browser that lists the files the application can open. You locate a file in this browser just as you locate a file with the browser view in the File Viewer.

Instead of selecting the file you want to open, you can type its pathname. If the file is further down the branch of the file system from the folder that’s currently open in the panel, you only need to type the part of the pathname that begins with a name in that folder.

Tip: You can double-click a file in the browser to open the file without having to click OK. You can also open more than one file by selecting the files you want to open—for example, by dragging over them—and clicking OK.

When you open a file, the panel goes away and the contents of the file appear in a window.
Saving a new file

1 **Choose the command that opens the document menu.**

2 **Choose Save.**

3 **In the Save panel, name the file and open the folder you want to put it in.**

4 **Click OK.**

To name a new file and put it in a folder, you must save it. When you’re working in a new window and you choose Save, a panel opens that contains a browser. You locate and open a folder in this browser just as you do with the browser view in the File Viewer.

**Tip:** You can scroll directly to any folder in the Save panel by dragging the folder’s icon from the File Viewer into the panel.

**Guidelines to Naming Files and Folders**

For more information on using a browser, see “Browsing Files and Folders” in Chapter 3.

You can use the disk buttons in a Save panel to open and eject floppy disks. See “Opening and Saving Files on a Floppy Disk” in Chapter 8.

You can choose nearly any name you want for a file or folder. Just keep the following in mind:

- You can’t use the same name more than once in the same folder. However, you can use the same name in different folders.

- Lowercase letters are distinguished from uppercase letters, so Fall Catalog is different from fall catalog.

- You can use any characters except a slash (/), which separates names in a pathname. If you work with files directly in UNIX, also avoid spaces and the ``, ``, ``, ``, and ``, characters, which have special meanings in UNIX.

- Remember that the extension at the end of most file names associates the file with an application. If you don’t include the extension when you name the file, the application adds it automatically.
When you save a file, the Save panel goes away and the file is placed in its folder.

Legends of the Blues
Where it all began...

Bessie Smith
The Empress of the Blues, she was born in poverty only to become one of the most renowned—and highest paid—blues performers of her day.

Memphis Slim
Over the course of half a century, this Arkansas pianist took the Blues from the barrelhouses and dives of Beale street, to the big-name blues world of Chicago, and across the ocean to the world.

Tricks in the Name Field

Instead of selecting a folder to save a file in, you can type a pathname for the file in the Save panel. Use the same shortcuts described in Chapter 3 in “Shortcuts to Typing Pathnames.”

To save the file further down the branch of the file system from the folder that’s currently open in the panel, type just the part of the pathname that begins with a name in that folder. In the panel on the previous page, for example, type Catalogs/Fall Catalog to save Fall Catalog.rtf in the Catalogs folder.

You can also create a folder to save a file in. Type a pathname for the file that includes the folder’s name as though the folder already exists. Type Festival/Program, for example, to create a Festival folder and save Program.rtf in it. In the panel that asks if you want to create the folder, click Create.

To replace a file with the one you’re saving, select the file you want to replace and click OK, or just double-click the file. In the panel that asks if you want to replace the file, click Replace.
Saving changes

- To save changes in a file, open the document menu from the main menu and then choose Save from the document menu.

- To save changes in all the files open in an application, choose Save All from the document menu.

You save changes you make to a file so they're there when you next open the file. Just choose Save while working in the window that contains the file. The contents of the window replace the previous version of the file on disk. The window stays around so you can keep working in the file.

You can get rid of changes you don't want to keep with the Revert to Saved command in the document menu. See “Standard Commands” in the Reference at the end of this book.
Tip: You should save changes periodically as you work in a file, not just when you’re about to close it. By saving frequently, you avoid losing a lot of work if the file closes unexpectedly—for example, if there’s a power failure.

If you choose Save All when any new window is open whose contents you haven’t yet saved, a Save panel opens. You can then name the file and put it in a folder.

When You Save an Edit Document

When you save an Edit document, Edit creates a temporary backup file, which contains the version of the file without the changes you’re saving. Edit deletes this backup file as soon as the new version is successfully saved on disk.

If something happens that prevents Edit from saving the file—a power failure, for example—the backup copy remains, and you can recover its contents. You can tell which is the backup copy because it has the same name as the original file but with a tilde (~) appended to it. For example, the backup copy for Memo.rtf would be Memo.rtf~.

If you do end up with only the backup file, you can remove the ~ from the name and use it in place of the original. See “Renaming a File or Folder” in Chapter 6.
Saving another version of a file

1 Open the document menu from the main menu.

2 Choose Save As or Save To from the document menu.

3 In the Save panel, name the new version and open the folder you want to put it in.

4 Click OK.

You can save the contents of a file under a different name and in a different folder while keeping the original file, too. You typically do this to save one version of a file before making any more changes to it.

Both the Save As and Save To commands save the contents of the window you’re working in as another file. Each command opens the Save panel, where you name the new version of the file and put it in a folder, just as you do for a new file. The original file stays the same as when you last saved it.

**Save As**

Save As puts away the previous version, which doesn’t include changes.

You keep working in the new version, which includes changes.

**Save To**

Save To puts away the new version, which includes changes.

You keep working in the old version, where your changes aren’t yet saved.

**Tip:** You can think of these commands as taking a snapshot of one version of the file and putting the snapshot away, while you continue to work in the other version of the file. Save As takes a snapshot of the original version, and Save To takes a snapshot of the revised version.
Why Save?

When you work in a file—for example, by typing in an Edit document—the computer displays your work in a window. But it doesn’t retain your work permanently on disk until you save the file.

Before closing a window that contains a file you’ve been working in, you need to save changes you’ve made if you want them to be there the next time you open the file. If you close the file without saving, the changes aren’t copied onto the disk and they won’t be there when you next open the file.
To keep your files organized, you put them in folders. Then you put the folders in other folders to keep related work together. You can move files and folders, copy them, or throw them away—all by dragging icons.
Organizing Your Work

You’d lose your own head if it weren’t stuck on your shoulders. That’s what your mother used to say. Your room always looked like a cyclone had hit it, and later, so did your house. When you started your own business, all your friends got together and threw a wake for it. Real funny.

Of course, you got the last laugh when you became the largest distributor in the state. And as your bank account grew, so did your inventory. You were always reorganizing it—creating new categories, merging old ones, relabeling things, finding ways to save space—all in your spare time. You told your friends it was magic. It was actually just your computer.

As for your house, it’s being featured on the covers of two interior design rags. Computer magic? No, you just hired a maid.
Permissions Granted

To make changes to the file system, for instance, by moving files around or renaming them, you must have certain permissions for the files and folders you’re working with. To rename a file, for example, you need permission to change the contents of the folder it’s in.

There are two basic types of permissions for a file or folder: read permission—that is, permission to look at its contents—and write permission, or permission to change its contents.

All of the tasks described in this chapter require that you have the correct permissions. When you try to do something you don’t have permission for—such as move a file out of someone else’s folder—a panel typically informs you that you can’t do it.

You can set permissions for your own files and folders to prevent anyone else from changing them. For example, you might give other people permission to read a folder, and therefore browse its contents. But if you don’t give them write permission for the folder, they can’t change the folder’s contents, for example, by moving a file out of it.

You can even use permissions to protect your work from yourself. If you remove write permission from an important file, for example, you can’t accidently alter the file by saving changes to it.

For information on how to set permissions for yourself and for others who have access to your files, see “Changing Permissions for a File or Folder” in Chapter 7.

**When you have read permission for a folder or file, you can see its contents:**

- **Read**
  - [ ]
  - [ ]

- **Write**
  - [ ]

**You read a folder when you open it and look at its contents.**

**Words.rtf**

**When you also have write permission for a folder or file, you can change its contents:**

- **Read**
  - [ ]
  - [ ]

- **Write**
  - [ ]

**You write in a folder, for example, when you rename a file in it or add a file to it.**

**Lyrics.rtf**

You can set permissions for your own files and folders to prevent anyone else from changing them. For example, you might give other people permission to read a folder, and therefore browse its contents. But if you don’t give them write permission for the folder, they can’t change the folder’s contents, for example, by moving a file out of it.

You can even use permissions to protect your work from yourself. If you remove write permission from an important file, for example, you can’t accidently alter the file by saving changes to it.

For information on how to set permissions for yourself and for others who have access to your files, see “Changing Permissions for a File or Folder” in Chapter 7.
Creating a folder

1 Open the folder you want to put the new folder in. As you accumulate files, you can create folders to put them in so they’re easy to find. Choosing New Folder creates a folder in the current folder.

2 Choose File from the Workspace menu.

3 Choose New Folder from the File menu.

4 Type a name for the folder and press Return. Your new folder is empty at first. But you can put files and other folders in it by copying or moving them into it, by saving files in it, or by creating other new folders in it.

Pick a name for your folder as described in “Guidelines to Naming Files and Folders” in Chapter 5.
Renaming a file or folder

1 Select the file or folder. You can rename a file or folder simply by editing its name in the File Viewer or any other folder window.

2 Edit the name in the icon path.

3 Press Return.

Pick a new name for the file or folder as described in "Guidelines to Naming Files and Folders" in Chapter 5.

You can use Edit menu commands to edit a file or folder name. You can also choose Sort Icons from the View menu to alphabetize the contents of a folder after renaming in it. See "Workspace Manager Commands" in the Reference at the end of this book.

What You Shouldn’t Rename

The name of a file or folder can’t or shouldn’t change in these cases:

- You can’t rename your home folder.
- Don’t rename an application. Changing an application’s name may prevent you from opening files you’ve already created with the application.
- Don’t change a file’s extension if that will prevent the file from opening in the right application.
Copying a file or folder

1. Select the file or folder and drag it to the shelf.

2. Select the folder you want to put the copy in.

3. Hold down the Alternate key and drag what you're copying from the shelf to the folder in the icon path.

You can make a copy of a file or folder in another folder. When you copy a folder, you copy all the files and folders in it, too.

To find out which is your keyboard's Alternate key, see "Keyboard Basics" in Chapter 9.

If the Processes panel asks for additional instructions, see "Solving File and Folder Problems" in this chapter.

For information on copying a selection of files or folders, see "Handling Several Files and Folders at Once" in this chapter.

You can also use the Duplicate command in the File menu to copy a file or folder. See "Workspace Manager Commands" in the Reference at the end of this book.
Moving a file or folder

1. Select the file or folder and drag it to the shelf.

2. Select the folder you want to put it in.

3. Hold down the Command key and drag what you're moving from the shelf to the folder in the icon path.

You move a file or folder into another folder much as you copy it—by dragging it to the other folder. When you move a folder, you move all the files and folders in it, too.

The standard way to move a file or folder is to drag it from the shelf to a folder in the icon path. But you can also drag from the icon path to a folder on the shelf, or from one folder window to another.

To find out which is your keyboard's Command key, see "Keyboard Basics" in Chapter 9.

If the Processes panel asks for additional instructions, see "Solving File and Folder Problems" in this chapter.

For information on moving a selection of files or folders, see "Handling Several Files and Folders at Once" in this chapter.
You might not need to hold down the Command key while you drag. It depends on where you’re dragging the selection to. When you drag it to a folder on the same part of a disk, for example, the cursor automatically becomes ⌘ and the selection is moved even if you don’t use the Command key.

If a folder doesn’t open when you drag a selection to it, you don’t have permission to put anything in that folder.

---

### When It’s a Copy or a Move

When you drag a file or folder to another folder, the Workspace Manager either copies it or moves it, depending on where the destination folder is. You can tell which by the shape of the cursor:

- A ✁ copies the selection. This cursor appears when the selection and folder you’re dragging it to are on a different disk (or part of a disk, if your system administrator has divided the disk up to act as separate disks). For example, it appears when you drag a file from your computer’s hard disk to a floppy disk or to a disk in another computer on a network.

- A ⌘ moves the selection. This cursor appears when the selection and folder are on the same disk or part of a disk.

To make the copy cursor appear in any case, you can hold down the Alternate key as you drag. To get the move cursor, hold down the Command key.
Replacing a file or folder

1. Select the file or folder you want to use as the replacement.

2. Drag the selection to the folder that contains the file or folder you want to replace.

3. Click Replace in the Processes panel.

You can replace a file or folder with another one of the same name. If the replacement and original don't have the same name, rename one of them so they do. Then copy or move the replacement into the folder that contains the original. The Processes panel asks if you want to replace the existing file or folder.

Replacing a folder removes the entire contents of the existing folder and leaves only the contents of the folder you copied or moved.

Any file or folder you replace is moved into the recycler. To get it back, see “Retrieving a File or Folder from the Recycler” in this chapter.

For information on replacing a selection of files and folders, see “Handling Several Files and Folders at Once” in this chapter.

If the Processes panel asks for additional instructions, see “Solving File and Folder Problems” in this chapter.
Merging two folders

1 Select the folder you want to merge.

2 Hold down the Alternate key and drag the selection to the folder that contains the folder you want to merge with.

3 Click Merge in the Processes panel.

You can incorporate changes made to one folder into another folder that has the same name. When you copy a folder over another with the same name, the Processes panel provides these options.

When you merge two folders, the new folder contains the entire contents of the folder you copy, plus any files or folders unique to the existing folder.

To find out which is your keyboard's Alternate key, see "Keyboard Basics" in Chapter 9.

For information on merging more than one folder at a time, see "Handling Several Files and Folders at Once" in this chapter.

Any file or folder that's replaced is moved into the recycler. To get it back, see "Recovering a File or Folder from the Recycler" in this chapter.

If the Processes panel asks for more instructions, see "Solving File and Folder Problems" in this chapter.

How Merging Saves Time

Before the Workspace Manager replaces a file during merging, it checks for any differences between it and the replacement. It compares their size and the date they were last changed. If it finds no difference, it doesn't replace the file.

When you're working on a large project at your office, you might copy part of the project onto a disk to work on it at home. Maybe you change 5 files out of 20 that you copied. When you merge them back with the rest of the files, the Workspace Manager detects that you changed only 5 files. Instead of taking the time to copy all 20 files, it copies only those 5.
Creating a link

1. Select the file or folder you want to create a link to and drag it to the shelf.

2. Select the folder you want to put the link in.

3. Hold down the Control key and drag the selection from the shelf to the folder in the icon path.

You can keep a file or folder in one location and work with it in another by creating a link to it. The link looks just like the file or folder it points to. It has the same icon, and when you open it, you see the same contents.

To create a link, you can also drag from the icon path to a folder on the shelf, or from one folder window to another.

If a folder doesn’t open when you drag a selection over it, you don’t have permission to put a link in that folder.

For information on creating several links at a time, see “Handling Several Files and Folders at Once” in this chapter.

You can identify a link and tell what file or folder it points to with the Inspector command. See “Getting Information about a File or Folder” in Chapter 7.
What Is a Link?

A link is a pointer to a file or folder that’s somewhere else in the file system. A link looks and acts like the file or folder it points to. It has the same icon, and when you open it, you see the same contents.

On a network, links make it easy for several people to open the same file. For example, if you’re working with a group of people on the same project, you can create a link to your group’s Schedule file and keep it in your home folder. To see the current schedule—including any changes made to it—you can open your link.

Links also save time. Instead of following a lengthy path to a folder you work in frequently, you can create a link to the folder and put it somewhere convenient, such as in your home folder. Then to get to the actual contents of the folder, you just open your link.

Finally, links save disk space. Instead of copying a sound or application into your home folder, just make a link to it. Since a link is just a pointer to the file, it takes up practically no space on the disk.

A link remains tied to the name and location of the file or folder it points to. You can move the link or rename it, and it still points to the file or folder. If the actual file or folder is moved, renamed, or deleted, however, the link breaks. You should therefore make links only to files or folders that you’re relatively sure aren’t going to be moved or renamed.

When a link does break, its icon changes to a question mark. You can reestablish the link by returning the actual file or folder to its original location and name. Otherwise, you should delete the link.
Setting options for copying links

1 Choose Info from the Workspace menu.

2 Choose Preferences from the Info menu.

3 Choose File Copy Options from the pop-up list at the top of the Workspace Manager Preferences panel.

4 Select an option.

When you copy a file that’s actually a link, the Processes panel asks whether you want to make another link, or make a copy of the actual file or folder the link points to. If you don’t want to be asked, you can select an option that applies for every link you copy. You select this option in the Workspace Manager Preferences panel.

**Options for Copying Links**

Select one of these options from the File Copy Options in the Workspace Manager Preferences panel. The option you select applies for all links that you copy.

- **Ask** When this option is selected, the Processes panel asks what you want to do for each link you try to copy.
- **Skip the link** Select this option and the Workspace Manager skips all links without copying them.
- **Copy the original** Select this option and the Workspace Manager creates a copy of the actual file or folder that a link points to.
- **Make a new link** Select this option and the Workspace Manager creates another link for each link it copies.
Compressing and decompressing a file or folder

To compress a file or folder, select it and choose File from the Workspace menu. Then choose Compress from the File menu.

To decompress the file or folder so you can open it, select it and choose File from the Workspace menu. Then choose Decompress from the File menu.

You can free space on your disk by compressing a file or folder. Then when you want to open the file or folder, you decompress it.

When you compress a file or folder, the amount its size is reduced depends on the kind of information in it. Compression works best on text files, reducing the size by up to 75 percent. It's also a good idea for folders that you don't look in very often, such as a folder containing an old project you're not currently working on.

You can decompress a file or folder with the Decompress command or you can double-click a compressed file or folder. In the latter case, the Inspector panel opens, and you can click the Decompress button to decompress the file or folder. The file or folder then has its original icon and takes up its original amount of disk space.

You can use the Inspector command to find out the size of a file or folder before and after compressing it. See "Getting Information about a File or Folder" in Chapter 7.
Deleting a file or folder

1 Select the file or folder.
2 Drag the selection from the icon path to the recycler.
3 When you’re sure you want to destroy everything in the recycler, choose File from the Workspace menu and then choose Empty Recycler from the File menu.

You can destroy a file or folder without moving it to the recycler with the Destroy command in the File menu. See “Workspace Manager Commands” in the Reference at the end of this book.

On many networks, the system administrator makes backup copies of files. If you accidentally destroy something, see your system administrator about retrieving a copy of it.

For information on deleting a selection of files and folders, see “Handling Several Files and Folders at Once” in this chapter.

You can remove a file or folder from the file system without immediately destroying it by moving it into the recycler—the icon at the bottom of the screen. When you decide you really want to destroy it, you can empty the recycler.

A sphere in the center of the recycler means there’s something in it.

You can also drag a file or folder from the shelf to the recycler. Or with the icon view, you can drag it from the current view.

Caution: The Empty Recycler command permanently destroys the contents of the recycler. You should leave files and folders in the recycler until you’re sure you don’t need them. But to free disk space, make sure to empty the recycler periodically.
Retrieving a file or folder from the recycler

1 Double-click the recycler.

When you move a file or folder into the recycler, it isn’t gone forever. You can retrieve it by opening the recycler and dragging the file or folder back to the File Viewer or any other folder window.

2 Drag the file or folder from the Recycler window to a folder in the File Viewer.

Double-click the recycler to see its contents in the Recycler window. Drag the file or folder you want to retrieve back to the folder you want to put it in.

3 Click the close button in the Recycler window.

Click to close the Recycler window.

You can only retrieve files or folders that you recycled since you last chose the Empty Recycler command.
Handling several files and folders at once

1 **Select the files or folders you want to copy, move, link, or delete.**

2 **Drag the selection icon to a folder or the recycler.**

You can work with several files and folders at once—to move them all to another folder, for example, or to put them all in the recycler. When you select several files or folders, a selection icon appears in the icon path. You can drag this icon to copy, move, link, or delete the selection of files and folders just as you drag a single file or folder.

If the folder doesn’t open, you don’t have permission to complete the operation.

Select more than one file or folder as described in “Selecting Several Files and Folders” in Chapter 3.

If the Processes panel asks for additional instructions, see “Solving File and Folder Problems” in this chapter.
Managing several file operations

1 Choose Tools from the Workspace menu.

2 Choose Processes from the Tools menu.

3 Choose Background from the pop-up list at the top of the Processes panel.

4 Click the operation you want to check.

5 If you want to halt the operation, click Pause or Stop.

Your computer can do several file operations at the same time. You can copy a selection, compress a folder, and delete another folder, without waiting for any previous operation to be completed. In the meantime, you can do something else in the Workspace Manager or with any other application.

Your computer carries out most of the file operations described in this chapter in the background—that is, behind the scenes where you don’t have to worry about them. You can track the progress of an operation, or stop, or pause it with the Processes panel.

Caution: Sometimes you need to make sure that a particular operation is complete before you begin another. For example, if you’re moving some files out of a folder that you then want to delete, make sure the move is complete before you delete the folder.

If you stop an operation that’s partially completed, such as a copy or move, any file or folder already named in the panel is copied or moved. If you stop while a folder is named, parts of the folder may be copied or moved.
Solving file and folder problems

Sometimes when you’re working with files, the Processes panel may describe a problem and wait for additional instructions before proceeding.

<table>
<thead>
<tr>
<th>Processes Panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Net/publicity/</td>
<td>A file or folder already exists</td>
</tr>
<tr>
<td>Schedule.rtf is</td>
<td>at destination</td>
</tr>
<tr>
<td>a link</td>
<td>One or several folders already exist at destination</td>
</tr>
<tr>
<td>You can create a new link, skip this link, stop the entire operation, or copy the original.</td>
<td></td>
</tr>
<tr>
<td>Repeat</td>
<td>The options change for each problem</td>
</tr>
<tr>
<td>New Link</td>
<td>If you’re working with several files or folders, you can check here to repeat instructions for all of them</td>
</tr>
<tr>
<td>Skip</td>
<td>You can press this button to stop the operation completely</td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
</tbody>
</table>

Here are some common messages and ways to respond to them.

**One or several folders already exist at destination**

*Click Merge* to merge all folders in the selection with the existing folder of the same name.

*Click Replace* to have all folders in the selection replace the existing folder of the same name.

*Click Proceed* to decide for each folder. When you click proceed, you’re asked whether you want to replace, merge, or skip each folder, one at a time (see the message below).

**File or folder already exists**

*Click Replace* to replace the existing file or folder named in the panel. See “Replacing a File or Folder” in this chapter for more information.

*Click Merge* to merge the folder named in the panel with the existing folder. See “Merging Two Folders” in this chapter.

*Click Skip* if you don’t want to replace the file or folder. When you’re copying or moving a selection of files or folders, this button skips the one currently named in the panel, but keeps copying or moving the rest of the selection.
**File or folder is a link**

*Click Copy* to create a copy of the actual file or folder the link points to. This copy is not a link.

*Click New Link* to create another link to the file or folder.

*Click Skip* if you don’t want to copy the link. When you’re copying or moving a selection of files and folders, this button skips the link currently named, but continues with the rest of the selection.

**Tip:** You can choose one of these options for all links you copy with the Preferences command. See “Setting Options for Copying Links” in this chapter.

**No room on disk**

*Remove files and folders from the disk you’re copying or moving to* and click Proceed. You can use the Inspector command in the Tools menu to see how much space is left on the disk and the size of your selection. Then free the necessary amount of space, return to the Processes panel, and click Proceed to complete the operation.

For ideas on ways to free disk space, see “When You Run Out of Room on Your Hard Disk” in Chapter 8.

**No room in recycler**

*Click Empty* to empty the recycler. Any files or folders in the recycler are permanently removed and then the operation continues.

---

**The Repeat Box**

When the Processes panel asks how to handle one of several files or folders in a selection, you can check the Repeat box. Then click a button to apply your response to the entire selection.

For example, if the panel says a file already exists, you can check Repeat and click Replace to replace all files with the same name as any in the selection without being asked about each one.

If the panel says that a file or folder you’re copying is a link, you can check Repeat and click New Link to copy all links as links. Or check Repeat and click Skip if you don’t want to copy any links in the selection.

The Repeat option can carry out or skip any of these actions: replacing files, copying links, or merging or replacing folders. It applies only to the exact situation named in the panel.
In the Workspace Manager, the Inspector panel gives you quick information about files and folders—and some options for managing them. You open the Inspector panel with the Inspector command in the Tools menu.
Inspecting Files and Folders

Getting information about a file or folder
Previewing the contents of a file
Sorting files and folders
Changing the application that opens a file
Assigning a file or folder to a new group
Changing permissions for a file or folder

A little information about a document. That’s all the dame said she needed. How big was it? Who owned it? And when was it last tampered with? The usual. So here you are creeping around the corporate archives. Past the Ps and Qs. Darn. It’s in a locked glass case.

Back at the office you make a couple of phone calls, call in a few debts. Finally you track down the owner of the document. Turns out it’s old Vinny Johnson. Lucky for you, he owes you for breaking open that spreadsheet caper last spring, so he sends a man down to unlock the case.

Later you toss the document in front of her. She flips through it, then looks up, smiling. Very good, she says. I must show this to my vice presidents. Uh-oh, that’ll be extra. You’ll have to go back to Vinny for extra permission. And Vinny has a thing against VPs—ever since one pink-slipped his old man.
Getting information about a file or folder

1 Choose Tools from the Workspace menu.

2 Choose Inspector from the Tools menu.

3 Select a file or folder in the File Viewer.

4 Choose Attributes from the pop-up list at the top of the Inspector panel.

You can use the Inspector to get information about a file or folder—its size, owner, and group, as well as its permissions and the last time it was changed.

The size of a file appears automatically each time you inspect it. But you have to compute the size of a folder if you’ve changed any of its files since the last time you inspected it.

When a File Isn’t a File

In the File Viewer, you may see things that look like files or folders but really aren’t. These are either links or file packages.

**Links** A link looks and acts like an ordinary file or folder but is actually a pointer to a file or folder somewhere else in the system. When you inspect a link, the Inspector panel shows both the pathname for the link and the pathname for the file or folder it’s linked to. See “What Is a Link?” in Chapter 6.

**File packages** A file package is a folder that looks and acts like a file. It contains information that shouldn’t be separated, such as the text and graphics files that make up a document or the files that make up an application. When you inspect a file package, it looks like a folder—you need to press the Compute button to compute its size. See “File Packages—Files That Are Really Folders” in Chapter 3.
Previewing the contents of a file

1. **Choose Tools from the Workspace menu.**

2. **Choose Inspector from the Tools menu.**

3. **Select a file in the File Viewer.**

4. **Choose Contents from the pop-up list at the top of the Inspector panel.**

You can get a quick look at the contents of a file without taking the time to open the file and start up its application—to make sure it's the one you want, for example.

You use the File Inspector panel, which changes when you open different types of files. For example, these Inspector panels show the contents of an RTF file and a TIFF file:

![RTF File Inspector](image1)

![Image Inspector](image2)

The Workspace Manager provides Inspector panels for inspecting several types of files, including RTF (.rtf and .rtfd), EPS, TIFF, and sound (.snd) files. If the application you're using produces a different kind of file, it may provide its own Inspector panel. If not, you can't preview its files.
Sorting files and folders

1. Choose Tools from the Workspace menu.
2. Choose Inspector from the Tools menu.
3. Open the folder you want to sort in the File Viewer.
4. Choose Contents from the pop-up list at the top of the Inspector panel.
5. Click one of the sorting options and click OK.

The files and folders in the File Viewer and other folder windows are normally listed alphabetically by name. You can change the order in any folder to list its contents by kind, date, size, or owner.

In the icon view, you can also use the Clean Up Icons command and the Sort Icons command in the View menu to organize your files and folders. See "Workspace Manager Commands" in the Reference at the end of this book.
Changing the application that opens a file

1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.


4. Choose Tools from the pop-up list at the top of the Inspector panel.

5. Click the application you want to open the file.

6. Click Set Default.

When you open a file in the Workspace Manager, an application automatically starts up at the same time. The application that starts up depends on the type of file—that is, on its file extension. For example, when you open an RTF file, Edit normally starts up.

You can use the Inspector to see which applications can open a file, to change the application that starts up whenever you open specific types of files, or to open a file temporarily in another application.

Tip: You can also open a file temporarily in an application by holding down the Command key and dragging the file icon from the icon path to the application icon in the dock.

For more information about what makes a file and application compatible, see “Which Application Opens a File” in Chapter 3.
Assigning a file or folder to a new group

1. **Choose Tools from the Workspace menu.**
2. **Choose Inspector from the Tools menu.**
3. **Select a file or folder in the File Viewer.**
4. **Choose Attributes from the pop-up list at the top of the Inspector panel.**
5. **Choose the new group from the Group pop-up list and click OK.**

The Workspace Manager helps groups of people work more efficiently by sharing access to a set of files and folders. Every file and folder you create is assigned to a group. If you belong to more than one group, you can reassign files and folders from one group to another.

For information about setting up groups to share files and folders, see your system administrator.
Changing permissions for a file or folder

You can control access to individual files and folders that you create—and protect them from accidental changes—by setting permissions for them.

Permission is granted when a checkmark appears in the appropriate square. An X indicates that permission is denied. You can change permissions only if you are the owner of the file or folder.

You can also set read and write permissions in the Attributes Inspector panel. These permissions apply only to the current file or folder—not the files and folders it contains.

Caution: Don’t change execute permissions unless you’re an expert user. If you uncheck execute permissions for an application, you may not be able to open any of the files that use the application. If you uncheck execute permissions for a folder, you or others may not be able to open any of the files in the folder.

Permissions affect many file operations. For an overview, see “Permissions Granted” in Chapter 6.

You can preset permissions for any file or folder you create with the Preferences application. See “Setting Permissions for New Files and Folders” in Chapter 22.
You usually store your files and folders on a hard disk in your computer or in another computer on a network. But you can use floppy disks to make backup copies of files and folders, for example, or to share them with people who aren't on your network. You can also get new information and software from either a floppy disk or a CD-ROM.

<table>
<thead>
<tr>
<th>Workspace</th>
<th>Disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
<td>Eject e</td>
</tr>
<tr>
<td>File</td>
<td>Initialize...</td>
</tr>
<tr>
<td>Edit</td>
<td>Check for Disks</td>
</tr>
<tr>
<td>Disk</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Tools</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Services</td>
<td></td>
</tr>
<tr>
<td>Hide</td>
<td>h</td>
</tr>
<tr>
<td>Log Out</td>
<td>q</td>
</tr>
</tbody>
</table>

[Diagram of file viewer with options: gray, Stock Photos, Blank]

1.37 MB available on Macintosh® disk

[Popup window for Initialize Floppy A]

- Disk Name: Contracts
- File System: NeXT
- Capacity: 1440k (HD)

Initiating the floppy disk will erase it.

[Buttons: Cancel, Erase]
Working with Disks

Inserting a floppy disk
Preparing a new floppy disk
Creating a folder window for a disk
Copying files to or from a disk
Reusing a disk
Ejecting a disk
Opening and saving files on a floppy disk

Someone once explained to you how computers work. Little electrical signals you turn off and on to create letters, numbers, pictures, even 3-D images. All stored as infinitely small blips on something called a disk.

That’s great, but you just want to get a document out of this computer and into that one or put it on a separate disk. Or maybe you’re worried about getting too many blips. And then you’ve got all these choices—floppy disks, hard disks, disks called CD-ROMs. Where to start?

You wander over to your stereo, pick out a CD, pop a cassette in the tape deck to record on, and put away a stray album. Then you sit back down at your computer. Maybe this isn’t so complicated after all.
Inserting a floppy disk

1. Slide the disk into the drive, metal end first, label side up.

2. Gently push the disk until it clicks into place. (If the disk appears in your File Viewer, go to step 5.)

3. Choose Disk from the Workspace menu.

4. Choose Check for Disks from the Disk menu.

5. Click the disk on the File Viewer's shelf or double-click it in the current view to open it.

You can use a 3.5-inch floppy disk to store backup files or to move files from one computer to another. The disk can be in Macintosh® format, DOS format, or NEXTSTEP format.

On some computers, you have to choose the Check for Disks command after inserting a disk to make the disk appear in your File Viewer. On other computers, the disk appears in your File Viewer automatically.

If a panel says that the disk is unreadable, you have to initialize the disk. See “Preparing a New Floppy Disk” in this chapter.

For information on inserting a disk while working in an Open or Save panel, see “Opening and Saving Files on a Floppy Disk” in this chapter.

For more information about how to insert a CD-ROM, see the owner's guide for your CD-ROM drive.
When you insert a floppy disk and choose Check for Disks, the disk appears in your File Viewer. On most computers, you have to choose Check for Disks for the disk to appear.

The files and folders on the disk become part of your file system. You can open the disk to see its contents just like you open a folder.

You are the owner for all files and folders on any floppy disk that you insert. You can work in all its files and folders and change their permissions.

**What Disks Look Like**

You can tell the type of disk by its icon.

- ![A floppy disk](image)
- ![A hard disk connected to your computer](image)
- ![A CD-ROM](image)

You can rename a floppy disk that's in NEXTSTEP format just as you do a file or folder. See "Renaming a File or Folder" in Chapter 6.
Preparing a new floppy disk

1. Insert the disk in the disk drive and choose Check for Disks from the Disk menu.

2. Click Initialize.

3. Type a name for the disk in the Initialize panel.

4. Press the File System button to choose a file format.

5. If necessary, press the Capacity button to indicate the size capacity of your floppy disk.

6. Click Erase.

Before you can use a brand-new floppy disk, you have to initialize it. Initializing a disk prepares it to store files and folders. When you insert a new disk, a panel usually asks if you want to initialize the disk.

When you click Initialize, this panel opens:

If you don’t name the disk, it has a temporary title, such as UntitledDisk.

You should initialize a disk in Macintosh or DOS format if you want to use the disk to copy files from your computer to a Macintosh or DOS computer.

On some computers, you must indicate the disk’s size capacity—for example, whether it can hold 720 kilobytes, 1440 kilobytes, or 2880 kilobytes.
Creating a folder window for a disk

1 Choose Info from the Workspace menu.

2 Choose Preferences from the Info menu.

3 Choose Disk Options from the pop-up list in the Workspace Manager Preferences panel.

4 Click the “open new folder window” option for removable disks.

5 Click an option for fixed disks.

When you insert a floppy disk or CD-ROM in your computer, the disk normally shows up on the File Viewer's shelf, if there's room. You can have the disk open in its own window, instead.

A fixed disk you add to your computer, such as a hard disk attached to the computer's SCSI port, doesn’t normally show up on the shelf. You can select to have it appear on the shelf, or to open in its window, too.

Other Disk Options

You can select one of four options for how removable disks show up in your file system and for how fixed disks show up. No matter which option you select, you can always find the disk to open it in your root folder.

Open new folder window Select this option to display the contents of the disk in its own folder window.

Select the disk This option selects and opens the disk in the File Viewer so its contents appear.

Do nothing This option simply puts the disk in your root folder without opening it or putting it on the shelf.

Place icon on shelf When this option is selected, the disk appears on the shelf, if there's room.
Copying files to or from a disk

1. Select the files you want to copy and drag them to the shelf.
2. Select the disk you want to copy them to. Or if you're copying from a disk, select the folder you want to copy them to.
3. Drag the files from the shelf to the disk or folder.

You copy files or folders to or from a disk just like you copy them between folders. Select them and drag them where you want to put them. To move a selection instead of copying it, hold down the Command key as you drag.

Tip: The best way to work with a file on a floppy disk is to copy the file somewhere else in your file system first and work in the copy. If you want to change a file on a CD-ROM, you must copy it somewhere else in your file system and then change the copy. You can't change the contents of a CD-ROM.

After copying files to a floppy disk, you can eject the disk and insert it into another computer to transfer files to that computer. See “Ejecting a Disk” in this chapter.

For more information on CD-ROMs, see the owner's guide for your CD-ROM drive.
DOS and Macintosh Disks

You can use a floppy disk to transfer files between a Macintosh or DOS computer and your NEXTSTEP computer. You can also connect any Macintosh SCSI device—such as an external hard disk, CD-ROM, or removable cartridge disk—to your computer and access files on that device.

When you insert a DOS or Macintosh floppy disk into your computer, or if you’ve attached a Macintosh SCSI device, the disk appears in your root folder like any NEXTSTEP disk. You can then copy files from the disk to your file system.

If you want to transfer a file from your computer to a DOS or Macintosh computer, you can initialize a disk in DOS or Macintosh format (see “Reusing a Disk” in this chapter). Then copy the files you want to transfer onto the disk, eject the disk, and insert it into the other computer.

Once a DOS or Macintosh disk is in your file system, you can work with its files just as you do anywhere else in the file system, with these exceptions:

- You don’t set permissions for files or folders on a DOS or Macintosh disk, but you can when you copy them to your computer’s disk.
- You can’t rename a DOS or Macintosh disk by editing its name in the icon path. You have to name it when you initialize it.
- You may need to rename a file before you copy it from a DOS or Macintosh disk. For information, see “DOS and Macintosh Files” in the Reference at the end of this book.
If a file or folder is too large to fit on one floppy disk, you can copy it onto several. To make a backup copy of a 2-megabyte file, for example, you can copy it onto two 1.4-megabyte disks.

Copy a single file or folder to a floppy disk as you normally would. If what you’re copying is too big to fit on the disk, a panel asks if you want to create a multivolume file. When you click Yes, the Workspace Manager copies a “chunk” of the file or folder onto the disk. When the disk is full, a panel asks you to remove the disk from its drive and insert another one. After doing this, click Proceed in the panel. The Workspace Manager copies the second chunk. Repeat this for as many disks as needed.

To copy the file or folder from the disk back into your computer, insert the disk containing the first chunk—a file with a .chunk extension. Drag the chunk to the folder you want to put it in. When a panel asks for the next chunk, remove the disk, insert the next one, and click Proceed. Repeat this until you’ve copied all the chunks. Make sure to copy chunks in the order they were originally copied. If you insert a disk in the wrong order, just remove it and insert the correct one before clicking Proceed. After you copy all the chunks, you can open the file or folder as usual.

You can copy only one file or folder in this fashion at a time. To copy more than one, put them all in a folder and copy that folder.

The Workspace Manager compresses a file or folder before it copies a chunk onto the floppy disk. Sometimes this makes the file or folder fit on one disk, in which case the Workspace Manager doesn’t request an additional disk after all.
Reusing a disk

1. Insert the disk in the disk drive and choose Check for Disks from the Disk menu.

2. Select the disk in the File Viewer.

3. Choose Initialize from the Disk menu.

4. Choose a file format in the Initialize panel and, if necessary, indicate the disk's size capacity.

5. Type a new name for the disk.

6. Click Erase.

You can erase a disk and change its format by reinitializing it. Just select the disk (or any file or folder on it), and choose Initialize. You can initialize any disk whose contents you can change, such as a floppy disk, an external hard disk, or a removable cartridge disk.

Caution: Initializing a disk destroys all files and folders on it. They cannot be retrieved.

When you choose Initialize, this panel opens:

You can type a new name for the disk here. Press here if you want to choose another format. When dimmed, this value indicates the disk's size capacity. Click to erase the current contents of the disk.

You can give the disk a new name when you initialize it. If the disk is in NEXTSTEP format, you can also rename it later by editing its name in the icon path (just like you rename a file or folder).

On some computers, you must indicate the disk's size capacity—-for example, whether it can hold 720 kilobytes, 1440 kilobytes, or 2880 kilobytes.

If the value on this button isn't dimmed, you must press the button and choose the capacity that matches your disk.
When You Run Out of Room on Your Hard Disk

You should normally have plenty of room on the hard disk in your computer for all your work plus the software you’re using. But if you do run short of space, here are some ways to free some up.

- Delete personal files that you don’t need anymore. You can use the Inspector command to find out which are particularly large. See “Getting Information about a File or Folder” in Chapter 7.
- Empty your recycler. Remember that dragging files to the recycler doesn’t remove them from the disk. You have to open the Workspace Manager File menu and choose Empty Recycler to do that.
- If you receive electronic mail, compact all your mailboxes. See “Compacting a Mailbox to Free Disk Space” in Chapter 14.
- Quit any running applications that you don’t immediately need to use.
- If you haven’t restarted your computer in a few days, try doing so. This frees space that, over time, can get filled with files the computer uses only temporarily.
- Use the Compress command in the File menu to compress files or folders you aren’t using.
- If you installed software in your computer from the NEXTSTEP CD-ROM, you might not need all the software. If so, you can compress or delete some of it to free disk space. See Chapter 19, “Installing New Software.”
- If your needs for disk space have grown, you can also add space by connecting an external hard disk to your computer or by getting a larger hard disk.

The File Viewer shows the amount of space available on the disk that contains the current selection.

If a panel warns that your available disk space is low, you must quit applications or restart the computer. If you don’t, you may soon have problems such as not being able to save work or send Mail messages.

You’re running low on disk space. You may want to quit a few applications or restart your computer to free up space.
Ejecting a disk

1. **Select the disk you want to eject.**
2. **Choose Disk from the Workspace menu.**
3. **Choose Eject from the Disk menu.**
4. **When a message asks you to eject the disk, remove the disk from the computer’s disk drive.**

When you’re done using a removable disk, such as a floppy disk or a CD-ROM, you choose Eject to remove the disk’s contents from the file system. Only after you choose Eject and see the message asking you to eject should you actually remove the disk from the drive.

**Select the disk (or any file or folder on it).**

**Caution:** Don’t remove a floppy disk from the disk drive before a message says to, or else you might lose information from that disk or from the next one you insert.

On some computers, a disk ejects from its drive automatically after you choose Eject.

A floppy disk is automatically removed from your file system when you log out, turn off the computer, or restart it. See “Ending Your Work Session” in Chapter 1.

You can also eject a disk while working in an Open or Save panel. See “Opening and Saving Files on a Floppy Disk” in this chapter.
Opening and saving files on a floppy disk

To make it easy to open and save files on a floppy disk, you can insert and eject disks while working in an Open or Save panel.

1 When an Open or Save panel is open, insert the disk you want to open from or save on.
2 Click the disk button in the panel.
3 Select the file you want to open, or type a name for the one you’re saving.
4 Click OK in the panel.

Caution: Don’t remove a floppy disk from the disk drive before a message says to, or else you might lose information from that disk or from the next one you insert.

You can use the disk and eject buttons to open and eject a floppy disk, a CD-ROM, or any other removable disk.

When you have more than one removable disk in your file system, clicking the disk button repeatedly selects the next disk. To eject a particular disk when more than one is there, you have to select the disk or a file or folder on it, and then click the eject button.

Tip: You can browse several disks, one after the other, in an Open or Save panel. Just insert a disk and click the disk button. Then after browsing, click the eject button, remove the disk, insert another one, and click the disk button again.
TEXT AND GRAPHICS

ry, this Arkansas barrelhouses an—and across t

enues of the wor

Tunes Bo
For most applications you use, you need to know how to type and edit text. In addition, your NEXTSTEP workspace comes with an application that’s specially designed for creating text documents. It’s called Edit, and you’ll find it in the /NextApps folder.

In 1990, jazz and blues legends at the Blue Planet F claimed the ‘90s as the decade of the Earth.

In 1991, record crowds swarmed the Berlin Wall in music gathering in recorded history.

Now, in 1994, over 3 million people are expected to a five-day extravaganza in Washington, D.C. when

Blue Planet Productions presents:

THE THIRD ANNUAL BLUE PLA

“We are the Earl

JAZZ & BLUES HERITAGE FEST

On the Mall in Washington, D.C. • September 17-2

Featuring: Queen of the torch light, Betty James • Francois de la Patisse • Big Daddy Jordan and his Caccitore et il suo Jazz Italiano • Saxophone virtuoso As well as new Blue Planet artist Emily Bright, Dido E of our planet’s best jazz and blues superstars.
Typing and Editing

You think back on typing class in school and laugh. You used to get in trouble for typing off the bottom of the page. And for staring out the window.

You remember daydreaming of a better way to get your thoughts down. A giant page where words would appear as you thought them. Your thoughts could move the words around, too, and make them go away or put them back. You could even make them bigger, smaller, or just plain different.

The teacher tapped you on the shoulder and pointed to your page. The dropped W's weren't your fault. Oh, you misspelled a word. You fumbled with Liquid Paper® and typed the correction. Looking back out the window, you wished someone would invent a machine that could transcribe your thoughts—or at least keep up with them.
Starting up the Edit application

- Double-click the Edit icon in the dock.
- Double-click an RTF file.
- Open the /NextApps folder in the File Viewer and then double-click Edit.app.

The Edit application is a tool for creating formatted documents. You can start up Edit with its icon in the dock or by opening an RTF file (one with an .rtf or .rtfd extension) from the File Viewer.

You create an Edit document in a document window. When you start up Edit from the application dock, a new, empty document window appears. You can also open a new window by choosing New from the File menu.

For information on naming an Edit document, see Chapter 5, "Creating and Saving Files."

Typing text

1. Click in the window where you want to type.
2. Type without pressing Return at the end of each line.
3. Press Return to end each paragraph.
4. Click elsewhere to continue typing there.

You enter text in a document or text field by typing on the keyboard. As you type each character, it appears in the key window at the insertion point.

To move the insertion point and select a new place to type, click where you want the text to appear.

You can also move the insertion point with an arrow key on the keyboard.

Press the left or right arrow key to move the insertion point to the left or right.

The up or down arrow key moves it up or down.

You don’t have to press Return to end a line as you do on a typewriter. Applications automatically break lines between words (a process known as word wrap). You only press Return to cut a line short, as when ending a paragraph.
Most keys on your keyboard are labeled with letters, numbers, punctuation, or other symbols that the keys generate when you press them. You hold down the Shift key to get uppercase letters or the upper characters on keys labeled with two characters. The space bar inserts an invisible space character.

When you hold down a key, the character repeats itself. You can use the Preferences application to adjust the repetition speed. See "Setting the Rate for Repeating Characters" in Chapter 21.

You press Return to end a paragraph. In some panels, pressing Return operates a button.

On most keyboards, you can press Caps Lock to then type uppercase letters without holding down the Shift key. To turn Caps Lock off, press the key again.

You can press Tab to move to the next tab stop in a document or the next text field in a panel. Sometimes holding down Shift while pressing Tab moves in the reverse direction—for example, to the previous field in a panel.

To delete text, you can press the Backspace key, which backs up over text one character at a time.

Two keys to the left and right of the space bar—usually labeled "Alt"—work as your Command key and Alternate key, respectively. Several uses for these keys are given throughout this book.

The numeric keypad provides a convenient way to enter numbers and do calculations. There's no difference between typing the same character here and on the main part of the keyboard.

Finally, if you type when there's no key window or if the key window doesn't accept typing, the computer beeps so you know that your keystrokes aren't doing anything.

If you're using the NeXTUSA keyboard arrangement, your Control, Alternate, Command, and Escape keys are in a different place. You also get keys for adjusting screen brightness and speaker volume, and for turning off the computer. See "The NeXTUSA Keyboard Arrangement" in Chapter 21.
Selecting text

- Drag across the text you want to select.
- Hold down the Alternate key while clicking to select a range between the insertion point and where you click.
- Double-click a word to select it.
- Triple-click anywhere in a paragraph to select the whole paragraph.

To edit text, you usually select it first. Your next action, such as choosing the Delete command, acts on the selection.

One way to select text is to drag across it. Drag horizontally to select text on the same line or vertically to select several lines of text. You can even drag past the edge of your view—for instance, past the bottom of an Edit window—to scroll the window’s contents and keep selecting.

Over 3 million people are expected to gather once again for a five-day blowout in Washington, D.C.

The Alternate key is useful for selecting large amounts of text. You can even scroll beforehand to select more than is currently displayed.

If you select text by double-clicking or triple-clicking, you can drag before releasing the mouse button the final time to extend the selection by a word or paragraph at a time. If you then Alternate-click, the selection is extended to the next word or paragraph boundary.

Tip: In an Edit document, you can select text and any surrounding delimiters, (), [], {}, or « ». Just double-click one of the delimiters.
Deleting and replacing

▶ To delete text as you type, press the Backspace key.

▶ To delete a block of text, select it. Then choose Delete from the Edit menu or press the Backspace key.

▶ To replace text, select it. Then type the replacement text.

Pressing the Backspace key as you type backs up and deletes characters one at a time. When text (or a graphic image) is selected, the Delete command in the Edit menu and the Backspace key on the keyboard do the same thing—they delete the selection.

over 3 million people are expected to gather once again for a five-day blowout in Washington, D.C.

Press Backspace to delete the selection.

over 3 million people are expected to gather once again for a five-day extravaganza in Washington, D.C.

Or enter text to replace the selection.

When you delete a word that you selected by double-clicking, spacing is automatically adjusted around the remaining words. For instance, if you double-click the word *automatically* in the first sentence of this paragraph and then delete it, one space remains between *is* and *adjusted* instead of two.
Moving and copying

1. Select what you want to move or copy.
   You can move and copy text with the Cut, Copy, and Paste commands in the Edit menu. In applications where you work with graphic images, you can typically copy and move them, too.

2. Choose Edit from the application's main menu.
   Choosing Cut removes the current selection and places it on the pasteboard—the computer's holding place for information you're transferring from one place to another. Choosing Copy puts a copy of the selection on the pasteboard. The Paste command inserts the contents of the pasteboard at the insertion point, or if you selected text, in place of the selection.

3. Choose Cut to move the selection or choose Copy to copy it.
   After decades of producing some of the greatest blues and jazz artists, from around the world
   Cut or copy the selection.

4. Put the insertion point where you want the selection to appear.
   After decades of producing some of the greatest blues and jazz artists,
   Move the insertion point.

5. Choose Paste.
   After decades of producing some of the greatest blues and jazz artists from around the world,
   Paste the selection.

You can paste text anywhere you can type—somewhere else in a document, in a text field, even in another application. Just click where you want the text to go.

A selection stays on the pasteboard until you replace it by choosing Cut or Copy again. You can therefore keep choosing Paste to paste the same selection over and over.

When you paste a word that you cut or copied after double-clicking it, spacing is adjusted around the pasted word.
Finding text

You can search for a string of text in a document, such as an Edit document or a Mail message you’re composing. You do this with the Find panel.

You can search for any sequence of characters in the standard text character set, including spaces. In some applications, you can also search for characters such as tabs and returns.

**Find Options in Edit and Mail**

- **Regular Expression** Check this box if you want the Find panel to recognize UNIX regular expressions, which are described in the UNIX manual page for `ed`. Manual pages are available on-line in the extended configuration of the software.

- **Ignore Case** Uncheck the Ignore Case box to distinguish between upper- and lowercase letters during the search—for example, to locate “Planet” but not “planet.”

Commands in the Find menu provide other ways to search for text. See “Standard Commands” in the Reference at the end of this book.
Replacing text that you find

1 Choose Edit from the application's main menu.

2 Choose Find from the Edit menu.

3 Choose Find Panel from the Find menu.

4 Click in the document you want to search.

5 In the Find panel, enter the text you want to find and the replacement text.

6 Click the Next or Previous button.

7 Click a replace button.

In some applications, including Edit and Mail, the Find panel provides easy ways to replace each occurrence of text you find with another string of text. You can replace occurrences one by one, or you can replace them all at once.

Type the text you want to replace here.

Type the replacement text here.

Click one of these buttons after you find text to replace it.

Tip: You can delete one or more occurrences of text you’re searching for by leaving the “Replace with” field empty and clicking a replace button.

Replace Options in Edit and Mail

The Find panel in Edit and Mail has several options for replacing text you find. In Mail, these options apply only for a message you’re composing.

Replace Click this button after finding an occurrence of text to replace it with the text in the “Replace with” field.

Replace & Find Click this button to replace the current occurrence and find the next one, all in one motion.

Replace All You can use the Replace All button to replace all occurrences of the text you’re searching for. Replace All can apply to the entire document or to a selection only, depending on the setting under Replace All Scope.

Entire File If you set the Entire File option under Replace All Scope, Replace All replaces all occurrences in the document.

Selection You can select a portion of a document and set Selection under Replace All Scope. Clicking Replace All then replaces only the occurrences in the selection.
Typing special characters

- To type a special character, hold down the Alternate key—and the Shift key, if necessary—and type the character.

- To type an accented character, type the accent. Then type the character.

You can type an entirely different set of characters than those labeled on your keyboard. You get one set of characters by holding down the Alternate key as you type. You can get another set by holding down the Alternate and Shift keys as you type. For example, type Alternate-2 to get †, or type Alternate-Shift-2 to get ¥.

Some special characters are accents that are meant to appear above or below another character. When you type an accent character, you don’t see it. But the next character you type appears with the accent.

Börg

Type this accented character by typing Alternate-u followed by 0.

If you want the accent by itself, type the accent and then press the space bar.

If Caps Lock is on, typing a character with the Alternate key is the same as holding down Alternate and Shift when Caps Lock isn’t on.

To find out which is your keyboard’s Alternate key, see “Keyboard Basics” in this chapter.
Previewing special characters

1. **Start up the Preferences application.**

2. **Click the button for Keyboard Preferences.**

3. **Click the Keyboard Panel button.**

4. **Press and hold down the Alternate key, with and without the Shift key, to see which characters you can type.**

To find out what each key produces when you hold down the Alternate key, or the Alternate and Shift keys, you can use the Preferences application.

To find out which is your keyboard’s Alternate key, see “Keyboard Basics” in this chapter or “The NeXTUSA Keyboard Arrangement” in Chapter 21.

Some characters that you type with the Alternate key belong to the Symbol font family. See “What Is a Font?” in this chapter and “Special Characters” in the Reference at the end of this book. “Special Characters” also shows which characters are accents.

See also “Starting Up the Preferences Application” in Chapter 20.

You can also click the Alternate or Shift key in the Keyboard panel itself to display the alternate characters. Click the key again to deselect it.
Setting a new font

1 Select the text whose font you want to change, or click where you want to type text in a new font.

2 Choose Format from the application's main menu.

3 Choose Font from the Format menu.

4 Choose Font Panel from the Font menu.

5 In the Font Panel, select the font family, typeface, and size you want.

6 Click Set.

You can give text in a document a different look by setting its font—changing its font family, making it bold, making it three points larger, or making all these changes at once. You use the Font Panel. The new font applies to text you’re about to type at the insertion point or text you select.

In the Font Panel, select a font family by clicking it in this column.

In this column, select a typeface in the selected family.

Type a size for the text in the text field—decimals are okay—or click a size in the column.

Click this button to apply your selections to your document.

Or click this button to undo selections you’ve made in the panel.

Type + or – before a size value to increase or decrease each character in the selection by a certain number of points.

You can double-click a font property to set it without clicking Set. For example, double-click 12 in the Size column to make your selection 12 points.

The top of the Font Panel usually displays the current font—the one you’re about to type at the insertion point or the font of text you select.

The current font appears against a white background.

If you select text that contains more than one font, the top of the panel looks like this.

You can also set font properties by choosing commands such as Bold or Italic from the Font menu. See “Standard Commands” in the Reference at the end of this book.

In some applications, the Font command is in the main menu. See the user’s guide for the application.

See also “What Is a Font?” in this chapter.
You can apply one font property to a selection without affecting other properties. For example, you might select:

**Third Annual Blue Planet**

*We are the Earth*

This selection uses more than one size and typeface. If you set its size to 11 points, the whole selection appears in 11-point but the typefaces stay the same:

**Third Annual Blue Planet**

*We are the Earth*

If you set a family but not a typeface, for example, by double-clicking the family in the Font Panel, a matching typeface in the new family is set automatically. Changing the above example to Helvetica®, for example, makes it look like this:

**Third Annual Blue Planet**

*We are the Earth*

If a matching typeface isn’t available, setting the family but not a typeface has no effect.

**Fonts and Special Characters**

When you work with symbols and graphic characters that aren’t standard text characters, you can change the font family of standard characters in a selection without affecting the other characters. Just don’t set a typeface.

For example, if you select “© Blue Planet,” which is in the Helvetica font family, and then double-click Times® in the Font Panel, the standard characters change to Times and the © remains, as in “© Blue Planet.” If you similarly change “The value πr²” from Helvetica to Times, the standard characters assume the new font but the π remains. If you instead set a typeface in either of these examples, the © or π changes to its equivalent standard character—here, a c or a p.

Some special characters, including π, are actually members of another font family. See “What Is a Font?” in this chapter.
A font is a set of properties—font family, typeface, and size—that determine what text looks like.

A font family is a collection of characters with a consistent design. Families that come with your computer are shown below. As you can see in the table, most families contain standard text characters. Some families, however, have symbols or graphic characters. The Symbol family, for example, has letters from the Greek alphabet and mathematical symbols.

Unlike other families, the characters in the Courier and Ohlfs families all have the same width. Ohlfs is used to display text on the screen—when small, it can be easier to read than Courier. When you print Ohlfs text, however, it appears on paper in Courier.

A typeface is a variation of a font family, such as Bold, Italic, or Bold Italic. Each family has its own set of typefaces.

The size of text is measured in points: A point is 1/72 of an inch. Point size is relative within a font family, so 11-point Times is larger than 10-point Times but looks smaller than 11-point Helvetica.

All characters—even spaces—have a font. If you put the insertion point after the space between two words and start to type, the text appears in the same font as the space character (which may not be the font of any neighboring text character).

The fonts shown below come with your computer. You can purchase others to add to this collection.

<table>
<thead>
<tr>
<th>Font Family</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Times</td>
<td>This family is popular for memos, letters, or other documents.</td>
</tr>
<tr>
<td>Helvetica</td>
<td>This family is often used for headlines or headings.</td>
</tr>
<tr>
<td>Symbol</td>
<td>π ≥ + ≠ © ® ← → Ω</td>
</tr>
<tr>
<td>Courier</td>
<td>This is a standard typewriter family.</td>
</tr>
<tr>
<td>Ohlfs</td>
<td>This family appears only on the screen.</td>
</tr>
</tbody>
</table>
Previewing a font

1. Choose Format from the application's main menu.
2. Choose Font from the Format menu.
3. Choose Font Panel from the Font menu.
4. In the Font Panel, select the font you want to preview and click Preview.
5. Replace text at the top of the panel with text you want to preview.
6. Delete text you entered to display font names at the top of the panel again.

You can see what a font looks like before you actually apply it to your document.

If you hold down the Shift key while clicking the Preview button, the button remains highlighted until you Shift-click it again. While the button is highlighted, each selection you make in the Font Panel is previewed at the top of the panel.
Setting margins, indentation, and tabs

1. Choose Format from the application's main menu.
2. Choose Text from the Format menu.
3. Choose Show Ruler from the Text menu.
4. Drag the left and right margin markers to set the margins for the entire document.
5. Adjust tab and indentation markers to format individual paragraphs.

In many applications, you can use a ruler to alter margins, indentation, and tab stops. The ruler is initially hidden, but you can make it appear in a document window with the Show Ruler command.

![Ruler with margin markers and tab markers](image)

The margin markers set the left and right margins of all text in the document.

You can use commands in the Text menu to align text in a paragraph and to copy and paste ruler settings. See “Standard Commands” in the Reference at the end of this book.

The location of the Text command may vary for some applications. See the user’s guide for the application.
To change the tab stops in a paragraph, click or select text anywhere in the paragraph. Then adjust tab markers. When you press the Tab key anywhere in the paragraph, the insertion point advances to the next position you set with these markers.

Drag a tab marker to reposition it.

Drag it off either end of the ruler to remove it.

Click just below the ruler's scale to create a tab marker.

Indentation markers also apply to the paragraph where you click or make a selection. Drag the ▼ marker to indent the first line of the paragraph. Drag the ▼ marker to indent the rest of the lines of the paragraph.

When you press Return to start a new paragraph, the new paragraph has the same indentation and tab stops as the one preceding it. You can also select several paragraphs to format all at once.

Tip: You can drag the ▼ marker to the right of the ▼ marker to create a hanging indent. If you then align the ▼ marker with a tab marker, you can type a bulleted paragraph.

Proceeds from the 1991 festival protect endangered species in Alaska and Canada, fund a project to regenerate the South American rain forests, and provide environmental scholarships to sixty major universities around the world.

Drag the ▼ marker to indent all but the first line.

Press Tab after the bullet to type this paragraph.
Checking your spelling

1. Click in the document you want to check.

2. Choose Edit from the application’s main menu.

3. Choose Spelling from the Edit menu.

4. Click Find Next in the Spelling panel.

5. When a misspelled word is found, correct it or select another option from the panel.

6. Repeat steps 4 and 5 until you’ve checked the entire document.

In some applications, including Edit and Mail, you can quickly locate misspelled words and choose from possible corrections.

You can choose Check Spelling from the Edit menu to check spelling without opening the Spelling panel. See “Standard Commands” in the Reference at the end of this book.

If a misspelled word is correct for the document you’re checking, click Ignore. For this document only, the panel skips all other occurrences of the word.

You can double-click a word listed in the panel to correct the misspelled word in your document. Then you don’t have to click Correct.
You can even check the spelling of a word that isn’t in a document you’re checking—for example, to determine the correct spelling before you type it.

You can type a word you want to find out how to spell.

Click Guess to see a list of possible corrections.

Dictionary Options

The Spelling panel checks spelling against a 100,000-word English spelling dictionary. It also provides options for selecting from other dictionaries you’ve installed or for modifying a dictionary.

Dictionary  If you’ve installed additional dictionaries, you can press this button to choose the one you want to use. The panel checks spelling against words listed in the dictionary you choose.

Learn  If the panel identifies a correctly spelled word as misspelled, you can click Learn to add the word to the current dictionary. The panel then treats this word as correct when you use any dictionary of the same language.

Forget  You can select a word you’ve added to the current dictionary and click Forget to remove the word from the dictionary.

Ignore  Click this button to treat all occurrences of a word as correct for this document only, without adding the word to the dictionary.

For information on installing additional dictionaries, such as a French or German dictionary, see the instructions that come with the dictionary.
When you want to add color to documents or even change the background color of your screen, you select the colors you want from the Colors panel. The Colors command—which you’ll find in different menus in different applications—opens the Colors panel.
Working with Color

You sense what it must have been like to color the world. Mixing that deep azure blue for the Santa Fe sky and the same color for the Aegean sea.

You could choose from a rainbow of colors or mix your own. Some colors would mix like paint, others like light. You could see through some colors—the ones you chose for water in a lake or the crystals of a semiprecious stone. You might name some of the colors and collect others in swatches or images. Your colors would never fade, and there would never be a mess.

Yeah, whoever created the world did a pretty good job. But you wonder how they managed without your computer.
Using color in a document

1. Open the Colors panel.
2. Select the color you want.
3. Drag the color from the color well to selected text in the document.

When you send Mail messages, you can send them in color. When you write a memo in Edit, you can highlight the text with color. In any application that has a Colors panel, you can create documents in color, black and white, or shades of gray.

For more information about the color wheel, see “Selecting a Color from the Color Wheel” in this chapter.

For other ways to select colors, see the instructions throughout this chapter.

Some applications have color tools—for drawing in color, for example. These tools typically use colors from wells in the application’s Inspector panel. To put color in one of these wells, you select a color in the Colors panel and drag it to the color well in the Inspector panel.
Creating color swatches

1. **Open the Colors panel.**
   - When you need to use the same colors over and over, you can save them as swatches in the swatch bar at the bottom of the Colors panel.

2. **Select a color.**

3. **Drag the color from the color well to the swatch bar.**
   - Each swatch has its own cell in the swatch bar. When you drag a new color to a cell, it replaces the existing color. You can make room for more swatches—hundreds of them—by making the Colors panel bigger.
   - All Colors panels have the same swatches. When you put a color swatch in the swatch bar in one application, it instantly appears in the Colors panels in other applications. The swatch remains there until you replace it with a new swatch.

**Where to Find the Colors Panel**

You use the Colors command to open the Colors panel.

In text applications like Edit and Mail, the Colors command is in the Font menu. (Choose Format from the main menu and then choose Font from the Format menu.) In applications that have color tools, the Colors command is typically in the Tools menu.

If you want to have the Colors panel at your fingertips, you can create a keyboard alternative for the Colors command and use it in any application that has a Colors command. See “Creating Command-Key Equivalents” in Chapter 20.
Selecting a color from the color wheel

1 Open the Colors panel. The color wheel is a quick, visual method for selecting colors.

2 Click the color wheel button.

3 Click or drag in the color wheel to select the color you want.

4 Drag the brightness slider to make the color lighter or darker.

As you move around the wheel, the hues change. Hue is what distinguishes between red and yellow or yellow and green, for example. The colors on the rim of the wheel are the most saturated. You can think of saturation as the intensity of the color—or how much of a particular hue is in the color. As you move toward the center of the wheel, the colors become less saturated and more neutral or washed out. At the very center of the wheel, they appear white.

What Happens When You Print Colors

The colors you see on the screen can never precisely match printed colors because screen colors are created with light, while printed colors are created with pigments. Also, colors printed by different printing methods never look exactly alike.

However, your NEXTSTEP computer has some features that help you get the color you want. Most colors you select in the Colors panel are calibrated so that they look the same when you print them on different brands of Level II printers.

The exceptions are the CMYK and PANTONE® Colors described later in this chapter. If you’re an expert color graphics user and are using a traditional printing process, you can use these color models to specify colors numerically—for exact results.

If you’re not an expert, you should use one of the other models and a Level II printer to produce your printed images. Check the owner’s guide that comes with your printer to find out if it’s a Level II printer.
Selecting colors from the screen

1. **Open the Colors panel.** You can capture any color that's on the screen and use it in a document or save it as a color swatch.

2. **Click the magnifying glass.** When you click here, the cursor changes to a magnifying glass.

3. **Click a color on the screen.** Use the magnifying glass to find the color you want.

When you move the magnifying glass around the screen, it shows a magnified picture of every pixel you drag it over. (A **pixel** is one of the dots that makes up the image on the screen.)

You center the color you want between the crosshairs and click.
Mixing your own colors

You can mix your own colors—or shades of gray—using one of four models built into the Colors panel. Each of these models creates colors differently.

For example, the **RGB color model** mixes colors by blending red, green, and blue light. This is a standard model for representing color on computer screens. The slider values indicate brightness, which can range from 0 for minimum brightness to 255 for maximum brightness.

The **CMYK color model** simulates the four-color printing process, which creates colors by combining cyan, magenta, yellow, and black inks. The slider values indicate saturation, which can range from 0 for no saturation to 100 for maximum saturation.
The *HSB color model* mixes colors by adjusting hue, saturation, and brightness. You can think of hue as the color name—red, green, or yellow, for example. Saturation is the intensity, or how much of a particular hue is in the color. Brightness is how dark or light the color is.

In addition to these three color models, you can use the grayscale model to work with shades of gray. The values on the grayscale slider show the percent of white in the gray.

If you’re working with both color and shades of gray, you can also select shades of gray with the other models. In the RGB model, you set the same values for all three sliders. In the CMYK model, you set the cyan, magenta, and yellow sliders to 0 and adjust the black slider. In the HSB model, you set the hue and saturation sliders to 0 and adjust the brightness slider.
Using an image as a palette

1 Open the Colors panel.
2 Click the palette button.
3 Choose an image from the pop-up list at the top of the panel.
4 Click or drag in the image to select the color you want.

You can use an image as a color palette. For example, if you have a cover image for a color brochure, you can keep it in a list of palettes in the Colors panel. Then you can pick up one of the colors from it to use in the text of the brochure.

Some applications come with several images to use as palettes. You can also add your own images as described next.

You can also select a color directly from an image on the screen. See “Selecting Colors from the Screen” in this chapter.
Adding an image to the list of palettes

1. Open the Colors panel.

You can add images to a list of palettes in the Colors panel to turn any image file into a palette.

2. Click the palette button.

3. Press Palette and choose the New from File command.

4. Select an image file and click OK.

You can press Palette and choose Rename to change the name of an image. You can also remove images from the list with the Remove command. All the images you add are saved as TIFF files in your ~/Library/Colors folder.

Tip: If you want to use part of a color image as a palette, you can select the part you want and copy it to the pasteboard. Then open the Colors panel, click the palette button, press Palette, and choose the New from Pasteboard command. The image on the pasteboard appears in the Colors panel, and it's listed as an unnamed palette in the list at the top of the panel. Also, if you want to use the image in the color palette in a document, you can press Palette, choose Copy, and then use the Paste command in your application to paste it.
Opacity and Transparency—When You Want Layers of Color

Sometimes you want layers of color. Maybe you want to show color text over a color photograph. Maybe you want the text to block part of the image behind it. But maybe you don’t. Maybe you want the image to show through your words.

Or maybe you want to blend two or more images into a collage of semitransparent objects that overlap each other but don’t block each other out.

In some applications, the Colors panel has an Opacity slider. You can use this slider to make selected objects and text as opaque or transparent as you want.

When you move the Opacity slider, you begin to see a split pattern in the color well. It’s as though you were looking through a colored glass at a surface that’s half black and half white. The more transparent the color becomes, the more clearly you see the black-and-white contrast.

In some applications, you can select individual pixels and change their opacity, so you can make parts of the image transparent. For details, see the user’s guide for your application.
Simulating PANTONE Colors

1 Open the Colors panel.
2 Click the PANTONE button.
3 Choose one of the PANTONE lists from the pop-up list at the top of the panel.
4 Click the color you want in the list.

PANTONE Colors are part of a proprietary system designed by Pantone, Inc., for matching colors with professional printing inks. This system includes several thousand colors, each of which has a name and formula. People who work with professional printers use these color names to specify the exact color they want on the final printed copy. You can simulate these colors on the screen with the PANTONE lists in the Colors panel.

If you know the name of the color you want, you can press Color, choose Find, and type the name—or part of the name—in the panel that opens.

Why You Need Two PANTONE Lists

The Colors panel has two PANTONE lists—PANTONE and PANTONE Process.

The PANTONE list simulates custom-blended color inks. These are the inks that printers typically use on a one- or two-color press when you specify a PANTONE Color.

When you’re printing with process colors—cyan, magenta, yellow, and black—to get full-color images, you can specify a color from the PANTONE Process list. Such a color is produced by a mathematically defined combination of the four process colors.
Creating your own color list

1. Open the Colors panel.

2. Select the first color you want to put in the list.

3. Click the PANTONE button.


5. Select another color, click the PANTONE button, press Color, and choose New.

6. Repeat step 5 for each color in the list.

You can create your own list of colors and select them by name in the Colors panel. For example, if you have a publication that uses a standard palette of colors, you can name the colors and save them in a list like the PANTONE Colors described earlier.

When you create a new list, it appears as an unnamed list in the pop-up list at the top of the panel. You can press List and choose Rename to give it a name. You can press Color and choose Rename to name individual colors in the list.
You can add as many colors as you want to the list. You just select each color one at a time, press Color, and choose New.

You can press Color and choose Remove to remove selected colors you don’t want in the list. If you no longer need the list, you can press List and choose Remove to remove it. You can’t remove, rename, or change a PANTONE list.

If Your Application Supplies Color Lists

Some applications supply color lists. They’re stored in files with the extension .clr. You can open these lists in the Colors panel and use them like the PANTONE Colors or color lists you create. You can press List and choose Open to find them in your file system. When you select a .clr file and click OK, it appears in the list. You can also drag the file icon directly into the list in the Colors panel.

All color lists that you create as well as those you get from applications are kept as .clr files in your ~/Library/Colors folder. When you open an application’s list with the Open command, a copy of the original file appears in the folder. When you remove the color list, the original file remains in your file system. However, if you remove a list you created, the Remove command permanently removes it from the file system, and it can no longer be retrieved.

For more information, see the user’s guide for your application.
You can drag or paste graphic images into your pages. You can even link the images you add to the originals, so the copies in your pages are always up to date.
You can preview how your pages will appear before you print them. And you can use the Grab application to take pictures of all or part of the screen.

In 1990, jazz and blues legends at the Blue Planet Festival's Paris debut claimed the '90s as the decade of the Earth.

In 1991, record crowds swarmed the Berlin Wall in the largest peace and music gathering in recorded history.

Now, in 1994, over 3 million people are expected to gather once again for a five-day extravaganza in Washington, D.C. when...

Blue Planet Productions presents:

THE THIRD ANNUAL BLUE PLANET
I have a single eye of glass. I can make an exact copy of anything I see, surround it with glorious scriptures, change a hundred faces with a single command, and show you what I see before you see it. What am I?

You have three minutes to solve the riddle. The priestess sets the sands in motion. The pot of gold is inches away.

Seconds pass. Your mind drifts to what you’ll do with all those riches—a yacht, a totally intense stereo, a gigabyte disk drive. No, you have to concentrate. Exact copies, text integration, automated updates, image previews—only five seconds left!

Then you see it in a flash. It’s your computer. You gasp the word NEXTSTEP as the last grain of sand falls noiselessly into place. The priestess hands you the gold, but you’re not quite satisfied.

Wait, you say. You forgot the part about user-defined link buttons, timed snapshots, detailed color analysis...
Adding a graphic image

1 Click in the document where you want the graphic image to appear.

2 Drag the icon for the graphic file from the File Viewer into the document window.

You can add a graphic image to documents, such as Edit documents or Mail messages. The image may be a file in TIFF, EPS, or another graphics file format.

If you add a graphic image to an Edit document that contains only text, the document is converted to an untitled RTFD file. (RTFD files are Edit file packages that contain Rich Text and one or more graphic images.)

For more information about file packages, see “File Packages—Files That Are Really Folders” in Chapter 3.

You select graphic images you want to copy differently in different applications. For more information, see the user’s guide for your application.
If you want to add only part of a graphic image, you can use the commands in the Edit menu to copy the part of the image you want and then paste it in the document where you want to add it.

You can’t modify the contents of graphic images you add to text documents. You can only move, copy, or delete them with the commands in the Edit menu.

**Graphics File Formats**

Graphic images and the documents they’re created in can be stored in a number of different formats. The most common are:

**TIFF**  
Tag Image File Format is a format for single-page or smaller images. TIFF files typically include grayscale or color halftones (such as photographs or shaded art) or screen images, as well as other kinds of art. The Grab application creates TIFF files. TIFF files have a .tiff extension.

**EPS**  
Encapsulated PostScript is another format for single-page or smaller images. EPS files typically include black-and-white, grayscale, or color text or line art (such as technical drawings), as well as other kinds of art. Unlike TIFF files, EPS files can look good at almost any scale or resolution. Many illustration applications create EPS files. EPS files have an .eps extension.

**PS**  
PostScript is a format for single- or multiple-page files. They can include the same kinds of information as EPS and TIFF files, but they also include information about how text and images are oriented on one or more pages. PS files can include fonts and printer-specific information for how they should be printed. As a rule, you can’t add PS files to your documents, but you can open them in Preview and print them. PS files have a .ps extension.

For more information, see “What Is a PostScript File?” in Chapter 15.
Adding linked graphics

1. Select the graphic image you want to add in the graphics application and choose Copy from the Edit menu.

2. Click in the document where you want to add the linked image.

3. Choose Link from the Edit menu.

4. Choose Paste and Link from the Link menu.

You can add a linked graphic image to your documents. Then if the original image is changed, the linked copy in your document is updated automatically.

You can use the commands in the Edit menu to copy, move, or delete the linked image.

What You Can Link

To work with linked graphics, your application must be able to receive linked information. Such applications have a Paste and Link command in the Link menu. In addition, the application where the graphic image was created must be able to supply linked information. For example, the Edit application (in /NextApps) can receive linked information, while the Draw application (in /NextDeveloper/Demos) can both receive and supply linked information.

Some applications can supply linked information that isn’t a graphic image, such as text or database information. You add this information to a document the same way you add linked graphics.

See the user’s guide for your application to find out whether it can receive and supply linked information.

For information about selecting and copying the images you want to paste and link, see the user’s guide for your graphics application.
Adding a link button

1. **Select a graphic image or other information you want to link to and choose Copy from the Edit menu.**
   - In some applications, you can add a link button to a document. The button is linked to a graphic image or other information in another file. If you click the link button, the file the button is linked to opens in a window.

2. **Click in the document where you want to add the button.**

3. **Choose Link from the Edit menu.**

4. **Choose Paste Link Button from the Link menu.**

To find out whether your application can add link buttons and supply linked information, or for more information about selecting and copying information you want to link to, see the user’s guide for your application.

You can select a button in most applications by dragging across it. Then you can drag one of its corners to resize it, or you can copy, move, or delete the button with one of the commands in the Edit menu.

To add a link button, your application must have a Paste Link Button command in its Link menu. In addition, the application where the original information was created must be able to supply linked information. For example, the Draw application in /NextDeveloper/Demos can both add link buttons to its documents and supply linked information.
Publishing an image as a link file

1. **Select a graphic image in a document.**

2. **Choose Link from the Edit menu.**

3. **Choose Publish Selection from the Link menu.**

4. **Type a name for the link file and select the folder where you want to save it.**

5. **Click OK.**

In some applications, you can select part of a graphic image or other information you want to share and “publish” the selection as a link file. Then you can drag the link file into other documents to add the graphic image as a linked graphic image.

When you choose Publish Selection from the Link menu, the Publish panel opens.

You can share link files with others by storing them in a folder that others can open, or by mailing them.

*Link files have an .objlink extension. Their icons look like this.*

To publish a selection, your application must have a Publish Selection command in its Link menu. In addition, an application must be able to receive link files for you to be able to drag them in. For example, the Draw application in /NextDeveloper/Demos can both publish selected images as files and add a link file as a linked graphic image if you drag one in.
Editing and updating links

1 Select a linked graphic or link button.

2 Choose Link from the Edit menu.

3 Choose Link Inspector from the Link menu.

You can use the Link Inspector command to update and get information about linked graphic images, link buttons, and other linked information.

The Link Inspector panel shows the pathname of the file the linked graphic image is linked to and the date and time the link was last updated.

You can change how and when a link is updated by choosing an option from the Update pop-up list.

![Link Inspector panel]

You can use the Show Links command in the Link menu to highlight all the linked graphic images in your document with a chain-link pattern. See “Standard Commands” in the Reference at the end of this book.

If you choose Manually, the link is updated only when you click “Update from Source” in the Link Inspector. If you choose When Source Saved, the link is updated only when the original file is saved. If you choose Continually, the link is updated as soon as the original is changed.
Previewing pages

- Choose Print from your application's main menu and then click Preview.
- Double-click a PostScript (PS) file, if you've saved your pages in this format.

You can preview your pages on screen before you print them, so you can see how they will look when you print them.

When you click Preview or double-click a PostScript file that has a .ps extension, the Preview application starts up and displays the first page of the file in a window.

For more information about PostScript files and how to create them, see “Saving Your Pages as a PostScript File” in Chapter 15.

For more information about the commands in the Display menu, see “Preview Commands” in the Reference at the end of this book.

Tip: If you're having trouble previewing a file, start up the Preview application in the /NextApps folder. Then try to open the file with the Open command in Preview's File menu, but click Use Simple Mode in the Open panel before clicking OK. Some of Preview's commands aren't available in simple mode, but you can open a wider range of graphics files.
Previewing graphic images

1 Start up the Preview application by opening the /NextApps folder and double-clicking Preview.app.

2 Choose File from the Preview menu.

3 Choose Open from the File menu.

4 Select a graphics file in the panel.

5 Click OK.

You can preview a graphic image in TIFF, EPS, and other graphics file formats to see how it will appear when you add it to a document or print it.

![Graphics files open in a Preview window sized to fit the image.]

You can use the Zoom In and Zoom Out commands in the Display menu to enlarge and reduce the image.

You can also use the Inspector command in the Workspace Manager to preview a graphic image. See “Previewing the Contents of a File” in Chapter 7.
Starting up the Grab application

- Open the /NextApps folder in the File Viewer and double-click Grab.app.

You can use the Grab application to take a picture of your computer screen—or part of the screen. You can print the image you grabbed or save it as a TIFF file.

The Grab application icon looks like this.

Normally when you start up Grab, the Grab menu appears, but the rest of the screen remains unchanged. You can grab the entire screen, a window, or a part of the screen you select.

If You Want to Grab the Cursor

When you use the Grab application, you can pick a cursor style you want to include in the images by choosing the Choose Cursor command from the Grab menu.

This option applies when you grab the screen, grab the screen with a time delay, and when you grab a window. These techniques are described in this chapter.

The cursor you pick appears in place of Grab’s cursor wherever you place it at the moment the picture is taken.

You can use the Turn Sound Off command in the Info menu to turn off the sound effects that accompany the screen grabbing animation. See “Grab Commands” in the Reference at the end of this book.
Grabbing the screen

1 Start up the Grab application.

2 Choose Grab from the main menu.

3 Choose Screen from the Grab menu.

4 Arrange the windows, panels, and other images on the screen the way you want them.

5 Click the camera icon at the top of the dock.

6 Click anywhere on the screen.

You can use Grab to take a picture of the whole screen.

When you choose Screen from the Grab menu, a camera icon appears in the upper right corner of the screen, usually replacing the NeXT icon at the top of the application dock. When you click the camera icon, an eye behind the camera looks left and right as you move the cursor to remind you that, when you next click the mouse button, the whole screen will be grabbed.

Each image you grab is displayed in a new, untitled window. You can use the Save command to name the image and save it as a TIFF file.
Grabbing the screen with a time delay

1. Start up the Grab application.
2. Choose Grab from the main menu.
3. Choose Timed Screen from the Grab menu.
4. Click the camera icon at the top of the dock to start the timer.
5. Arrange the windows and cursor on the screen the way you want, and "hold the pose" until the screen is grabbed.

You can use Grab to take a picture of the screen after a 10-second delay. The delay gives you time to set up images that are possible only when the mouse button is pressed, such as choosing an option from a pop-up list or dragging a file to a folder.

When you choose Timed Screen, a camera icon appears at the upper right corner of the screen, usually replacing the NeXT icon at the top of the application dock.

When you click the camera icon, the stopwatch behind the camera counts off the seconds until the screen is grabbed.

A stopwatch counts the seconds before the screen is grabbed.

You can use the Timed Screen command to capture images that appear only when the mouse button is pressed.

Each image you grab is displayed in a new, untitled window. You can use the Save command to name the image and save it as a TIFF file.
Grabbing a window

1. Choose Grab from the main menu.
2. Choose Window from the Grab menu.
3. Open and arrange the window you want to grab.
4. Click the camera icon at the top of the dock.
5. Click in the window you want to grab.

You can use Grab to take a picture of a single window on the screen. The window you grab can be a standard document window, a panel, a menu, or even an icon in the application dock.

When you choose Window, a camera icon appears at the upper right corner of the screen, usually replacing the NeXT icon at the top of the application dock. When you click the camera icon, an eye behind the camera looks left and right as you move the cursor to remind you that, when you next click the mouse button, the window you click in will be grabbed.

Select the window you want to grab and click the camera icon. Then click in the window you want to grab.

Each image you grab is displayed in a new, untitled window. You can use the Save command to name the image and save it as a TIFF file.

Tip: If you want to grab an image that includes transparent elements, you must grab the window that contains the image. Otherwise, information about transparency is lost.
Grabbing a portion of the screen

1. **Start up the Grab application.**

2. **Arrange the screen so the windows, icons, and other parts you want to grab are visible.**

3. **Choose Grab from the main menu.**

4. **Choose Selection from the Grab menu.**

5. **Drag across the rectangular area of the screen you want to grab.**

You can use Grab to take a picture of any portion of the screen. When you choose Selection, the cursor becomes a right angle to help you position the top left corner of the area you want to grab. As you move the cursor on the screen, a pair of numbers shows you the distance (in pixels) from the bottom left corner of the screen to the top left corner of the cursor. When you press the mouse button and start to select part of the screen, the numbers change to tell you the width and height (in pixels) of the area you're selecting.

When you release the mouse button, the selection is displayed in a new, untitled window. You can use the Save command to name the image and save it as a TIFF file.
Inspecting an image you grabbed

Choose Inspector from the main Grab menu.

You can use the Inspector command to get information about the screen images you grab.

When you choose Inspector, the Image Inspector panel displays information about the grabbed image in the main window.

The numbers show the width and height—in pixels—of the image.

Alpha and Depth—What They Mean

The Image Inspector panel includes two pieces of information you may not be familiar with: alpha and depth.

Alpha is the part of the image that contains information about what areas are transparent and how transparent they are (on a scale from transparent to opaque). “Image has alpha” is checked only if you’re inspecting an image you grabbed with the Window command, and if the application whose window you grabbed includes transparency information in its documents.

Depth indicates how much information there is for each pixel (or picture element) in the image. For example, if the depth is 2, only one of four colors or shades of gray is possible for each pixel (as on a monochrome display). If the depth is 24 or higher, each pixel can be one of over 16 million colors or shades of gray.
On-line references give you access to information when you need it. Digital Webster gives you definitions and synonyms. Digital Librarian turns your folders into indexed collections of information for easy search and retrieval. And for addresses and phone numbers, you can keep an on-line address book.

**barrelhouse** \(\text{ˈbər-əl-ˌhau̯s}\)  
(1883)  
1: a cheap drinking and usu. dancing establishment  
2: a strident, uninhibited, and forcefully rhythmic style of jazz or blues

§ Thesaurus:

**barrelhouse**  
**syn** DIVE, hangout, honky-tonk, joint

**barrelhouse**  
**syn** HURRY 2, barrel, bucket, fly, holler

---

**Beale Street**

4 found  
In Contents  
Word

**Reaction Reports/Out of Town/Beale Street/John's.rtf**  
**Songs/Lyrics/Beale Street Blues.rtf**  
**Venues/Artist Bios.rtf**  
**Venues/Draft Artist Bios.rtf**
Using On-Line References

It’s your first assignment for the toughest editor in the industry. Few have survived working for him, and now you know why. You’re supposed to dig up articles about oil tycoons in banking—every single one that’s appeared in the last year. It’s a daily paper with two editions. You have two hours.

You feign dismay and then trot home to your computer. You log into the paper’s archive server. While the computer indexes articles, you compile personal data on major oil tycoons. Then you run a search for articles with the words *bank* and *oil* and finish with a half hour to spare.

The editor just scowls and assigns you a day-in-the-life-of-a-driller piece, due tomorrow morning. You suppress a grin. You worked in the oil fields summers to put yourself through college. But you don’t tell him that.
Starting up Digital Webster

- Double-click the Digital Webster icon in the dock.

  Or

- Open the /NextApps folder in the File Viewer and then double-click Webster.app.

Digital Webster gives you on-line access to two standard reference guides: *Webster’s Ninth New Collegiate Dictionary* and *Webster’s Collegiate Thesaurus*. The on-line versions supply nearly all the information you would find in the hardbound editions.

![The Digital Webster application icon](image)

When you start up Digital Webster, a window with several search options opens.

![Digital Webster window](image)

You can use the dictionary to look up the meaning and pronunciation of a word and to check its spelling. You use the thesaurus to find synonyms.
Starting up Digital Librarian

- Double-click the Digital Librarian icon in the dock.
  Or
- Open the /NextApps folder in the File Viewer and then double-click Librarian.app.

You can turn any file or folder into an on-line reference. You just put it on your Librarian bookshelf or another bookshelf that you create with Digital Librarian. Then you can search in it for words or phrases—or for file and folder names.

When you start up Digital Librarian, it opens the Librarian bookshelf.

If Digital Librarian is running, you can also search from other applications by setting up a search service. Or you can file information from documents or Mail messages in a notebook folder on the bookshelf. So you may want to start up Digital Librarian automatically when you enter the workspace and use the Preferences command in Librarian’s Info menu to hide the application automatically.

To start up Digital Librarian automatically when you enter the workspace, see “Starting Up an Application Automatically” in Chapter 4.

To use Librarian’s services in other applications, see “Setting Up a Search Service” and “Setting Up a Jotting Service” in this chapter.
Looking up a definition or synonym

1 **Start up Digital Webster.**

2 **Type the word you want to define.**

3 **Click to open the dictionary or thesaurus or both.**

4 **Click Define.**

You can look up the meaning and pronunciation of any word in Webster’s on-line dictionary.

When you click the Define button, it becomes a stop sign. You can click it to interrupt the search. You can also click the up and down arrow buttons to see definitions of previous words that you’ve looked up.

**How Digital Webster Looks for Words**

When you type the word you want to define, Webster normally searches the dictionary for all the definitions in which the word appears in bold type. If you want to search in every dictionary definition where the word appears, you can click Other Word in the Digital Webster Preferences panel.

If you want to find derivative words, you can click Prefix in the Preferences panel. Then, when you type *legend*, Webster finds the definition of *legend* as well as *legendary*.

For more information about the Preferences command, see the Info menu under “Digital Webster Commands” in the Reference at the end of this book.
When the thesaurus is open, you get a list of synonyms for the word you type.

![Digital Webster interface]

**Tip:** If you’re working in another application, such as Edit or Mail, you can select a word in your document and choose Services from the main menu. Then choose Define in Webster to see the definition. Digital Webster starts up automatically and finds the definition for the word, provided the dictionary is open in the Digital Webster window. It also finds synonyms if the thesaurus is open.
Looking up information

1. **Start up Digital Librarian.**
   Digital Librarian comes with your home folder and an empty notebook on the Librarian bookshelf. You can search these folders—or folders that you add—for any word or phrase.

2. **Select a target from the bookshelf.**

3. **Type the word or phrase you want to search for.**
   - **Type a word or phrase here.**
   - **Click here to start the search.**
   - **Press to choose the search options you want.**

4. **Click Search.**

5. **Double-click a file to show its contents.**
   - When you select a file, its icon appears here.
   - You can click here to list all the files in the selected folder instead of searching for a word.

When you click Search, Librarian starts searching the selected target for the word or phrase you typed. As it searches, Librarian displays each file that contains the word or phrase you’re searching for. If you select more than one target, it lists the files by target.

If the target folder is large and the search takes more than a few moments, a stop sign appears. You can continue working while Librarian searches. For example, you can open one of the files you find while Librarian continues searching for others. Or you can click the stop sign to interrupt the search.

*Note: If the target folder you’re searching contains a second target folder on your bookshelf, Librarian skips all the files in the second target. You must search that target separately.*
Options for Your Information Search

When you search a folder for information, you can choose several options from two pop-up lists in the bookshelf window.

Where Librarian Searches
The first pop-up list gives you choices for where Librarian searches for the word or phrase you type:

In Contents To search the complete contents of the files for the word or phrase.

In File Names To search only the folder and file names in the target folder for the word or phrase.

What Librarian Searches For
The second pop-up list gives you choices for what Librarian searches for:

Words To search for every occurrence of a word or set of words that you type in the search field. For example, if you type oldtime fiddle in the field, Librarian finds every document in which both oldtime and fiddle occur, whether they occur together or not.

Prefix To find every occurrence of a search word and words that start with the word. For example, if you type fiddle, Librarian also finds fiddler.

Within To find every occurrence of a search word, even if it appears within another word. For example, if you type rise, Librarian also finds arisen.

Literal To search for every occurrence of the complete phrase as you type it. For example, if you type oldtime fiddle in the search field, Librarian finds every occurrence of the phrase oldtime fiddle.

Expression To search for UNIX regular expressions, which are described in the UNIX manual page for ed. Manual pages are available on-line in the extended configuration of the software.
Viewing results

- To view a file that contains your search word, double-click the file name in the bookshelf window.

- To see related files or folders, select the file or folder that contains your search word, choose File from the Librarian menu, and then choose Open Folder from the File menu.

When you find a file or folder that contains the word or phrase you’re searching for, you can open it to view it. If it’s a text file, it normally opens in a Librarian window, where you can search it quickly. Other types of files open in the appropriate application.

When you open a file in a Librarian window, the first occurrence of the search word or phrase is highlighted.

Sometimes you may find that a file contains only part of the information you’re looking for. A quick way to find related information is to select the file and choose Open Folder from the File menu. Librarian opens a folder window for the folder that contains the file. You can then browse to see other files and folders that may be related.

If you want to open text files in a window other than a Librarian window, use the Preferences command in the Info menu to choose this option. See “Digital Librarian Commands” in the Reference at the end of this book.

You can use the standard Edit, Format, and Print commands in a Librarian window. See “Standard Commands” in the Reference at the end of this book.
Sorting results

1. **Start up Digital Librarian.**

2. **Select a target from the bookshelf.**

3. **Choose Target from the Librarian menu.**

4. **Choose Inspector from the Target menu.**

5. **Choose Searching from the pop-up list in the panel.**

6. **Click the sort option you want.**

When you look up information in a target, Librarian normally displays the results—the files and folders that contain your search word—in alphabetical order. But you can choose to display them in other ways.

![Target Inspector](image)

<table>
<thead>
<tr>
<th>Sort results:</th>
</tr>
</thead>
<tbody>
<tr>
<td>By description</td>
</tr>
<tr>
<td>By weight</td>
</tr>
<tr>
<td>By date</td>
</tr>
<tr>
<td>Unsorted</td>
</tr>
</tbody>
</table>

Choose Searching from this pop-up list.

- Lists files alphabetically.
- Lists files with the most “matches” for your search word first.
- Lists files according to the date they were last changed—oldest first.
- Lists files in the order they are found.

You choose a sorting option for each target on your bookshelf. It applies to all subsequent searches of the selected target until you choose a new option.

Librarian only sorts the results of searches of indexed targets. For information about indexing, see “Indexing Targets” in this chapter.
Choosing a search language

1 Start up Digital Librarian.
2 Select a target from a bookshelf.
3 Choose Target from the Librarian menu.
4 Choose Inspector from the Target menu.
5 Choose Languages from the pop-up list at the top of the panel.
6 Click the language you want to search in.

Librarian uses different approaches to indexing for different languages. So if you look up information in documents written in different languages, you should choose the appropriate language for searching and indexing them. You can choose a different language for each target on your bookshelf.

Which Languages Are Available

The list of languages in the Target Inspector depends on which readers you have installed. Readers are files that are used to set up indexes for different materials in different languages.

For example, English.reader sets up indexes for English-language materials. Japanese.reader sets up indexes for Japanese-language materials. These files are in the /NextLibrary/Readers folder.
Adding a target to the bookshelf

1. **Start up Digital Librarian.**
2. **Select the file or folder you want to add in the File Viewer.**
3. **Drag the file or folder icon to the bookshelf.**
4. **Choose Bookshelf from the Librarian menu.**
5. **Choose Save from the Bookshelf menu.**

Any information in your file system can be part of your on-line reference library. You simply add files and folders to the bookshelf to include them as targets.

You can add the target temporarily to search for information when you need it. If you want to keep the target on the bookshelf permanently, you must save the change to the bookshelf. When you no longer need a folder as an on-line reference, you can drag it off the bookshelf to remove it.

The contents of a target change as you work—so they are always up to date with the corresponding file or folder in the File Viewer.
Indexing targets

1 Start up Digital Librarian.

2 Select a target from the bookshelf.

3 Choose Target from the Librarian menu.

4 Choose Inspector from the Target menu.

5 Choose Indexing from the pop-up list at the top of the panel.

6 Click Set Up.

7 Click Update.

You can index your target files to search more quickly. When you index a target, Librarian creates a list of all the significant words and marks them with pointers to their location in the file or folder. Then Librarian uses the index to find your word or phrase quickly.

You index a target in two stages. First you set up the index. This step creates an empty index. Then you update the index. This step finds all occurrences of all the words and records their location in the index. You must index each target individually.

Indexes take up space on your disk. For more information, see “How the Index Works” in this chapter.
You can update when you first set up the index or just before you search. You can also update the index periodically to include new information that you’ve added to the target folder. Periodic updating is particularly useful for your home folder, which changes frequently, and for folders with large volumes of technical information, such as program code, that you may need to refer to as you work.

You can index only folders and files that you have permission to read or write in.

For information about file and folder permissions, see “Permissions Granted” in Chapter 6 and “Changing Permissions for a File or Folder” in Chapter 7.
How the Index Works

Digital Librarian uses indexes to make searching for information faster.

What's In an Index
Librarian's standard indexing scheme creates indexes that contain all words of two or more letters other than common words such as the, like, and me. Also, as it indexes a target, Librarian removes all punctuation except hyphens, apostrophes, and underscores. A word that contains a hyphen, apostrophe, or underscore is indexed as a single word. For example, honky-tonk, is indexed as one word, not two.

When You Don't Want to Index
You can search targets whether you index them or not, and in some cases, you may not want to use an index.

For example, if you want to be able to find every word, don't index the target. Librarian excludes some words from an index.

Also, indexes occupy disk space. You may not want to keep a lot of indexes on your disk.

How Much Space It Takes
Indexes are stored in the folder they index in a hidden file named .index.store. (See "Displaying UNIX Files" in Chapter 20 to display hidden files.)

The size of index files depends on several factors, including the number of files in the folder you index, the absolute size of the data, the number of distinct terms, and the distribution of terms. Some folders and files thus require proportionally larger indexes than others.

For example, an index for a file that contains ASCII text may be as large as 30 percent of the size of the file. An index for a file in Rich Text Format (RTF) requires less space because formatting characters—which take up space in the original file—are not indexed in the index file. An index for your home folder requires still less space because applications, Mail messages, and some other types of files are not indexed at all.

If You're a Programmer
If you're a programmer, you can also create your own custom indexing scheme and use it to index individual targets on your bookshelf. For more information, see the NEXTSTEP Developer's Library.
Creating a new bookshelf

1. **Start up Digital Librarian.**
2. **Choose Bookshelf from the Librarian menu.**
3. **Choose New from the Bookshelf menu.**
4. **Choose Save from the Bookshelf menu.**
5. **Type a name for the bookshelf and click OK.**

If you have a lot of folders that you want to use as on-line references, you may want to create additional bookshelves to organize them. A bookshelf is a file that contains all the information about the targets you add and their indexes.

When you choose New from the Bookshelf menu, a new, empty bookshelf window opens. When you choose Save, a browser panel opens. You can use it to type the name of the new bookshelf and choose a folder to put it in.

Once you create a new bookshelf, you can open it directly from the File Viewer or you can use the Open command in Librarian’s Bookshelf menu. You can use the other commands in the Bookshelf menu to save changes to the bookshelf, revert to a previous version of the bookshelf, and close a bookshelf window.

For more information about the commands in the Bookshelf menu, see “Digital Librarian Commands” in the Reference at the end of this book.
Setting up a search service

1. **Start up Digital Librarian.**
   If you want to be able to search a folder as you work in another application, you can set up a search service. For example, if you have a catalog of products, you may want to be able to refer to the product numbers in memos, reports, or other documents you create in Edit. If you set up a search service for the file or files that contain your catalog, you can choose a command from the Librarian Services menu in Edit or another application to search those files.

2. **Select a target from a bookshelf.**
   You use the Target Inspector to set up a search service.

3. **Choose Target from the Librarian menu.**

4. **Choose Inspector from the Target menu.**

5. **Choose Services from the pop-up list at the top of the panel.**

6. **Check “Search in.”**

7. **Restart your applications.**

The next time you start up an application, the Services menu has a Librarian menu that includes a new command for searching in the target file or folder. You select a word or phrase in the text of the document you’re working in and then choose the command. Librarian searches the target for the selected word and displays the results in the bookshelf window. The command is dimmed if no text is selected.

You can add as many search services as you want. A new service appears when you next start up an application or when you log out and log back into your workspace.
Setting up a jotting service

1. Start up Digital Librarian.
2. Add a new folder to one of your bookshelves.
3. Choose Target from the Librarian menu.
4. Choose Inspector from the Target menu.
5. Choose Services from the pop-up list at the top of the panel.
6. Check “Jot in.”
7. Restart your applications.

You can set up a jotting service to save text from other applications in an indexed folder on your bookshelf. For example, Librarian comes with a folder called Notebook on the Librarian bookshelf. You can file important bits of information from other documents in this notebook and search it by topic when you want to find the information quickly. You can also create additional notebook folders.

You use the Target Inspector to set up a jotting service.

The next time you start up an application, its Services menu includes a Librarian command that lists two new commands for jotting in the target file or folder. One files the currently selected text as an unnamed file in the target folder. The other files the entire document—or message if you’re using the Mail application—in the target folder.

You jot in different folders. Just add a jotting service for each folder you want to jot in. A new service appears when you next start up an application or when you log out and log back into your workspace.

Not all applications support jotting services. For information, see the user’s guide for your application.
Looking up an on-line address

1 Open the Addresses folder in your Library folder.

2 Double-click an address book.

3 Double-click a name in the address book.

Your workspace comes with two built-in address books—the User address book and an Example address book. If you are working on a network, the addresses of other users on the network are automatically included in the User address book. You can also add names and addresses to the Example address book—to organize your business contacts, for example.

The User address book is a public, read-only address book. It’s stored in `/NextLibrary/Addresses/User.addresses`.

The Example address book is your own private file, stored in `~/Library/Addresses/Example.addresses`. You can create a new address book by copying the Example address book the same way you copy any file.
Adding an on-line address

1. Open the address book. You can add new addresses to your address books and organize the addresses into groups.

2. Choose File from the Workspace menu.

3. Choose New Address from the File menu.

4. Type a name for the new address in the icon path.

5. Double-click the new address icon.

6. Type the name and address information in the Inspector panel.

You can choose New Group from the File menu to create a new group. A group is a folder in the address book. You add addresses—or other groups—to a group by dragging them into the group the same way you drag a file into a folder in the File Viewer. You can then use the Inspector to sort addresses in the group and record information about it.

For information about the Inspector, see Chapter 7, "Inspecting Files and Folders."
If your computer is connected to a network, you can use the Mail application to exchange messages with others on the network. The messages can be in a number of formats. They can be simple text, or they can include files and folders, graphics, and even sound recordings. The Mail application is in your dock.

Hey Everybody!

Don’t forget that this Friday night is the first-ever Bay Area appearance of recent Blue Planet “signee” and scat sensation

Dido Estevan

8:00 PM at the Sweetwater Pavilion

Come early for press hour and hors d’oeuvres (don’t forget your badges).

P.S. Whoops, I almost forgot—here are directions to the Pavilion.

I look forward much to seeing you again at this year’s fest.

Au revoir.
You have to get a package to Stockholm—tomorrow. You have the copy, photographs of the musicians, a cassette tape of releases, and a letter laying out specs for the brochure.

You pack it all up in a box wrapped over and over in thick plastic tape, the kind that’s impossible to cut without a serious pair of scissors. Then you get to the post office—and just miss overnight delivery.

Later at dinner, a friend tells you what she would have done—type the letter in her computer, drag scanned images into the letter along with the copy, even record samples of the tape and stick them in the letter, too. It’d be in Stockholm within minutes.

When you drop her off, she hopes you’ll come in for a while. You hope she keeps her computer at home.
Starting up Mail

- Double-click the Mail icon in the application dock.
  
  Or
- Open the /NextApps folder in the File Viewer and then double-click Mail.app.

The Mail application is a tool for exchanging electronic messages with other people over a network or with others who have home folders in your computer. When Mail starts up, a window displays the contents of your Active mailbox. The Active mailbox is where all new messages are delivered to you.

![Active mailbox screenshot]

A one-line summary of each message you receive appears in the summary area.

Drag to see more or fewer summaries at once.

When a Mailbox Is Already in Use

If a panel warns that your mailbox is locked when Mail starts up, one of two things is going on:

- Your Active mailbox is open on another computer on the network. Click Cancel in the panel so the mailbox doesn’t open on this computer.

- Your last Mail session ended abnormally, because of a power failure, for example. The mailbox isn’t open anywhere else so you can click OK to open it now.

When working on a network, don’t open the same mailbox on more than one computer at once or you might lose mail from that mailbox. If you tend to log into several computers and you’ve set Mail to start up automatically, you should set it to start up hidden, which prevents your Active mailbox from opening at startup. Choose Preferences from Mail’s Info menu, and then check the Hide on Auto-Launch box in the Preferences panel.
Opening messages

1 Select the message you want to look at by clicking it in the summary area.

2 Click the large down arrow button to select the next message, or click the up arrow to select the previous one.

Messages you receive are listed in the summary area of your Active mailbox. You select a message in the summary area to open the message and see its contents below.

You can hide Mail when you’re done reading messages. As long as Mail is running, its icon in the dock shows if you have new messages.

To: preceding an address in a message summary marks a message you sent. See “Sending a Message” in this chapter.

For information on MIME message, see “MIME Messages and Encoded Attachments” in this chapter.

You can get a sound signal when new messages arrive. See “Setting a Sound to Announce New Messages” in Chapter 14.

If you don’t see the sender’s picture, ask your system administrator to set up Mail to show pictures.

Shortcuts from the Keyboard

You can also open messages by typing:
- To open the next message, press Return or the down arrow key.
- To open the previous message, hold down Shift and press Return, or press the up arrow key.

• Hold down Alternate and press the down arrow key to scroll to the next “page” in a message. When you get to the end of a message, Alternate–down arrow opens the next message. Press Alternate–up arrow to similarly scroll to the previous page or message.
Options for Showing Information about Messages

Here are some options for displaying information about messages in a mailbox window.

**Show Message Totals and Sizes**

You can see the size of each message and the total size of all messages in the mailbox. Just choose Show Sizes from the Mailbox menu.

The Show Sizes command displays the total number of messages in the mailbox and their total size.

You also see the size of each individual message, including any files or other attachments in it.

If you’ve recently deleted messages, information about them might appear, too. See “Compacting a Mailbox to Free Disk Space” in Chapter 14.

You can have all mailbox windows report message totals—with or without sizes—using the Preferences command in the Info menu. For information, see “Mail Buttons and Commands” in the Reference at the end of this book.

**Mark a Message as Unread**

If you’ve opened a message, you can mark it with a so it looks like you haven’t opened it. You might do this if you don’t plan to read the message until later. Choose Mark as Unread from the Message menu.

Select a message you’ve opened.

**Show Additional Headers In a Message**

Each message you receive includes information about who sent the message and when. This information is at the top of the message, in fields called headers.

You can show additional headers that provide technical information about the message by choosing Show All Headers from the Message menu.

A system administrator might show all headers to see the exact path a message traveled over the network.

You can use Mail’s Preferences command to choose which headers appear in all your messages. You can also create headers for messages you send. See “Tailoring Headers in Messages You Receive” and “Creating Headers for Messages You Send” in Chapter 14.
Opening a file or folder in a message

Double-click the file or folder in the message.

You might receive a message with a file attached to it—or a folder containing several files. The file or folder appears as an icon that you can double-click to see its contents.

Edits you make to a file that’s attached to a MIME message—one with an M next to its summary—aren’t saved with the message. When you forward the message or open another one, your edits are lost. For information on MIME messages, see “MIME Messages and Encoded Attachments” in this chapter.

You can edit the contents of the file and save your changes. If you then send the message to anyone else—for example, by forwarding it—the file with your changes goes with it.

If you want to keep a copy of the file or folder, drag it out of the mailbox window to one of your folders in the File Viewer. You can also drag a graphic image out of the window to keep a copy of it.

When you drag a graphic image out of the window, its file icon appears.
Listening to a recording

1 Double-click the sound icon in the message.

You might receive a sound recording in a message. The recording appears as an icon. If your computer can play sounds, you can play back the recording.

2 Click Play in the Lip Service panel.

When you double-click a sound icon, the Lip Service panel opens.

Click to play the recording.

During playback, this meter indicates the sound level of the recording.

Click to stop playback before the end.

Click to pause during playback. Click again to resume.

The buttons in the Lip Service panel work like those on a standard tape recorder.

You can adjust the speaker volume with the Preferences application’s Sound Preferences. See “Adjusting Volume and Input Gain” in Chapter 21.
MIME Messages and Encoded Attachments

In addition to messages from NEXTSTEP computers, you can receive formatted MIME messages and encoded attachments in plain text messages from other kinds of computers.

What Is a MIME Message?
A MIME message is a message that people using different kinds of computers can use to exchange formatted text, images, sound, files, folders, and even video attachments. MIME is the set of technical formats that makes this possible. It stands for Multipurpose Internet Mail Extensions.

To maximize the variety of computers that can display a message properly, MIME messages often provide multiple representations of their contents—each in a different format. For example, a message might include a plain text and formatted version of the same text, or two versions of the same file attachment. When you open the message, Mail usually shows you just one version of its contents—the one that Mail displays the best.

If a MIME Message Doesn’t Look Right
If any part of a MIME message is in a format Mail can’t display properly, that part may appear as unintelligible text.

When this happens, you can see the plainest version of a message—the one most likely to be readable—by choosing Show First Alternative from the MIME menu. To see the entire message—including multiple versions of the same contents—choose Show All Alternatives. For more information, see “MIME Menu” in “Mail Buttons and Commands” in the Reference at the end of this book.

If a MIME Message Has Been Split
You might receive a MIME message that’s split into pieces, for example, if it’s otherwise too large to go through a gateway between networks. The pieces appear as separate messages in your mailbox window. To assemble the pieces, select their summaries—either by dragging or by holding down the Shift key and clicking each one. Then choose Combine Messages from the MIME menu. The pieces are replaced by the assembled message.

Retrieve a Remote MIME Attachment
An icon that looks like the one below represents a file or folder that’s not actually in the message. Instead, the icon is a pointer to a file or folder that resides somewhere else on yours or another network.

Someone might send a pointer if the real file or folder is very large, especially if they’re sending it to a large number of people. To see the actual file or folder, double-click the icon. A panel asks if you want to retrieve the attachment. Click OK and one of three things happens:

- The file or folder opens in your workspace.
- A panel asks you to log into the network where the file or folder resides. You must have a password to log into that network. After you log in, the file or folder opens in your workspace.
- The file or folder arrives in a separate message.

Decode a Plain Text Attachment
Unintelligible text in a message might be a file that’s been encoded with the UNIX uuencode command. You might receive such a file from a computer that can’t send NEXTSTEP or MIME messages.

You can see the actual file by selecting the message summary and choosing Decode Foreign Attachment from the Message menu. The Workspace Manager opens a folder window that contains a temporary copy of the file. To keep your own copy, you must drag it into another folder.
Sending a message

1 Click the Compose button in a mailbox window.

2 Address the message and type a brief summary of its subject.

3 Compose your message.

4 Click the Deliver button.

You can send a message to one person, a group of people, or a combination of individuals and groups. You address the message directly to at least one person or group. You can also send a “carbon copy” to anyone else who should see the message. You address and compose a message in a Compose window.

Enter at least one address here.

Type a brief summary here.

Send carbon copies by entering addresses here. Separate addresses with a comma or a space.

Compose the message here.

Click to deliver the message.

Hey Everybody!!!
Don’t forget that this Friday night is the first-ever Bay Area appearance of recent Blue Planet “signee” and scat sensation

Dido Estevan
8:00 pm at the Sweetwater Pavilion
Come early for press hour and hors d’oeuvres (don’t forget your badges).

What’s an Address?

A person’s address is usually his or her user name. Your system administrator may also have set up group addresses, such as publicity, that you can use to send a message to a specific group of people.

You can look up the address of a person or a group on your network with the Addresses panel. See “Looking Up Mail Addresses” in Chapter 14.

To send a message to someone on another network, you use an address that includes information about the network. Such an address might look like jstarr@blues.com.

A person’s address appears at the top of any message that person sends you. You can quickly reply to that address by using the Reply button. See “Replying to a Message” in this chapter.
You can type your message, set fonts, and make ruler settings just as in any standard document, such as an Edit document. To add a graphic image, drag a TIFF or EPS file into the message from the File Viewer or from another Mail window. You can also paste text or images copied from a Mail window or from another application.

When you set fonts, make ruler settings, or add images, a triangle reminds you to send the message only to people whose computers can display NEXTSTEP or MIME messages.

When you send a graphic image in a message, Mail delivers a copy of the image. The file that contains the original remains where you dragged it from.

If you change your mind about sending a graphic, you can delete it just as you would delete text—for example, by pressing Backspace to back up over it.

When you send a message to yourself—for example, by including your address in the Cc field—the summary that appears in your mailbox window when you receive the message lists who you sent the message to, instead of your address, as in To: starr.

**Shortcuts Typing Addresses**

You can type part of an address and press Escape to have Mail fill in the rest. Try this in a field in a Compose window or in the Send Options panel. Mail can fill in any address that's listed in the Addresses panel.

Type the first few characters of the address.

Press Escape and Mail fills in an address from the Addresses panel.

Press Escape again and Mail fills in another address that begins with the same characters.

For more information on typing, formatting, and adding images, see Chapter 9, “Typing and Editing,” and “Adding a Graphic Image” in Chapter 11.
Sending a MIME or plain text message

To send a message to anyone whose computer can display MIME messages, select the MIME Mail format and compose the message, including formatting and attachments.

To send a message to anyone whose computer can't display NEXTSTEP or MIME messages, select Plain Text and type a message with no formatting or attachments.

You can send your message to people using non-NEXTSTEP computers. If the computers can receive MIME messages, you can include formatting, graphics, and attachments. Otherwise, you must type a plain text message.

Click this button in a Compose window to select a format for your message. As you click, the button switches among three formats.

![Button Options]

Use this format to send the message to NEXTSTEP computers.
Use this one to send formatted messages to computers that can display MIME messages.
Use this one to send plain text messages to other non-NEXTSTEP computers.

Caution: Formatting, graphics, sounds, or file or folder attachments generate unintelligible messages on computers that can't display NEXTSTEP or MIME messages. If your message is going to such a computer, choose the plain text format.

What Is a Plain Text Message?

When you select the Plain Text format in a Compose window, text in your message appears in a fixed-width font, such as Courier, and line length is limited to 70 characters.

If you've added any formatting, such as fonts, ruler settings, or attachments, they're removed—but they come back if you choose the NeXT Mail or MIME Mail format.

As you type your message, lines "wrap" as usual. But when you send the message, Return characters are added to the ends of lines, as required by the receiving computer.

You should include only ASCII characters in a plain text message. Mail converts any other characters to ASCII. For example, it converts an em dash (—) to a hyphen (-).
Options for Sending Messages

You can set options for a message you send. When working in a Compose window, choose Send Options from the Message menu. Then make the following settings in the Send Options panel.

You can select options for all messages you send with the Preferences command in the Info menu. See “Preferences for Messages You Send” in Chapter 14.

You can also use the Send Options panel to select a header you’ve created. See “Creating Headers for Messages You Send” in Chapter 14.

Enter a Long List of Addresses

The Send Options panel has a large area for listing more addresses than can fit in a Compose window field. Press the button at the top of the panel to choose To or Cc—whichever field you want to enter addresses in. Type the addresses in the panel and press Return to enter them in the Compose window.

Send a Hidden Copy of a Message

You can send a copy of a message to one or more addresses without other recipients knowing it. Choose Bcc (“blind carbon copy”) from the pop-up list at the top of the Send Options panel. Type the addresses in the panel and press Return. A copy of the message goes to the addresses, but no other recipients know because the Bcc list doesn’t appear in the message.

Reroute Replies

You can have replies to your message go to one or more addresses other than your own. Type the addresses in the Reply-To field. When recipients click Reply in their mailbox window to reply to your message, any address you type here is inserted in their To field. If you also want a reply, type your address here, too. See “Replying to a Message” in this chapter.

Archive a Copy of the Message

You can save a copy of a message you send by checking “Archive in Outgoing mailbox.” Mail creates a mailbox named Outgoing and puts the copy in it.

As a shortcut, you can hold down the Alternate key and click Deliver in the Compose window to archive the message. Or if you’ve used the Preferences command to archive all messages, Control-click Deliver to not archive this message.
Attaching a file or folder

1. Click in the Compose window where you want the file or folder to appear.

2. In the Workspace Manager’s File Viewer, select the file or folder you want to send.

3. Drag the selection from the File Viewer’s icon path into the Compose window.

You can include a file or even an entire folder in a message. Just drag the file or folder from the File Viewer. Drag a selection icon into your message to attach all the files and folders in the selection. You can also copy or drag a file or folder from another Compose window or from a mailbox window.

When you click Deliver, Mail delivers a copy of the file or folder. The original remains wherever you dragged or copied it from.

If you change your mind about attaching a file or folder, you can delete it from the message, for example, by pressing the Backspace key to back up over it.

Tip: If a file or folder takes up a lot of disk space, you should send a link to it rather than sending the actual file or folder—especially if you’re sending it to a large number of people. Just hold down the Control key while dragging the file or folder into the Compose window.

A triangle reminds you to send the message only to people whose computer can display NEXTSTEP or MIME messages.

Drag a file or folder from the File Viewer.

The file or folder appears where you last clicked or in place of the current selection.

A link you send in a Mail message is just like one you create in the File Viewer. For information, see “What Is a Link?” in Chapter 6.
You can send a file or folder attachment to any computer that can receive NEXTSTEP or MIME messages. To send a file or folder to other computers, you must instead select the Plain Text format and paste an encoded version of the file or folder in your message.

When you click Paste Encoded Contents, Mail inserts a block of unintelligible text that is your attachment encoded with the UNIX `uuencode` command. The recipient of your message can “decode” the attachment using the UNIX `uudecode` command.

**Caution:** File or folder icons in a message generate unintelligible messages on computers that can’t display NEXTSTEP or MIME messages. To make sure that recipients can read your message, choose the Plain Text format and send either a pathname or an encoded version of the file or folder.

For more information on the UNIX `uuencode` and `uudecode` commands, see the UNIX manual pages for these commands.
Saving a draft

1. Choose Compose from the Mail menu.

2. Choose Drafts from the Compose menu.

3. Choose Save in Drafts from the Drafts menu.

You can save the contents of a message you’re composing, much as you save the contents of a document. You might do this when composing a message you want to finish later or to save versions of a message as you type it.

Mail saves the contents of your Compose window as a message in the Drafts mailbox, which it creates for you.

The subject and addresses you’ve typed are saved, too.

If you close a Compose window without saving or delivering it, a panel asks if you want to save your draft before closing it. If you click Save, the message is saved in your Drafts mailbox.

Each time you save a draft, Mail saves another version of the message in the Drafts mailbox—it doesn’t replace the last version you saved.

Remember to delete drafts you don’t need anymore from the Drafts mailbox so they don’t take up disk space. See “Deleting Messages” in Chapter 14.
Restoring a draft

To restore the last draft you saved, open the Compose menu and choose Restore Draft from the Drafts menu.

To restore an earlier draft, open the Drafts mailbox, select the message, and choose Restore Draft.

You can restore the last draft of a message you saved so you can resume working in it. Just choose the Restore Draft command. A Compose window opens that contains your draft, exactly as when you last saved it.

To restore an earlier draft, you must open the Drafts mailbox, select the message summary of the draft you want to restore, and choose Restore Draft.

You open the Drafts mailbox using the Mailboxes panel. For information, see “Organizing Messages in Mailboxes” in Chapter 14.
Forwarding a message

1. **Open the message.**

2. **Click the Compose button in the mailbox window.**

3. **Click Forward in the Compose window.**

4. **Address the message.**

5. **Click Deliver.**

You can quickly forward a message to others who may want to read it.

You can forward several messages all in the same message. Just open each message in your mailbox window and click Forward in the Compose window. Each message is inserted following anything that’s already there.

When you copy a message into a Compose window with the Forward button, all formatting is copied, too, as well as any recordings, graphics, or file or folder attachments.

You can also forward a message by choosing Forward from the Compose menu. And you can remove formatting from a message you’re forwarding by choosing Make ASCII from the Compose menu. See “Mail Buttons and Commands” in the Reference at the end of this book.
Replieding to a message

1. **Open the message.**
2. **Click the Compose button in the mailbox window.**
3. **Click Reply in the Compose window.**
4. **Click Reply All to also send the reply to those who received a carbon copy of the original message.**
5. **Type your reply.**
6. **Click Deliver.**

If you want to reply to a message, you can quickly copy the sender’s address and subject into a Compose window. Just click the Reply button in your Compose window. To copy the addresses listed in the original message’s Cc field, click the button again.

![Compose window screenshot](image)

The Reply button alternates between Reply and Reply All when you click it.

Reply fills these fields.

Reply All fills this one.

You just type your reply.

**Tip:** Use Forward and Reply together to include a copy of the message you’re responding to. If recipients of your message do the same thing, their replies will contain all earlier messages in the exchange, and a message history grows.

You can also reply to a message by choosing Reply or Reply All from the Compose menu. See “Mail Buttons and Commands” in the Reference at the end of this book.

If the sender used the Send Options command to route your reply to an address other than his or her own, clicking Reply fills the To field with that address. See “Options for Sending Messages” in this chapter.
Recording and inserting sound in a message

1. Click the Lip Service button in a Compose window.

2. Click Record in the Lip Service panel and record through your computer's microphone.

3. Click Stop when you're done.

4. Click in the Compose window where you want the sound icon to appear.

5. Click Insert.

If your computer can record sounds, you can include a sound recording in a message.

You can adjust the sensitivity of your microphone with the Preferences application's Sound Preferences. See “Adjusting Volume and Input Gain” in Chapter 21.

For more information on using a microphone with your computer, see the owner's guide for the computer or for any devices you've attached to it.

You can use the Play button to play back your recording before inserting it. If you don't like the recording, just record over it or click Erase. You can also close the Lip Service panel without inserting the recording. Unless you erase it, the recording will be there when you next open the panel.

If you change your mind about sending a recording after you insert it, delete the sound icon, for example, by pressing Backspace to back up over it.
Editing sound

You can edit a recording you’ve made or received by modifying its waveform in the Lip Service panel.

1 Double-click the sound icon. You can edit a recording you’ve made or received by modifying its waveform in the Lip Service panel.

2 Click the waveform button in the Lip Service panel.

3 Select a portion of the waveform or click somewhere in it.

4 Use Edit menu commands to edit the waveform. Or click Record to insert new material.

5 Click Play to listen to the result.

You can select a segment of the waveform. Then click Play to play back the segment. Click Record to record over it. Or choose Cut or Copy from the Edit menu to move or copy it.

You can also click in the waveform where you want to insert new material. Then click Record to record the material, or choose Paste to insert a segment you cut or copied.

Caution: The Erase button erases the entire recording, even when only a segment is selected.
The Mail application has tools to help you manage your messages—including mailboxes for storing messages you want to keep and a special Mail address book that makes it easy to address your messages. And like other NEXTSTEP applications, Mail can be tailored to your needs.
Managing the Mail Application

You’re getting ready for a meeting with your new boss, and you can’t find last week’s sales report. You’ve looked everywhere. You check to make sure no one’s around and start digging through the trash. You’re elbow-deep in yesterday’s lunch when your boss walks in. She’s 20 minutes early.

The alarm sounds and you wake up with a feeling of relief. You got that report last week in a Mail message and put it in your Reports mailbox. You’ll just do a search for messages dated last Friday and forward the report to your boss. It won’t take more than a second to look up her address.

Later that morning, your computer beeps to announce an incoming message. It’s from your boss. She needs more than a sales report—she wants sales forecasts. You’re typing out some figures when the computer beeps again. She wants to know if you can meet 20 minutes early.
Deleting messages

You can let important messages accumulate in your mailbox. But you should delete messages you don’t need, to get them out of your way.

If you can tell without reading a message that you want to delete it, hold down the Control key while clicking its summary to select the message without waiting for its contents to appear. Then click Delete to delete the message.

Ways to Select Messages

<table>
<thead>
<tr>
<th>What You Do</th>
<th>What Happens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag</td>
<td>Selects the messages you drag across</td>
</tr>
<tr>
<td>Shift-click</td>
<td>Adds the message to the selection, or removes it from the selection</td>
</tr>
<tr>
<td>Alternate-click</td>
<td>Selects all messages between the one you click and the last one you selected</td>
</tr>
<tr>
<td>Control-click</td>
<td>Selects a message without opening it</td>
</tr>
</tbody>
</table>
Compacting a mailbox to free disk space

1 Open the mailbox you want to compact.

2 To see messages you’re about to destroy, choose Show Deleted from the Mailbox menu.

3 To undelete a message you want to keep, select it and choose Undelete from the Message menu.

4 Choose Compact from the Mailbox menu.

Deleting a message removes it from the summary area of a mailbox window, but not from your disk. In fact, you can see a dimmed summary of it and other deleted messages by choosing the Show Deleted command.

You delete a message.

The message no longer appears in your mailbox.

But you can see its dimmed summary by choosing Show Deleted.

You can undelete a message you want to keep by selecting its dimmed summary and choosing Undelete. To destroy remaining deleted messages—whether they’re showing or not—choose Compact.

When deleted messages aren’t showing, the Undelete command undeletes the last message you deleted. For more information, see “Mail Buttons and Commands” in the Reference at the end of this book.

You can have all mailbox windows show deleted messages or report message totals and sizes using the Preferences command in the Info menu. See “Mail Buttons and Commands.”

Display the total number of deleted messages and the disk space they occupy by choosing Show Sizes from the Mailbox menu.

Choose Compact to destroy deleted messages and free up disk space. Remaining messages are renumbered.

Caution: If you don’t regularly compact your Active mailbox, deleted messages accumulate and take up disk space unnecessarily. However, compacting destroys deleted messages permanently.

To hide deleted messages, choose Hide Deleted from the Mailbox menu.
Looking up Mail addresses

1. **Open a Compose window and click the Addresses button.**
   - You can look up the addresses of other people and groups on your network with the Addresses panel. This panel lists addresses in a browser.

2. **Click the type of address you’re looking for.**
   - Click the type of address you’re looking for in the Types column.

3. **Select an address.**
   - Click to select an address.

4. **Click the To or cc button to copy the address into your Compose window.**
   - The person’s picture appears.
   - Click to copy the address into a field in a Compose window.

You can copy several addresses, one after the other, into a Compose window. Just select an address and click To or cc. The button appends the address to any already in the corresponding Compose window field.

---

**The Types Column**

You can look up addresses in one of five lists. You select a list from the Types column:

- **Users** Lists all addresses for everyone on your network.
- **Group** Lists group addresses available to everyone on the network.
- **Login Names** Lists the user name that each person on the network uses to log in. Look up an address here rather than in Users if you know only a person’s user name.
- **Private Users** Lists addresses that you use frequently.
- **Private Groups** Lists group addresses you create.

Addresses in Users, Groups, and Login Names are defined by your system administrator. You add the Private Users and Private Groups addresses yourself. See “Creating a Mail Address Book” and “Creating Your Own Group Address” in this chapter.
When you select an individual’s address, a picture appears if your system administrator has set up Mail that way. For groups, and for people who don’t have pictures in the system, the panel displays silhouette icons.

![Individual](image1.png) ![Group](image2.png)

**Shortcuts Selecting Addresses**

Try these shortcuts in the Addresses panel—when typing in the Name field or browsing addresses.

**Browse Using Arrow Keys**

You can browse in the Addresses panel using arrow keys, just as you can in the File Viewer’s browser. Press the up or down arrow key to select the previous or next address in a list. Press the left or right arrow key to move between lists.

**Type the First Few Characters**

You can select an address in the current list by typing the first few characters of its name. For example, select the Users list and type Jas to select Jason_Starr.

You can find an address in any list by typing the first few characters and pressing Escape, just as in a Compose window. For more information, see “Shortcuts Typing Addresses” in Chapter 13.

**Search for Any Text**

You can use the Find button to search for an address in the current list based on any text in the address. For instance, if you type kim in the Name field, Mail can find addresses like Kimberly_Osorio or Kyung_Kim. Click Find again to find the next occurrence of text in the list.
Creating a Mail address book

1. Open a Compose window and click the Addresses button.

2. Click Private Users in the Types column of the Addresses panel.

3. Type an address in the Name field.

4. Click Add.

You can keep your own list of addresses in the Private Users list in your Addresses panel. You might keep addresses you use frequently here so you don't have to search through long lists to find them.

Once an address is in your Private Users list, you can select it and click the To or cc button to copy it into the Compose window.

To remove an address from your Private Users list, select the address and click the Remove button.

Tip: If you open a message from someone whose address you want to add to your Private Users list, choose Add Private User from the Message menu. The sender's address is automatically added to your list, even if the Addresses panel isn't open.
Creating your own group address

1. Open a Compose window and click the Addresses button.

2. Click Private Groups in the Types column of the Addresses panel.

3. Type a name for the group address and click Add.

4. In the Private Groups column, select the group address you just created.

5. Type an address you want assigned to the group and click Add.

6. Repeat step 5 for each address in the group.

In addition to the group addresses set up by your system administrator, you can create some for your own use. You might create an address for sending messages to everyone working on a particular project. When naming a group, don’t use a comma or a space. Otherwise, follow the same guidelines as for naming files and folders.

The group automatically includes your own address. You can add other addresses by selecting the group, typing an address, and clicking Add again.

To remove an address from the group, select the address and click Remove. You can’t remove the last remaining address associated with a group (so if you want to remove your own address, you have to add another one first). But you can remove the entire group by selecting its name in the Private Groups list and clicking Remove.

Tip: You can create a shorthand address for one person. Just create a group and assign only that person to it. For example, if you send messages frequently to the address sammi_wright@globalvoice.com, you might create the group sammi, add his address to it, remove your own, and then send messages to him using the shorthand address.
Organizing messages in mailboxes

To create a new mailbox, click the Mailboxes button in a mailbox window, type a name for the mailbox, and click New.

To open a mailbox, select it in the Mailboxes panel and click Open, or double-click it in the panel.

To delete a mailbox, select it in the Mailboxes panel and click Delete.

To move messages to another mailbox, select the messages. Then in the Mailboxes panel, select the mailbox you want to move them to and click Transfer.

Instead of letting messages accumulate in your Active mailbox, you can organize them in other mailboxes. You do this with the Mailboxes panel.

You can also organize mailboxes in folders. You create a folder while creating a mailbox. Just type a pathname in the Mailboxes panel that includes the folder’s name and click New.

You can select a mailbox by typing the first few characters of its name or by pressing arrow keys, just as when selecting addresses in the Addresses panel. See “Shortcuts Selecting Addresses” in this chapter.

To reorganize existing mailboxes, open your ~/Mailboxes folder in the File Viewer and move mailboxes into folders there, just as you move a file. See “Moving a File or Folder” in Chapter 6.

You can also open an existing mailbox to see its messages. Or delete a mailbox to destroy all the messages in it. If you delete your Active mailbox, Mail creates an empty Active mailbox the next time you start it up.
After you create a mailbox, you can move messages to it from your Active mailbox. You can also move messages between any mailboxes you create.

You can also use Edit menu commands to move selected messages. Choose Cut from the Edit menu. Then click in the summary area of the mailbox window you want to move the messages to and choose Paste.

After moving messages out of a mailbox window, remember to compact the mailbox.

A Mailbox Is a File Package

Your Active mailbox and any mailboxes you create are actually file packages with an .mbox extension. Mail keeps these file packages in the Mailboxes folder in your home folder.

You don't have to open a file package to read the messages in a mailbox. It's easiest to read and maintain messages in the mailbox window.

For information on selecting several messages to move at once, see “Ways to Select Messages” in this chapter.
Finding a message

1. **Click in the summary area of a mailbox window.** You can find a message in a mailbox by searching for any text in its summary or in the message itself.

2. **Click the Find button.**

3. **In the Find panel, type what you want to find.**

4. **Select the options you want.**

5. **Click Next or Previous.**

If you click in the body of a message in a mailbox or Compose window and open the Find panel, you can search for text in that message. See “Finding Text” in Chapter 9.

You can use commands in the Sorting menu to sort message summaries in a variety of orders. See “Mail Buttons and Commands” in the Reference at the end of this book.

To search for a message based on text in its summary, click Summaries under Find Scope in the Find panel. You can search for text in the message’s subject, message number, date, or sender’s address. To search for a message based on text that’s in the message, click Messages in the Find panel.

Any message that’s found is highlighted in the summary area and opened in the message area below.

**Tip:** You can search for an unread message—one with a \(\bullet\) next to it. Just select Summaries under Find Scope, type a bullet in the Find field (by typing Alternate-7), and click Previous or Next.
Focusing on a group of messages

1. Click in the summary area of a mailbox window.
2. Click the Find button.
3. In the Find panel, type the text you want to find.
4. Select the options you want.
5. Click Find All.
6. Open the Mailbox menu and choose Focus.
7. When you’re done reviewing the messages resulting from the search, choose Unfocus.

You can find all messages in a mailbox that have your search text, either in their summaries or in the messages. You can then “focus” on those messages, temporarily hiding others so it’s easy to find a particular message.

Type your search text and select Summaries or Messages in the Find panel. Then click Find All.

To narrow down your search, you can do another Find All search and choose Focus again to display the results of that search in the mailbox window. You can keep selecting messages and choosing Focus as many times as you want.

To see all your messages again, choose Unfocus. Mail also displays all messages the next time you open the mailbox.
Tailoring how you get new messages

1. Choose Info from the Mail menu.
2. Choose Preferences from the Info menu.
3. Choose General from the pop-up list at the top of the Preferences panel.
4. Click Automatic or Manual.
5. If you clicked Automatic, type a value for how often Mail checks for new messages.
6. Click Set at the bottom of the Preferences panel.
7. If you clicked Manual, click the Get Mail button to retrieve new messages.

Before messages addressed to you actually reach you, they're collected in a central "post office"—a folder on the network that your system administrator maintains. Mail is set up to check this post office at a regular interval and to retrieve new messages it finds there, putting them in your Active mailbox.

Normally, Mail retrieves message automatically, and you can set how often Mail checks for new messages in the Preferences panel. If you prefer to control how quickly messages accumulate in your mailbox, you can select Manual to retrieve new messages yourself.

When you select Manual, Mail no longer retrieves messages automatically. Instead, the next time a mailbox window opens, a Get Mail button appears in place of the Find button. To retrieve messages, you must either click the Get Mail button or choose Get New Mail from the Mailbox menu. When new messages are ready to be retrieved, a fan of letters appears in Mail's icon in the dock.

Tip: When you retrieve messages automatically, you can choose the Get New Mail command to speed up retrieval. You might do this when you're expecting a particular message.
Setting a sound to announce new messages

1 Choose Info from the Mail menu.
2 Choose Preferences from the Info menu.
3 In the Preferences panel, click Set under New Mail Retrieval.
4 In the Open panel, select a sound file.
5 Click OK in the Open panel.
6 Click Set at the bottom of the Preferences panel.

When new messages arrive, a fan of letters appears in the Mail icon in the dock. You can also have a sound notify you of new messages. If you receive messages automatically, the sound tells you that there are new messages in your Active mailbox. If you check for messages manually, the sound tells you that there are messages for you to retrieve with the Get Mail button.

You select a sound file from an Open panel.

You can select a sound file from the /NextLibrary/Sounds folder. If your computer can record, you can also make your own sound with any sound application, such as the Sound.app application in /NextDeveloper/Demos. You can use any sound file, as long as it has an .snd extension.

If your computer makes only one sound, you’ll get that one, no matter which sound file you select.

You locate and select a sound file in the Open panel just as you open a file from any standard Open panel. For more information, see “Opening an Existing File” in Chapter 5.
Creating headers for messages you send

1. Choose Info from the Mail menu.
2. Choose Preferences from the Info menu.
3. Choose Expert from the pop-up list at the top of the Preferences panel.
4. Double-click in the Key field and type the name of a header you want to create.
5. Press Tab, type any text you want to appear with the header in the Value field, and press Return.
6. Click Set.

You can create headers of your own that will appear in messages you send. You do this using Mail's Expert Preferences. You can create up to two headers.

Choose Expert from the pop-up list at the top of the Preferences panel.

Double-click in the Key field and type the name of the header.

Press Tab and type an optional "value"—the text that appears with the header—in the Value field.

You can press Tab again to move to the next field and type another header.

Click Set when you're done.

If you type a value for the header, the header appears with that value in all messages you send. To send a different value in a message, choose the header in the Send Options panel when you send the message and type another value for it there.

If you leave the Value field empty, you must choose the header from the Send Options panel and type a value for it to include it in a message.

Choose a header you created from the pop-up list in the Send Options panel.

Type a value for the header here. The value replaces any value set in the Preferences panel for just this message.

You open the Send Options panel by choosing Send Options from the Compose menu. For more information on this panel, see “Options for Sending Messages” in Chapter 13.
Your headers appear at the top of your message in each recipient’s mailbox window.

Guidelines for Naming Headers

Follow these guidelines when typing a name in the Key field of Mail’s Preferences panel.

Mark Custom Headers with “X-”

It’s common protocol among network users to precede the name of headers you create with an X-, as in X-Quote-Of-The-Day.

Don’t Use Spaces

Don’t use a space to separate words in a header, or else Mail won’t recognize the header and include it in your messages. If a header contains more than one word, separate words with a dash, as in X-Quote-Of-The-Day.
Tailoring headers in messages you receive

To make a header that's normally hidden appear in messages you receive, remove it from the Hidden Headers list in the Preferences panel.

To prevent a header from appearing in your messages, add it to the Hidden Headers list.

You can choose which headers normally appear in messages you receive. You do this in Mail’s Preferences panel.

To see all headers in a message—whether or not you’ve hidden them in the Preferences panel—choose Show Headers from the Message menu. For more information, see “Options for Showing Information about Messages” in Chapter 13.
Preferences for Messages You Send

You can set options for all messages you send. Choose Preferences from the Info menu and then choose Compose from the pop-up list at the top of the Preferences panel. Make settings in the panel to choose any of the following options.

**Format** Press the Format button to choose a format—NeXT Mail, MIME Mail, or Plain Text—for all your compose windows to open in.

**Indent New lines** When you check this option, pressing Return in a Compose window indents the next paragraph the same as the previous one. This option is useful for typing UNIX code.

**Emacs Key Bindings** Check this option to use Emacs text editor commands in a Compose window. Emacs commands are popular among UNIX programmers.

**Reply in Same Format** Check this option to reply to messages in the same format as the original messages. When you click Reply in a Compose window, the window selects the format for you.

**Remove Self from Replies** Check this option to not receive replies you send using the Reply All button. If you are “carbon copied” in a message and you click Reply All in a Compose window to reply to that message, Mail doesn’t copy your address from the message’s Cc field into your Compose window. For this option to work, Mail must recognize your address in the message as being you. You can make Mail recognize an address if it doesn’t already. See “Expert Preferences” in this chapter.

**Reply-To** You can have all replies to your messages go to someone other than yourself. Enter one or more addresses in the Reply-To field. When anyone uses the Reply button to respond to one of your messages, the To field of his or her Compose window is filled with the addresses you enter here. (To also have replies go to you, enter your address, too.)

**Request Read Receipt** Check this option to receive a notification message when each NEXTSTEP recipient reads any message you send.

**Archive Outgoing Mail** Check this option to collect copies of all messages you send in the Outgoing mailbox. Mail creates this mailbox for you, if it doesn’t already exist.

**Expand Private Groups** You can make it easy for recipients of messages you send to a private group address to reply to others in the group. When you check this option, individual addresses in the group, rather than the group address, are listed in each recipient’s message. Recipients can then click Reply All to reply to everyone in the group.

**Send MIME Alternatives** Check this option to send contents of MIME messages in plain text as well as using formatted text. You might do this if you’re not sure which formats recipients’ computers can display.
Expert Preferences

The Preferences panel has options for how Mail manages messages. Choose Expert from the pop-up list at the top of the panel and type in these fields:

**Other Addresses for Self** If you're known by addresses that Mail doesn't recognize as you, type them in this field. Mail already recognizes your user name and your full name in the format *Jason_Starr*. But it doesn't recognize addresses used from other networks, like *jstarr@blues.com*, or ones you create in the Addresses panel, until you type them here.

When you reply to a message sent to an address entered here, Mail can remove you from that reply. See “Preferences for Messages You Send” in this chapter. If you send a message to one of these addresses, To: followed by recipients' addresses appears in your mailbox window rather than your address. See “Sending a Message” in Chapter 13.

**Administration** System administrators can modify how Mail stores, retrieves, and delivers messages by replacing pathnames in these fields:

- **Mail Dir**: The folder where Mail keeps your mailboxes. Normally this is *Mailboxes* in your home folder. If your home folder is on another computer on the network, you might want to specify a folder on your computer's own disk.
- **Spool Dir**: The "post office" folder that collects incoming messages. If your system administrator is using a folder other than the one currently named here, you should specify that folder here, instead.
- **Mailer**: The program Mail uses to deliver mail. You might want to use another program, such as one that tracks statistics.

**Line Length** This value is the maximum number of characters per line in messages you send in Plain Text format. You might want to change this value to send messages through a gateway to a network that supports fewer than 70 characters per line.

**Send Limit** You can set a size limit for messages you send. Type the number of kilobytes in this field. If you compose a message that's larger than this size, a panel tells you so when you click Deliver in the Compose window. To still send the message, click Deliver Anyway in the panel.
PRINTING AND FAXING
If you have your own printer—or if one is available on a network—you can print most documents that you create in your NEXTSTEP workspace. You can print one copy of 20 pages or 20 copies of one page, sideways, reduced, or on custom-sized paper.

Name: Repertoire_Color_Printer
Note: In the record library.
Progress:

<table>
<thead>
<tr>
<th>Printer</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local_Printer</td>
<td>NeXT 400 dpi Level II Printer</td>
</tr>
<tr>
<td>Repertoire_Color_Printer</td>
<td>NeXT Color Printer</td>
</tr>
<tr>
<td>Sly_Personal_Printer</td>
<td>NeXT 400 dpi Level II Printer</td>
</tr>
</tbody>
</table>

Emily Bright may have her roots in a blues past, but she's got her eyes on the future. Her sound is soulful, down-and-dirty, and innocent at the same time. This woman's going to soar, and *Git on down the road* is going to get an old tradition moving in a fresh, new direction.

Emily Bright moves first album:

*Git on down the road*
Printing

Your grandfather was a printer. You remember his stories about staying up all night to roll the presses for the next day’s edition.

Yessiree, those were the days, he’d say, puffing on his pipe. Those old printing presses and folks like me—we changed the way the whole world communicates.

You once tried to explain what you do for a living. Bah, computers, he puffed. You tell me what a little box of wires can do that a good man with a vat of ink and a well-oiled press can’t do a lot better—and a lot faster.

He blew a smoke ring that spiraled gracefully up through the branches of the old magnolia tree. You thought about the high-resolution laser printouts of complex documents you churn out every day in your spare time. Then you shook your head and smiled. Can’t think of a doggone thing, gramps.
Preparing a file for printing

1. Open the file and choose Format from the application’s main menu.

2. Choose Page Layout from the Format menu.

3. Choose a paper size from the Paper Size pop-up list. Or type custom dimensions in the Width and Height fields.

4. Click Portrait or Landscape.

5. Choose how many pages you want to fit on each sheet of paper from the Layout pop-up list.

6. Type a percentage in the Scale field.

7. Click OK.

Before you print a file, you can change its paper size and orientation. You can also scale your pages to enlarge or reduce them.

You can change the default paper size and units of measure for the Page Layout panel with the Preferences applications. See Chapter 20, “Personalizing Your Workspace.”

The Page Layout command may not be in the Format menu in your application. See the user’s guide for your application.
You reduce or enlarge printed pages by changing the percentage in the Scale field. Scaling doesn’t change the actual contents of a file, and in many applications, it doesn’t change how the file appears on screen.

Your pages are normally printed “1 Up”—that is, with one page on each sheet of paper. But you can choose one of the other Layout options to print 2, 4, 8, or even 16 pages on each sheet of paper. The following examples were all printed with Portrait selected.

Scaling works differently in different applications. See the user's guide for your application.
Printing a file

1. **Open the file and choose Print from the application’s main menu.**

2. **Click the name of the printer you want to use.**

3. **Type the number of copies in the Copies field.**

4. **Click All to print the whole file. Or type page numbers in the From and To fields to print part of the file.**

5. **Choose Paper Feed and Resolution options.**

6. **Click Options to set any special options for your printer.**

7. **Click Print.**

When you’re ready to print a file, you select a printer, the pages you want to print, and the number of copies.

You can preview on screen what your pages will look like on paper with the Preview button. See “Previewing Pages” in Chapter 11.

You can fax your pages instead of printing them by clicking the Fax button. See Chapter 16, “Sending Faxes.”

The name of the current printer appears at the top of the Print panel. It remains the current printer until you select a different one. If only one printer is available, the scrolling list doesn’t appear in the panel.

You type the range of pages you want to print in the To and From fields.

If you type a starting page number, the To field automatically changes to last.

If you type an ending page number, the From field automatically changes to first.

You can type 0 or even a negative number in the From field if you want to print pages that come before page 1.

When you click Print, your pages are prepared for printing. A temporary file is created and sent to the print queue for the printer you selected. If no other files are in the queue, your file is printed immediately.
Print Panel Options

Different printers offer different options in the Print panel. You choose the options you want from the pop-up lists in the Print and Printer Options panels.

Paper Feed
Lists the sources of paper available to your printer. Some common sources are as follows:

**Cassette** Uses the paper in the printer's cassette.

**Manual** Uses envelopes, acetate, or other stationery you feed into the printer by hand. (For instructions on feeding paper manually, see the owner's guide for your printer.)

**Upper, Lower, or another named cassette** Uses paper from a specific cassette, if your printer has more than one.

**Any Tray** Automatically uses paper from the cassette that matches the size of your pages.

**Split** Uses multiple cassettes. The paper in the second cassette is used for the first page, and the paper in the first cassette is used for the second and following pages in the file. This option is commonly used to print cover sheets on letterhead or other special paper.

Resolution
Lists the resolutions your printer can print at, expressed in dots per inch (dpi). You can print sharper lines and smoother gradations of shading by choosing a higher resolution. High-resolution printing may take longer than low-resolution printing.

Options
If your printer offers other options, you can click the Options button in the Print panel to set them. The Printer Options panel displays the special settings for your printer in a series of pop-up lists. For example, a printer might offer several printing modes for different paper stocks and ink coverages. For more information about the options offered by your printer, see its owner's guide.

If you select a printer and no options appear in the Print panel, it's probably because you don't have its PostScript Printer Description (PPD) file installed. For more information, see “About PostScript Printer Description (PPD) Files” in Chapter 18.
Checking the print queue

1. Open the /NextApps folder and double-click PrintManager.app.
2. Choose Printers from the PrintManager menu.
3. Click the name of the printer whose queue you want to check.
4. Click Queue.

When you print a file, a copy is prepared and stored in the queue for the printer you selected. If no other files are in the queue, yours is printed right away. But if other files are in the queue, your file is placed at the end. You use PrintManager to see what’s in the print queue.

The Printers window lists printers connected to your computer first, followed by those available on a network. You can open Printer Queue windows for as many printers as you want.

The Printer Queue window lists the files in the order they’ll be printed. The one at the top is printed first.

For more information about PrintManager, see Chapter 18, “Managing Printers and Fax Modems.”
Managing the print queue

1 Start up the PrintManager application.

2 Open the queue window for the printer whose queue you want to manage.

3 Select files you want to remove from the queue and click Delete. Or click Pause to stop all printing on that printer temporarily.

If you change your mind about printing a file after you've clicked Print in the Print panel, you can delete the copy that was sent to the print queue to stop it from printing. You can also temporarily pause and then resume all printing.

When you click Delete, selected files are removed from the print queue. If you delete a file that was being printed, no more pages in the file are printed. If you share a printer, you can delete only your own files from the queue.

Remember that the files in the print queue are just copies. Deleting them has no effect on the original files.

What Happens When You Pause

When you click the Pause button, it changes to Continue and the printer stops printing until you click the button again. All files in the queue—including any file that was being printed when you clicked Pause—are held in the queue until you continue printing. While printing is paused, anyone with access to the printer can still use it. However, their files are simply added to the queue until printing is resumed.

If you click Pause in the queue window for a printer that's not connected to your computer, you don't stop printing any files that are already in the queue. You also don't stop anyone else from using the printer. Instead, you simply stop your computer from sending files to that printer's queue. The files you print are stored on your computer until you click Continue.

For more information about PrintManager, see Chapter 18, “Managing Printers and Fax Modems.”
Saving your pages as a PostScript file

1. Choose Print from the main menu.

   You can prepare a file for printing and then save the prepared file instead of printing it. The prepared file is a PostScript file.

2. Select a printer, the page range, and other options you want in the Print panel.

3. Click Save.

4. Choose the type of PostScript file you want to save from the pop-up list.

5. Type a name for the file and select the folder where you want to save it.

6. Click OK.

**What Is a PostScript File?**

A PostScript file is a description, in the PostScript language, of a graphic image or pages.

PostScript is a standard programming language for describing text, images, and pages. PostScript is most commonly used to describe pages for a printer. It’s also the language used to describe what you see on a NEXTSTEP computer screen.

Different types of PostScript files are designed for different purposes. For example, the PostScript files you create with the Print panel describe whole pages, and may include options for working with a variety of printers or features specific to a single kind of printer. They have a .ps extension. You can open them with the Preview application, as described in Chapter 11, “Working with Graphics.”

Some applications, such as illustration applications, use image-oriented Encapsulated PostScript (EPS) files for displaying graphics. These files have an .eps extension.

The files you create in the Print panel are not EPS files, so you shouldn’t try to open them in page layout and graphics applications.
You have at least three choices for the kind of PostScript file you want to create:

| Normal Device-Independent PostScript | PostScript For Chosen Printer | Chosen Printer / Include Fonts |

You can choose Normal Device-Independent PostScript to save the file in a format that can be printed by any PostScript printer.

Or you can choose PostScript For Chosen Printer if you want to save the settings you made in the Print panel. Some of the settings, such as resolution and paper tray options, may apply only to the printer you selected.

If you don't think that the printer you'll use to print the file will have access to the fonts you've used in the original file, you can choose Chosen Printer/Include Fonts to save the fonts needed to print the file. (Be sure you comply with your software license for the fonts in the file.)

---

**Why Save PostScript Files?**

You can use the PostScript files you create with the Print panel to:

- Take a “snapshot” of your pages. Sometimes, page layout and other options you choose in an application change the way a page is printed. You can save a version as a PostScript file so that in the future, you can print it exactly as you saved it, regardless of other changes you make to the file, to your application, or to your system software.

- Create a version of your pages that anyone with a PostScript printer can print, exactly as you intended, even if they don’t have the same computer, application software, and fonts as you.

- Prepare a file for a printer you don’t own, such as a high-resolution imagesetter or film recorder. For example, you may want to take a copy of the PostScript file to a service bureau for printing.
If you have a fax modem, you can use the Fax button in the Print panel to fax your files instead of printing them—right away or at a time you schedule. You can include a standard cover sheet or one that you create yourself.
16

Sending Faxes

*It’s as easy as printing,* says your associate. She reminds you of your piano teacher who said you could play Bach if you could play scales. You know better. Besides, you hate noisy machines that eat your originals. And punching in all those numbers. You’d rather practice scales any day.

*Calm down,* says Ms. Associate. *Don’t click the Print button, just click Fax. Two clicks later and it’s on its way.*

Skeptical, you reach for the manual. Aha! If it’s so easy, why is there a whole chapter on it? Hmm, choosing a cover sheet. Scheduling the fax to go out later (when the rates go down, Ms. Associate points out). Keeping an address book.

*All done with mouse clicks and a few keystrokes in the quiet of your own office,* says Ms. Associate.

Mouse clicks and keystrokes, huh? Maybe you’ll take up faxing after all.
Sending a fax

1. Open the file you want to fax and choose Print from the main menu.

2. Click Fax in the Print panel.

3. Enter the full name and fax phone number for the recipient.

4. Check the Cover Sheet and other options you want.

5. Specify the range of pages you want to fax.

6. Click Fax Now.

If you can print a file, you can fax it. The tools for faxing are built into the standard Print panel.

About Fax Phone Numbers

Keep the following in mind when you type a fax phone number:

- If you're faxing to a long-distance number, enter 1 and the area code before the fax phone number.
- If your fax modem isn't connected to an outside line, be sure to enter any numbers you'd normally dial to call outside your building.
- If you normally have to wait a moment after dialing a number to get an outside line, enter a comma (,) after that number to make the fax modem pause a second before continuing dialing.
- If you have call waiting, type 1170 or *70 before the phone number to keep an incoming call from disconnecting you during faxing.

For more information about dialing, see your fax modem owner's guide.
If you maintain an on-line address book with the Workspace Manager, you can use the Fax panel’s browser to select the addresses or groups of addresses you want to send the fax to. If you want to send the fax to more than one address or group of addresses, hold down the Alternate or Shift keys while you click the ones you want.

You type the range of pages you want to fax in the To and From fields.

If you type a starting page number, the To field automatically changes to last.

If you type an ending page number, the From field automatically changes to first.

You can type 0 or even a negative number in the From field, if you want to fax pages that come before page 1.

When you click Fax Now, your pages are prepared for faxing. A temporary file is created and sent to the queue for the chosen fax modem. If no other files are in the queue, your file is faxed immediately.

Fax Panel Options

The Fax panel offers a number of options for sending a fax.

**Receipt** Check to receive mail that confirms your fax was sent or that lets you know there was a problem.

**Fine** Check to increase the sharpness of your pages—particularly pages that contain small fonts, fonts with thin vertical lines, or detailed diagrams or other kinds of art. Fine (or “high-resolution”) faxes have a resolution of 200-by-200 dots per inch (dpi), compared with about 200-by-100 dpi for normal-quality faxes.

**Trim Page Ends** Check to fax only the portion of each page that has text or an image on it, rather than the whole page. This option can reduce the time it takes to send a fax.

**Cover Sheet** Check Yes to include a cover sheet with your fax. For more information, see “Including a Cover Sheet” in this chapter.
Including a cover sheet

1 Open the Fax panel and check Yes under Cover Sheet.

2 Click Edit if you want to change the current cover sheet.

3 Choose the cover sheet you want to use from the Cover pop-up list.

4 Edit the information, as necessary.

5 Click OK.

You can include a cover sheet with each fax you send. You choose the cover sheet you want to use and edit it in the Cover Sheet panel.

You can use the Cover pop-up list to choose any cover sheet file in the ~/Library/Fax, /Library/Fax/English.lproj, or /LocalLibrary/Fax folder.

Depending on the cover sheet you choose and the information available about the recipient, some parts of the cover sheet are filled in automatically. For example, the To field is filled in with the recipient’s full name from the Fax panel. You can edit the parts of the cover sheet that are displayed in the panel. Images and uneditable text are displayed only in the miniature image of the cover sheet.
Custom Fax Cover Sheets

You can create custom cover sheets and keep them in the /Library/Fax folder in your home folder. Then you can choose one of them from the Cover pop-up list in the Cover Sheet panel whenever you want to send a fax.

The Draw Application Creates Cover Sheets

To create a cover sheet, you use the Draw application, which is stored in /NextDeveloper/Demos.

You can use any of the Draw tools to draw lines and shapes and add text to your cover sheet. Or you can drag an existing TIFF or EPS file into the Draw document (see "Adding a Graphic Image" in Chapter 11).

Fax Cover Sheet Commands Create Form Fields

In addition to objects you draw on the cover sheet, you can create standard form fields. These fields always appear on the cover sheet but contain different information depending on the fax you're sending. For example, a field might contain the current date.

To create fields, you use the commands in the Fax Cover Sheet menu, which is in Draw's Tool menu. You can create the following types of fields:

- **Date** This field is filled automatically with the current date.

- **Notes** You can add text to this field in the Cover Sheet panel.

- **From** This field is filled automatically with your full name.

- **To** This field is filled automatically with the full name of the recipient.

- **Pages** This field is filled automatically with the total number of pages in the fax, including the cover sheet.

- **Address** This field is filled automatically with the address from the recipient's address book entry.

The forms appear as gray boxes in your Draw document. You can move them or resize them and label them with text. When you save a custom cover sheet for the first time, be sure to click Yes in the panel that asks if you want to save the form entries with the file.

Custom Form Fields

You can create a custom form field by changing the text label of any standard field. You can also select any text you type in the Draw document and click Form Field in the Inspector panel to turn that text into a form field. Custom form fields are not filled in automatically—you can type the appropriate information in the Cover Sheet panel each time you send a fax.

When you create a custom cover sheet, you may find that it's easiest to modify the cover sheet in /NextLibrary/Fax/English.lproj and save it in your ~/Library/Fax folder rather than create one from scratch.
Choosing a fax modem

1. Open the Fax panel and click Modem.
2. Select the fax modem you want to use.
3. Click OK.

To send and receive faxes, you need access to a fax modem—a device your computer uses to talk to fax machines or other fax modems over telephone lines. The first time you send a fax, you choose a fax modem. It remains the current fax modem until you choose another one.

The Choose Fax Modem panel shows the name and type of each fax modem you can use, along with the host name of the computer it’s connected to. The fax modems connected to your computer appear first, followed by those available to you on the network.
Sending a scheduled fax

1. Open the Fax panel, enter the fax number, and select the other options you want.
   If your fax doesn’t need to go out right away, you can set a later date and time when you want your pages faxed. For example, you can pick a time when long distance rates are cheaper or when there’s less demand for a shared fax modem.

2. Click Fax Later.

3. Set the time when you want your pages faxed.

4. Click OK.
   ![Fax Later]
   - Click the hours, minutes, or date.
   - Then click the arrows to set an earlier or later time.
   - Click OK.

When you click OK, your pages are prepared for faxing. A temporary file (which includes the time you set) is created and sent to the queue for the fax modem you chose. It’s stored there until the time you scheduled it to be sent.
Managing the fax queue

1. Open the /NextApps folder and double-click PrintManager.app.

2. Choose Fax Modems from the PrintManager menu.

3. Click the name of the fax modem whose queue you want to check.

4. Click Queue.

When you fax a file, a copy is prepared and sent to the queue for the fax modem you chose. If no other files are in the queue (and you haven’t scheduled the fax to be sent later), your file is faxed right away. But if there are other files in the queue, yours is placed at the end.

The Fax Modems window lists all the fax modems you can use. The fax modems connected to your computer appear first, followed by those available on the network.

Remember that the files in the fax queue are just copies. Deleting them has no effect on the original files.
Updating fax addresses

To add an entry to your address book, type a name, full name, and fax phone number in the Fax panel and click Add.

To modify an existing entry, select it in the Fax panel browser, edit the full name and fax number, and click Modify.

To delete an address book entry, select the entry in the Fax panel browser and click Delete.

You can set up and maintain an on-line address book in the Workspace Manager. But you can modify the full name and fax phone number for an address book entry in the Fax panel. You can also add or delete an entry.

If you don’t have an address book file in your ~/Library/Addresses folder, a new one named Numbers.addresses is created when you first add an entry in the Fax panel.

For more information about maintaining an on-line address book in the Workspace Manager—including how to create a group of addresses—see “Adding an On-Line Address” in Chapter 12.
Without leaving your workspace, you can receive faxes from any fax machine or fax modem. You just need a fax modem and the FaxReader application, which you'll find in the lNextApps folder.

Emily.

Here's the mockup of the concept today. What do you think?

Jason

Received Faxes

<table>
<thead>
<tr>
<th>Date</th>
<th>Calling Number</th>
<th>Pages</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tue May 26 15:41:51</td>
<td>213 555 3961</td>
<td>2</td>
<td>26</td>
</tr>
<tr>
<td>Tue May 26 18:33:22</td>
<td>206 555 1234</td>
<td>4</td>
<td>49</td>
</tr>
<tr>
<td>Thu May 28 06:18:19</td>
<td>213 555 1111</td>
<td>2</td>
<td>33</td>
</tr>
<tr>
<td>Wed Jun 03 09:03:27</td>
<td>312 555 1212</td>
<td>3</td>
<td>47</td>
</tr>
</tbody>
</table>

Open | Assign... | Assign to Me | Delete
Getting Faxes

You got a promotion from your job at the front desk. With it came the dubious honor of handling incoming faxes. Now you spend all afternoon around this noisy machine gathering rolled-up paper off the floor and chasing people down to hand it out.

You collapse at your desk and dream up another scenario—one where you get faxes on your computer. Quietly. You route them to others with the click of a button. Effortlessly. Nothing gets lost. No one goes deaf. You take longer lunches.

The phone rings. It’s Ricardo looking for the fax from his lawyer. *Oh wait*, he says. *It’s on my screen.* *How the heck*...? He hangs up mumbling something about a prankster with a scanner. You smile and go back to work. You know that the scanner is out of service today.

Now, who should you invite to lunch first?
Starting up FaxReader

- **Open the /NextApps folder in the File Viewer and double-click FaxReader.app.**
- **Or**
- **Double-click a fax file icon.**

You can use the FaxReader application to view a list of faxes you've received, to read faxes, and to assign faxes to others.

![The FaxReader application icon looks like this.](image)

![A fax file icon looks like this.](image)

When you start up FaxReader by double-clicking its application icon, a window displays a list of faxes received by a fax modem.

![Fax modem window](image)

The date, size, and other information about received faxes are displayed in the fax modem window.

If you have a fax modem connected to your computer, its fax modem window opens the first time you start up FaxReader—otherwise, no window opens and you need to select one. Subsequently, the last fax modem window you opened is the one that opens when you start up FaxReader.

When you start up FaxReader by double-clicking a fax file, the fax opens directly in a FaxReader window and no fax modem windows open.

For information about choosing fax modems, see “Checking for Faxes” in this chapter.
When FaxReader is running, you can tell if you’ve received a new fax by checking its icon:

You’ve received
no new faxes.

You have new,
unread faxes.

A Mail message notifies you if you receive a fax on a fax modem whose window isn’t open in FaxReader—or if FaxReader isn’t running.

Who Has Access to Faxes?

Everyone who has access to a fax modem is assigned one of three access levels.

**Unrestricted** users see all new faxes received by the fax modem. They can assign new faxes to themselves and to other users, and they can work with the contents of the fax modem archive. Unrestricted users also receive a Mail message whenever a new fax is received if FaxReader isn’t running.

**Restricted** users see only faxes that have been assigned to them by another user. They can, in turn, assign faxes that have already been assigned to them—for example, to share them with other users.

Access levels are assigned with the PrintManager application. See “Sharing Access to Faxes” in Chapter 18.
Checking for faxes

1. **Start up FaxReader.**
2. **Choose Fax Modem from the FaxReader menu.**
3. **Select a fax modem in the list.**
4. **Click Open.**

If you have access to more than one fax modem, you can check each of them for faxes they've received. You use the Fax Modem panel, which lists all the fax modems that are connected to your computer or are available on your network.

![Fax Modem Panel]

When you select a fax modem and click Open, a window lists the faxes received on that fax modem. You can only open a window for a fax modem that you have been granted access to.
If you have unrestricted or trusted access to a fax modem, you see all new faxes in the window—in addition to faxes that have been assigned to you. If you have restricted access, only the faxes someone else has assigned to you appear in the window.

You can monitor the amount of disk space your faxes are taking up by checking the total at the top of the window—and the size of each fax in the list. Since faxes can be quite large, it's a good idea to delete them when you don't need them any more.

For more information about how faxes are assigned, see "Managing New Faxes" in this chapter.
Opening a fax

- Start up FaxReader, click the fax you want to open in a fax modem window, and click Open.

  Or

- Double-click a fax file icon in a File Viewer or Mail window.

A fax is a document you can open and read like any document. When you open a fax, it appears in a FaxReader window.

You can also open faxes with the Open command in the Fax menu. See “FaxReader Commands” in the Reference at the end of this book.
Changing how a fax is displayed

1 Open a fax in FaxReader.
2 Choose Display from the FaxReader menu.
3 Choose Inspector from the Display menu.
4 Click the options you want.

You can change the way a fax is displayed in the FaxReader window. For example, if the fax contains details you’d like to get a closer look at, you can double its size in the window. You can also turn the image in the window if you received one or more pages upside down or sideways. If the fax is oversized, you can choose to scale it, trim it, or display it on multiple pages.

All faxes are initially displayed at normal size, with oversized pages scaled to fit. You can use the Preferences command in the Info menu to change these general settings. See “FaxReader Commands” in the Reference at the end of this book.
Saving a fax

1 Open the fax you want to save in a FaxReader window.

2 Choose Fax from the FaxReader menu.

3 Choose Save As from the Fax menu.

4 Name the fax file and open the folder you want to save it in.

5 Click Group 4 or Group 3.

6 Click OK.

*Tip*: If you receive a fax for someone who doesn’t have access to the fax modem, you can use the Mail commands in the Services menu to mail the fax to anyone who can receive NEXTSTEP messages.
Managing new faxes

1 Start up FaxReader.

2 In a fax modem window, select the faxes you want to assign to another person or group of people.

3 Click Assign.

4 Select the person or persons you want to assign the fax to.

Because many people may receive faxes on one fax modem, you may need to assign faxes to the appropriate recipients. You can assign new faxes only if you have unrestricted or trusted access to a fax modem. Otherwise, you can reassign only faxes that have been assigned to you.

When you click Assign, a panel lists everyone who has access to the fax modem.

If you don’t include yourself in the list of people you assign the fax to, the fax is removed from the list in your fax modem window. If you just want to assign the fax to yourself, you can click Assign to Me.

Access to a fax modem is set with the PrintManager application. See “Sharing Access to Faxes” in Chapter 18.
Retrieving a fax from an archive

1. **Open a fax modem window.**

2. **Choose Archived Faxes from the pop-up list at the top of the window.**

3. **Select the faxes you want to retrieve.**

4. **Click Open to open the archived faxes. Or use the Assign or Assign to Me button to assign them.**

If you want to open a fax you deleted or assigned to someone else, you can retrieve it from the fax modem’s archive. You can view the archive for a fax modem only if you have unrestricted or trusted access to it. When you choose Archived Faxes, all the faxes in the archive are displayed in the window.

You open and manage archived faxes the same way you do new faxes. However, if you delete a fax from the archive, you can’t retrieve it unless you saved a copy as a fax file elsewhere.

You set the length of time faxes are stored in a fax modem’s archive with the PrintManager application. See “Setting Options for Archiving Faxes” in Chapter 18.
Reviewing a fax modem log

1. Open a fax modem window.

2. Choose Log from the pop-up list at the top of the window.

Every time a fax modem sends or receives a fax, it records its success or failure in its log.

Fax modem logs are normally displayed in 10-point type. But you can change to 12- or 14-point type with the Preferences command in the FaxReader Info menu. See “FaxReader Commands” in the Reference at the end of this book.

You can set the length of time entries are kept in a fax modem log with the PrintManager application. See “Setting Options for Archiving Faxes” in Chapter 18.

What’s Recorded in the Log?

The information in a fax modem log includes the following:

- An R to indicate the fax was received or an S to indicate it was sent.
- The date the fax was transmitted.
- The number of pages in the fax.
- The time it took to transmit the fax.
- OK to indicate success or a short note describing why the transmission failed.
- The fax phone number or other identifier sent by the other fax machine or modem, if it supports that feature.
- If the fax was sent, the number that was dialed to send it.
- If the fax was sent, the sender’s user name.
- If the fax was sent, the content of the Full Name field in the Fax panel.
Whenever you connect a printer or fax modem to your computer, you use the PrintManager application to make the printer or fax modem available to you and to others on your network. You also use PrintManager to set a number of options for the way you get and send faxes, and for who can work with the faxes a fax modem receives. You'll find PrintManager in the /NextApps folder.
Managing Printers and Fax Modems

"The stranger rides into town with nothing but a bedroll and a beltful of fire power. He ties old Bessie up outside the post office and saunters up to the postmaster.

'I'm 'spectin' a telygraph from Carson City, he says. He glances at the old tickertape machine behind the counter. *What, you only got one kinda machine? You ain't got no color? No laser printouts from the telyphone? No high-security clearance for who can read these communications? No archive facilities? What kinda two-bit outfit you running here?* He pulls out a .44 and shoots the postmaster dead..."

You take a gulp of coffee and read over the last paragraph. Something about it isn’t quite right. You scratch it out and shake your head. Looks like you’ve been putting off configuring your new printer and fax modem a little too long.
Starting up PrintManager

Open the /NextApps folder in the File Viewer and double-click PrintManager.app.

You use PrintManager to tell your computer and other computers on your network what printers and fax modems are available. You also use PrintManager to set options for sending and receiving faxes and to specify who can open the faxes your fax modem receives.

![The PrintManager application icon looks like this.](image)

When you first start up PrintManager, the Printers window opens:

![This list shows the name and type of each available printer and the host name of the computer it's connected to.](image)

The Printers window lists all the printers that are available to you, starting with the names of the printers connected to your computer.

If you close this window, you can always reopen it with the Printers command in the PrintManager menu. You can also use the Fax Modems command in the PrintManager menu to open a similar window that lists available fax modems.

For information about printing, see Chapter 15, “Printing.”

For information about sending faxes, see Chapter 16, “Sending Faxes.”

For information about receiving faxes, see Chapter 17, “Getting Faxes.”
About PostScript Printer Description (PPD) Files

PostScript Printer Description (PPD) files tell your computer about your printer. They typically include details about your printer's built-in fonts, the number and size of its paper cassettes, its resolution capabilities, sorting or stapling options, and many other features.

If you don't have the PPD file for a printer on your hard disk, the printer doesn't appear in PrintManager in the list of printer types you can add to your computer. In addition, if you don't have the PPD file for a printer you select in the Print panel (for example, because the printer is available to you on a network but the PPD file isn't), “Printer Information Unavailable” appears in the Print panel in place of its specific options.

You Probably Have the PPD File You Need

The PPD files for a few common printers are installed on all NEXTSTEP computers. And if you installed all the packages from the NEXTSTEP CD-ROM when you installed NEXTSTEP, you have the English-language PPD files for hundreds of models of printers and imagesetters.

If You Need to Add PPD Files

The easiest way to get additional PPD files is to install the PrinterPPDs.pkg Installer package onto your hard disk. If you work with high-resolution imagesetters, install the ImagesetterPPDs.pkg package as well. These packages are in the /NextCD/Packages folder on the NEXTSTEP CD-ROM. When you install one of these packages, the PPD files it contains are put in the /NextLibrary/PrinterTypes/English.lproj folder on your hard disk. (English.lproj is the folder where the English-language versions of the PPD files are stored.)

If you're short on disk space and just want a couple PPD files (instead of the hundreds in these packages), you can copy the individual NeXT PPD files you want from the /NextLibrary/PrinterTypes/English.lproj folder on the NEXTSTEP CD-ROM into the folder with the same name on your hard disk.

Since the /NextLibrary folder and its contents can be changed only by the superuser (root), you must know how to log in as root to add PPD files—whether by the package or individually. (See your system administrator if you need help logging in as root.)

Your printer may provide its own PPD file on a floppy disk. If so, you can create a PrinterTypes folder in your ~/Library folder and copy the PPD file there.

Your system administrator may also decide to add PPD files to a /LocalLibrary/PrinterTypes folder, so they're available to everyone on your network.

Your system administrator or the company that manufactured your printer may be able to help you find other PPD files.

For more information about the NEXTSTEP CD-ROM and the packages of software it contains, see the Release Notes. For more information about Installer packages and how to install them, see “Installing a Package” in Chapter 19.
Adding a printer

1. **Start up PrintManager.**

2. **Choose Printers from the PrintManager menu.**

3. **Click Create.**

4. **Type a name and a note about the printer.**

5. **Select your printer type in the list.**

6. **Choose the communications options for your printer.**

7. **Click OK.**

When you connect a printer to your computer, you use PrintManager to tell your computer about the printer, so it is added to the list of available printers that appears in the Print panel.

To set up your printer and connect it to your computer, see the owner’s guide for your printer.

For more information about the Configure application, see *Installing and Configuring NEXTSTEP.*

If your printer type doesn’t appear, see “About PostScript Printer Description (PPD) Files” in this chapter.

You may need to use Configure to add a port to your computer's configuration before it’s communications options are available in PrintManager.

You can use only letters, numbers, underbars ( _ ), and periods in the printer name.
If you’re adding a PostScript printer that’s connected to one of your computer’s serial ports, choose Serial from the Communications pop-up list. Then use the Port button to choose the port you connected the printer cable to. Set the baud rate and handshake options recommended by the owner’s guide for your printer.
Adding an HP JetDirect printer

1. Start up PrintManager.
2. Choose Printers from the PrintManager menu.
3. Click Create.
4. Type a name and a note about the printer.
5. Select your printer's type in the list.
6. Choose HP JetDirect from the Communications pop-up list.
7. Click Select.
8. Select your printer's host name in the panel and click OK.
9. Click OK again.

If you have a printer with an HP JetDirect network interface on your network, you can add it to the list of available printers that appears in the Print panel.

You can use only letters, numbers, underbars ( _ ), and periods in the printer name.

To set up a printer and connect it to your network, see the owner's guides for the printer and HP JetDirect network interface.

For information about adding a host to your network and assigning host names, see NEXTSTEP Network and System Administration.
When you click the Select button, the Host Name of Printer panel opens, which lists the host names of all the computers, HP JetDirect printers, and other standalone devices on your network.

![Host Name of Printer](image)

Select your HP JetDirect printer's host name in this list.

Click OK.

When you click OK, the printer’s host name and IP address are entered in the Create New Printer panel.

**Tip:** You can also type your printer’s host name or IP address directly in the Create New Printer panel’s Host Name of Printer field, instead of using the Select panel.
Adding a NetWare printer

1. Open the /NextAdmin folder in the File Viewer and double-click NetWareManager.app.

2. Double-click the NetWare server that serves the printer you want to add.

3. Type your NetWare user name and password in the panel that opens and click OK.

4. Choose NetWare Printers from the Configuration menu and click Create in the NetWare Printers window.

5. Type a name and note for the printer in the Create Printer panel and select the printer type in the list.

6. Click Set, browse to select the queue and print server for the printer you want to add, and click OK.

7. Click OK again.

If part of your network is a Novell® NetWare network and you have access to one of its servers, you can use the NetWareManager application to add printers supported by that server to the list of available printers in your Print panel.

When you start up NetWareManager, a window lists the NetWare network servers your system administrator has made available to you.

When you choose NetWare Printers, the NetWare Printers window opens. It lists any NetWare printers you’ve already added. When you click Create, the Create Printer panel opens.

For assistance with the NetWare network, see your system administrator.
When you click Set, a panel with a browser opens. You can use it to choose the file server, queue, and print server for the printer you want to add.

When you click OK in the Create Printer panel, the printer you added appears in the NetWare Printers window.

Click to modify an existing printer. Click to remove the selected printer.
Adding a fax modem

1. **Start up PrintManager.**
2. **Choose Fax Modems from the PrintManager menu.**
3. **Click Create.**
4. **Type a name and a note for the fax modem.**
5. **Select your fax modem type in the list.**
6. **Choose the port your fax modem is connected to.**
7. **Click OK.**

When you connect a fax modem to your computer, you use PrintManager to tell your computer about the fax modem, so it's added to the list of available fax modems that appears in the Choose Fax Modem panel.

For information on assembling your fax modem and connecting it to your computer, see the owner's guide for your fax modem.

If you need to add a serial port to your computer's configuration, you use the Configure application. See *Installing and Configuring NEXTSTEP.*

For information about sending and receiving faxes, see Chapter 16, "Sending Faxes," and Chapter 17, "Getting Faxes."
When you click the Create button, a new panel opens.

You can use only letters, numbers, underbars (_), and periods in the fax modem name.
Changing printer or fax modem settings

1. **Start up PrintManager.** You can change any of the settings you made when you first added a printer or fax modem to your computer.

2. **Choose Printers or Fax Modems from the PrintManager menu.**

3. **Select the name of a printer or fax modem and click Modify.**

4. **Make any changes you want in the panel that opens.**

5. **Click OK.**

   ![Image of PrintManager window with Printers and Fax Modems selected]

   *Click to change the settings of the selected printer (or fax modem, if you're working in the Fax Modems window).*

   ![Image of Modify Existing Printer window]

   *Change the settings you want and click OK.*

   You can modify printers and fax modems that are connected directly to your computer. You can also modify printers with HP JetDirect network interfaces that you added from your computer. The Modify button is dimmed when you select a printer or fax modem that's available to you on a network. It's also dimmed if you select the remote name of a printer or fax modem you're sharing with others.
Removing a printer or fax modem

1 Start up PrintManager.

2 Choose Printers or Fax Modems from the PrintManager menu.

3 Select the name of a printer or fax modem and click Modify.

4 Choose Unavailable from the Access pop-up list. Or click Delete.

5 Click OK.

If you disconnect a printer or fax modem from your computer, it’s best to remove its name from the list of available printers or fax modems.

Caution: Deleting a printer or fax modem removes all files or faxes waiting in a queue. It also removes any faxes you’ve received and not saved as fax files, including archived faxes.
Sharing a printer or fax modem

1. Start up PrintManager.

2. Choose Printers or Fax Modems from the PrintManager menu.

3. Select the name of a printer or fax modem and click Modify.

4. Choose Public from the Access pop-up list.

5. Click Set Domain.

6. Select the domain where you want to share the printer and click OK.

7. Type a name in the Remote Name field.

8. Click OK again.

If you have a printer or fax modem connected to your computer, you can share it with other people on a network. The name of your printer or fax modem then appears in the other people’s Print or Choose Fax Modem panel.

The remote name and note you type appear in everyone’s Print or Choose Fax Modem panel. Use only letters, numbers, underbars (_), and periods for the name. In the note, you can use punctuation and other characters.

You can also set up a printer or fax modem to be shared when you’re first adding it, as described in this chapter.
All computers on a network are organized in a hierarchy of groups of computers called *domains*, usually determined by the system administrator according to the computers' locations. When you first choose Public, your computer's own domain is listed below the button. Clicking the Set Domain button opens the panel you use to select the domain where you want to share your printer.

If you want to share your printer or fax modem with everyone on the network, just type / in the Domain field.

When you click OK, the domain appears in the Modify Existing Printer panel below the Set Domain button.

For information about how the domains in your network are organized, see your system administrator.
Sharing access to faxes

1. Start up PrintManager and choose Fax Modems from the PrintManager menu.
2. Select the name of a fax modem and click Modify.
3. Click the Fax Options button.
4. Choose Permissions Options from the pop-up list at the top of the panel.
5. Click Add.
6. Select the names of the users you want to share the fax modem with and click Add.
7. Select names in the Fax Modem Users list and click Unrestrict, Trust, or Restrict.
8. Click OK in the Fax Modem Options panel and then click OK again.

You can grant other users permission to work with faxes received on your fax modem.
When you click Add, a panel opens with a list of all the users on the computer and network. You can add as many users as you want.

Caution: Don't add people who are using NEXTSTEP Release 2, since they can't use their version of FaxReader to access faxes on a computer running NEXTSTEP Release 3.

Who Should Have Access

If you're the only person who will use a fax modem, simply leave yourself with the unrestricted access that is assigned to you automatically. But if a fax modem will serve a number of people, grant the access that makes sense to preserve the privacy of the people in your organization.

Grant unrestricted access to the person or persons whose job it will be to distribute faxes to the people they're meant for. This might be you (the owner of the fax modem), an administrative assistant, or the person who also distributes mail. (You must have at least one unrestricted user for each fax modem.)

Grant trusted access to people when you don't mind if they have access to all received faxes. Your system administrator, members of a work group, or a department head are typical trusted users. A trusted user can also serve as a backup in case an unrestricted user isn't available.

Grant restricted access to users when you want them to read only faxes assigned to them.

For more information about the different levels of fax modem access, see “Starting Up FaxReader” in Chapter 17.
Printing faxes automatically

1. Start up PrintManager.
2. Choose Fax Modems from the PrintManager menu.
3. Select the name of a fax modem and click Modify.
4. Click Fax Options.
5. Choose Printing Options from the pop-up list at the top of the panel.
6. Check Print.
7. Select the printing options you want and click OK.
8. Click OK again.

You can set up your fax modem to print received faxes automatically—like a conventional fax machine.

You can use the Choose button to change the printer the fax modem uses.

You can also choose this option when you add a new fax modem, as described in this chapter.

You can use the FaxReader application to print individual faxes. See Chapter 17, "Getting Faxes."
Setting options for sending and receiving faxes

1. **Start up PrintManager.**

2. **Choose Fax Modems from the PrintManager menu.**

3. **Select the name of a fax modem and click Modify.**

4. **Click Fax Options.**

5. **Choose Modem Options from the pop-up list at the top of the panel.**

6. **Set the options you want and click OK.**

7. **Click OK again.**

You can use PrintManager to set a number of options for how your fax modem sends and receives faxes.

**Tip:** You can tell whether your phone line uses pulse or tone dialing by listening when you dial. If you hear a series of clicks, your phone line uses pulse dialing. If you hear tones, your phone line uses tone dialing.

You can also set these options when you add a new fax modem, as described in this chapter.
Setting options for archiving faxes

1. Start up PrintManager.
2. Choose Fax Modems from the PrintManager menu.
3. Select the name of a fax modem and click Modify.
4. Click Fax Options.
5. Choose Recordkeeping Options from the pop-up list at the top of the panel.
6. Set the options you want and click OK.
7. Click OK again.

You can use PrintManager to change how long faxes are archived and how long log entries are kept. You can also change the disk where you want to store faxes that are received.

You can use the following pop-up lists to choose how long you want to archive faxes and retain log entries.

You open faxes and view a fax modem archive and log with the FaxReader application. See Chapter 17, "Getting Faxes."

You can also set recordkeeping options when you add a new fax modem, as described in this chapter.
Testing a printer

1 Start up PrintManager. You can use PrintManager to print a test sheet on any printer listed in the Printers window.

2 Choose Printers from the PrintManager menu.

3 Click the name of a printer in the Printers window.

4 Click Test. When you click Test, the following page is printed on the selected printer.

For troubleshooting hints, see the owner's guide for your printer.
YOUR CHOICE
You can often add new software to your computer simply by copying a few files from a floppy disk. But some software—including the files on the NEXTSTEP CD-ROM—comes in packages that you install with the Installer application.
Installing New Software

Okay, buddy, where do you want it?

You motion to a corner of the room and sign for the package. The delivery man steps back into the beaming chamber and disintegrates. You rush over to the box, open it, and step back. A large reference work—*Webster’s Ninetieth New Collegiate Dictionary*—floats up and locates itself in your library.

*Visitor arriving in portal one,* announces the chamber. This time it’s a box delivered by a freckle-faced girl. You open it, and a flutter of voices speaking Italian disperses throughout your house.

The chamber announces a third visitor. *La tua madre arriva a la porta due.* You’re pleased at how quickly your home voice system adopts its new language. Your mother, who is also pleased, steps out with a box of homemade lasagne. When you open this box, nothing happens. Oh, of course. You can put this away yourself.
Where to Install New Software

Your computer looks for certain kinds of software in particular folders. So when you install new software—such as applications, fonts, images, or sounds—you need to install it in a folder where your computer will find it.

The software you work with is stored in three main sets of folders:

**NeXT folders** These contain software created by NeXT. For example, `/NextApps` contains the Edit application. The only time you add software to one of these folders is when you use the Installer application to install software supplied by NeXT.

**Local folders** These folders contain software shared by a group of people who work on the same network (or who share a single computer). For example, if your company has a site license for a page-layout application, your system administrator may put it in `/LocalApps` for everyone to use. As a rule, only your system administrator can add software to local folders.

**Home folder** This is where you install software for your own use. For example, you can install your personal copy of an application in `~/Apps` (~ is an abbreviation for your home folder's name).

- `~/Apps`: Put your private copies of software in these standard folders in your home folder.
- `~/Library`: This is the location for many standard folders. Common ones are shown at the right. Some applications create additional folders in `~/Library` for their own use.
- `~/Library/Addresses`: Put the address books you maintain in the Workspace Manager and Fax panel here.
- `~/Library/Bookshelves`: Put the Librarian bookshelves you create here.
- `~/Library/Colors`: Put color lists you buy or create here.
The Workspace Manager and other applications look for software in folders in a standard order:
1. Your home folder
2. Local folders
3. NeXT folders

When you double-click a document to open it, the Workspace Manager looks for the associated application in the following places in order:
1. The application dock
2. ~/.Apps
3. ~/LocalApps
4. ~/NextApps
5. ~/NextAdmin

You can take advantage of the standard search order when you install software. For example, if you want to use your own version of a font, you can install it in your home folder’s ~/.Library/Fonts folder to take the place of the version with the same name in ~/LocalLibrary/Fonts or ~/NextLibrary/Fonts.

Also, when you drag an application icon to the dock, that copy of the application is used, regardless of where its folder is stored.

You can also use the Workspace Manager Tools Inspector panel to choose which application opens when you open a particular file. For more information, see “Changing the Application that Opens a File” in Chapter 7.

~/Library/Fax

Put the fax cover sheets you create in the Draw application here.

~/Library/Fonts

Put your personal copies of fonts here.

~/Library/Keyboards

Put custom keyboard layouts here.

~/Library/PrinterTypes

Put PostScript Printer Description (PPD) files you get from sources other than NeXT here.

~/Library/Sounds

Put sounds you want to use as system beeps here.
Starting up the Installer application

- Double-click an Installer package file.

Or

- Open the /NextAdmin folder in the File Viewer and double-click Installer.app.

You can install some software by simply copying it into the appropriate folder using the Workspace Manager. But many applications, fonts, and other software come in packages you install with the Installer application.

Some Installer packages contain software that must be installed in a folder you don’t have permission to change—usually one owned by the superuser (root). You must log in as root to install or do other work with such packages. For example, you must log in as root to install most of the packages in the /NextCD/Packages folder on the NEXTSTEP CD-ROM.

Each Installer package file opens in its own Installer package window.

For more information about becoming the superuser (root), see your system administrator.
Before you install an Installer package file, it contains one or more files in a compressed format, a list of those files and where they should be installed, and other information.

When you install a package, its files are installed in the folder you specify, and a version of the Installer package—called a "receipt"—is placed in /NextLibrary/Receipts. Package receipts normally don’t contain the files you install, just information about the files and where you installed them.

**Caution:** If you’re installing a package that’s split onto multiple floppy disks, don’t copy the pieces onto your hard disk or rename the disks they come on. Otherwise, you won’t be able to install the package properly.
Installing a package

1 Open the package file.

2 Click Install in the package window.

3 Click Set if you want to install the contents of the package in a folder other than the default folder.

4 Check the kinds of computers you want to use the software with.

5 Check the languages you want to make available to users of the software.

6 Click Install.

You can use the Installer to install a package and its contents on your hard disk. You just open the package and click Install in its package window.

When you click the Install button, the Install Package panel opens.

Click to install the package.

Click to open a panel where you can select where you want to install the software in the package.

Check each computer you want to be able to use the software with.

Check the languages you want to make available to users of the software.

Then click Install.

If the package contains software that must be installed in the default folder, the Set button isn’t available in the Install Package panel.

When you click Install in the Install Package panel, Installer checks the contents of the package and the contents of the folder you set to install it in. If some of the files in the package already exist in that folder, you’re asked if you want to replace the existing files.

Be sure to read the user’s guide for new software before installing it. The guide may have special information about installing the software.

You can preset the computers and languages initially checked in the Install Package panel. Use the Preferences command in the Info menu. See “Installer Commands” in the Reference at the end of this book.
If the package you’re installing is split up onto more than one floppy disk, a panel prompts you to insert each disk in the floppy disk drive as needed. Normally, you monitor the progress of installation in the Progress view. But you can also view a detailed account of the installation by choosing Log from the pop-up list in the window.

When the installation is complete, the pathname in the title bar changes from the name and location of the uninstalled package to the name of the installed package receipt on your hard disk in /NextLibrary/Receipts. Remember that the package receipt doesn’t contain the software you installed. It only contains information about the software and where you installed it. The software itself is installed in the folder you specified in the Install Package panel.
Listing the contents of a package

1. Open the package.
2. Click List in the package window.
3. Choose Log from the pop-up list at the top of the window.

You can create a list of all the files in a package and display it in the Log view. The List button is available for uninstalled packages on a floppy disk, a CD-ROM, or another location, as well as for installed package receipts in /NextLibrary/Receipts.

If the package is not yet installed, the list includes the pathname where each file will be installed. If the package is already installed, the list includes the pathname where each file in the package was installed on your hard disk.

You can choose the amount of detail you want in the log with the Preferences command in the Info menu. See "Installer Commands" in the Reference at the end of this book.
Where to Find Packages of Software

There are a number of sources for packages of software.

**The NEXTSTEP CD-ROM**

The NEXTSTEP CD-ROM contains a complete copy of NEXTSTEP. It may also contain software that isn't installed on your hard disk.

The /NextCD/Packages folder on the NEXTSTEP CD-ROM contains the packages of software you can install, including:

- Demonstration applications
- A copy of NEXTSTEP Network and System Administration, plus the UNIX manual pages, that you can read with Digital Librarian
- Digital Webster, the electronic edition of Webster's Ninth New Collegiate Dictionary
- Illustrations for Digital Webster
- PostScript Printer Description (PPD) files for printers and for high-resolution imagesetters

For more information about the packages on the NEXTSTEP CD-ROM and what they contain, see the Release Notes that come with the CD-ROM.

**The NEXTSTEP Developer CD-ROM**

This CD-ROM contains applications and files that you need to write NEXTSTEP software.

**Third-Party Applications**

Many applications, fonts, databases, images, and other software products are available from companies other than NeXT. Much of this software is distributed in packages on CD-ROM, floppy disks, or from public servers on the Internet.

**Other Sources**

Your local NeXT user's group may offer disks with free or demonstration software. You may also be able to obtain software from your system administrator.
Compressing and expanding a package

- **To compress a package,** open its package receipt in `/NextLibrary/Receipts` and click Compress in its package window. Then click Compress again in the panel that opens.

- **To expand a package,** open its package receipt in `/NextLibrary/Receipts` and click Expand in its package window. Then click Expand again in the panel that opens.

If you’ve installed a package of files that you aren’t planning to use for a while, you can save some space on your hard disk by compressing the package. When you compress a package, its files are removed from their individual locations on your hard disk and are stored in a compressed format in their package receipt in `/NextLibrary/Receipts`.

When you want to work with the files in a compressed package again, you can expand the package receipt in `/NextLibrary/Receipts` to restore its files to the appropriate locations on your hard disk.

**Caution:** Compressing and expanding Installer packages isn’t the same as compressing and expanding individual files and folders with the Workspace Manager.
Deleting a package

1. **Open the package receipt in** `/NextLibrary/Receipts`. If you no longer need the applications, fonts, images, or other software from an Installer package, you can delete them. You do this by opening the package receipt in `/NextLibrary/Receipts` and clicking the Delete button in its package window. This removes the package receipt and all the package’s files from your hard disk.

2. **Click Delete in the package window.**

3. **Click Delete again in the panel that opens.**

**Caution:** Don’t use the Workspace Manager to delete a package receipt from `/NextLibrary/Receipts`, or you won’t really delete the package’s files from your hard disk, just the receipt for the files.

When you click Delete, a panel asks you to confirm that you want to delete the package. The panel may also include information about the consequences of deleting the package and its files.

**Caution:** Deleting a package permanently removes the package receipt and its files from your hard disk. Be sure you have an uninstalled copy of the package on a floppy disk, CD-ROM, or another location before you delete the installed copy.
Individual applications have Preferences commands that you can use to tailor the applications to your needs. But if you want to set preferences that apply to all your applications—or if you just want to set the date and time—use the Preferences application. It's in the dock.
Personalizing Your Workspace

You always wanted to be an architect. You’d create spaces. Spaces of every shape and size. And you’d plan activities for your spaces—what people would do in them, what time of day or night they would do it, what would help them do it better.

No ordinary architect, you’d get all the best jobs. Clients would come to you from every country in the world, seeking designs that fit their local climate and customs. They wouldn’t want standard solutions to their problems—they’d want custom solutions, alternatives that only you could dream up.

That was your dream once upon a time. Of course, now you’ve got more important things to do. Like planning how to use your workspace—what you’ll do in it, what time of day or night you’ll do it, what will help you do it better...
Starting up the Preferences application

You use the Preferences application to choose a wide range of options for personalizing your workspace, managing your hardware, and controlling access to your computer. The Preferences application normally starts up when you log in and is hidden automatically. It appears in the dock as an icon that shows the time and date.

Some of the preferences you set in the Preferences application are also affected by how you configure your computer with the Configure application. For information, see Installing and Configuring NEXTSTEP.

Some applications may add their own Preferences buttons to the Preferences window. For information about these custom buttons, see the user's guide for the application.

If you don’t want Preferences to start up automatically when you start your computer, see “Starting Up an Application Automatically” in Chapter 4.

Some of the settings you choose with Preferences take effect immediately. Others take effect only after you start up an application or restart the computer.
Hiding menus

You can hide application menus and you can use your mouse to display menus when you need them.

1 Start up Preferences and click the button for Menu Preferences.
2 Drag the Preferences menu off the lower right corner of the screen.
3 Click the button for Mouse Preferences.
4 Click Enabled.
5 Click Left or Right to select the mouse button you want to use to display menus.
6 Restart your applications.

When you restart your applications, all their menus are hidden, and you must press a mouse button to display them.

**Where Do You Want Your Menus?**

You can choose a standard location for all your main menus in either or two ways: You can click the button for Menu Preferences and drag the Preferences menu to the new location in the workspace. Or you can drag the mini-menu in the Menu Preferences.

The next time you start up an application, its main menu appears in the new standard location—unless you’ve moved the menus in your application. If you have, the menu appears where you left it.
Working in your own language

1. **Start up Preferences** and click the button for Localization Preferences.

2. Drag your preferred language to the top of the Language list.

3. Drag the remaining languages into the order you want.

4. Restart your applications.

The Workspace Manager and many other applications can display the text in their windows, menus, and panels in more than one language. You can specify the language you want to use in these applications.

When you start up an application, it checks your order of preference and displays text in the first language it has available.

When You Want to Work in a New Language

When you first install NEXTSTEP and when you later install a package of software with the Installer application, you select the languages you want to work in.

To add support for languages you didn’t select when you installed a package of software, you can delete the package and reinstall it with support for the languages you want.

To reclaim disk space, you can reinstall a package with support for fewer languages.

Receipts for packages you install are in /NextLibrary/Receipts.

For information on using the Installer, see Chapter 19.

All NEXTSTEP software packages are included on the NEXTSTEP CD-ROM in /NextCD/Packages, so you can always reinstall one from there. For information, see the Release Notes that come with the CD-ROM.

You first pick a language when you install NEXTSTEP. For more information, see Installing and Configuring NEXTSTEP and “Selecting Your Language” in Chapter 1.

You may also want to specify a keyboard arrangement for the language you’re using. See “Choosing a Keyboard Arrangement” in Chapter 21.
Choosing units of measure and paper size

1. **Start up Preferences and click the button for Localization Preferences.**

2. **Choose the unit of measure you want from the Measurement Units pop-up list.**

3. **Choose the paper size you want from the Paper Size pop-up list.**

4. **Restart your applications.**

In some applications, you can specify the sizes of objects on the screen and the size of the paper you prefer to print on. For example, in Edit and Mail you can use a ruler to specify the width of the page, and in the Page Layout panel you can choose a paper size. With Preferences, you can set standard units of measure and a paper size you prefer to work with in all your applications.

The new units of measure and paper size take effect for an application the next time you start it up.

You can change the units of measure and paper size in some applications independently. For example, you might choose inches in Preferences but then work with picas and points in your page layout program. For details, see the user's guide for your application.
Setting the date

1 Start up Preferences and click the button for the Date & Time Preferences.

Your computer has an internal clock that displays the date and time on your computer. It's also used to create a date and time stamp for changes to your files and folders. If your computer isn’t connected to a network, you can use this internal clock to set the date.

2 Click the month arrow to select the month.

3 Click the year arrow to select the year.

4 Click a date in the calendar.

5 Click Set.

You can click the icon in the window to pick the style of Preferences icon that appears in the dock. If your computer supports Advanced Power Management (APM), you can even pick an icon that displays the battery charge level.

If you’re working on a network, you may not be able to set the date and time independently, but you can synchronize your computer’s clock with the network’s clock.

You can click the icon in the window to pick the style of Preferences icon that appears in the dock. If your computer supports Advanced Power Management (APM), you can even pick an icon that displays the battery charge level.
Setting the time

1. Start up Preferences and click the button for Date & Time Preferences.

2. Click in the map to select a time zone.

3. Select the hours, minutes, or seconds in the time field.

4. Click the arrows to change the time. Or type a new time.

5. Click Set.

If you’re working on a network, you can synchronize your computer with network time as described on the previous page. If you’re not connected to a network, you can set hours, minutes, and seconds. In either case, you can display the time in any time zone you want.

When you select a time zone, the button above the map shows the difference, in hours, between your time zone and Greenwich Mean Time (GMT). You can press this button to choose the regional variation within your time zone that applies to you. Select the time zone before you set the date and time. Otherwise, your settings are lost.
Changing the fonts on the screen

1. **Start up Preferences** and click the button for Font Preferences.
2. **Choose the type of font** you want to change from the pop-up list.
3. **Click Set Font.**
4. **Select a font family,** typeface, and size in the Font Panel.
5. **Click Set.**
6. **Log out and log back in.**

You can change what fonts appear in menus, window titles, prompts, and other places on the screen.

When you choose a type of font and click Set Font, the Font Panel opens. You use it to select a font family, typeface, and size.

The fonts you select appear on the screen the next time you log in.

For more information about setting fonts, see “Setting a New Font” in Chapter 9.
Selecting a font for applications

1. Start up Preferences and click the button for Font Preferences.
2. Choose Application Font from the pop-up list.
3. Click Set Font.
4. Select a font family, typeface, and size in the Font Panel.
5. Click Set.
6. Restart your applications.

You can choose a default font for your applications. The default font is the one the application uses when you first enter text in a new document or anytime you don’t specify a font.

When you click Set Font, the Font Panel opens. You use it to select a font family, typeface, and size.

Applications use the new font the next time you start them up. However, some applications may not use the font you set. Some have their own options for setting a default font that overrides Preferences. Also, some applications preset their own default font family, typeface, or size. This preset font overrides your choice.

For more information about setting fonts, see “Setting a New Font” in Chapter 9.
Creating Command-key equivalents

1 Start up Preferences and click the button for Menu Preferences.

2 Click in the Command field and type the name of the command.

3 Click in the Key Equivalent field and type a character.

4 Click Add.

5 Restart your applications.

Most applications include Command-key equivalents for some of the commands in their menus. A Command-key equivalent is a combination of the Command key and other keys that you can type instead of choosing a command from a menu. If a command has no Command-key equivalent, you can create your own. You can also change existing Command-key equivalents.

When you type the command name, be sure to match the capitalization, spaces, and ellipses (…) in the menu. The Command-key equivalent can be any character except a space. Case makes a difference. For example, if you type a lowercase c, the Command-key equivalent is Command-c. If you type an uppercase C, the Command-key equivalent is Command-Shift-C.

When you create a Command-key equivalent, it’s added to all applications that have the command (unless the application overrides Preferences). If you create a Command-key equivalent that’s already in use, it’s removed from the current command and added to the one you specify.

You can modify a Command-key equivalent you created by selecting it in the list in the Menu Preferences, typing a new key equivalent, clicking Add, and then clicking Modify in the panel that opens. You can remove a Command-key equivalent you created by selecting it in the list and clicking Remove.

New Command-key equivalents take effect in an application the next time you start it up. They take effect in Workspace Manager menus the next time you log in.

To find out which is your keyboard’s Command key, see “Keyboard Basics” in Chapter 9.
Customizing the Services menu

1. **Start up Preferences and click the button for Services Preferences.**

2. **Select the service you want to enable or disable.**

3. **Click the Enable or Disable button.**

When you’re working in applications, you can request some of the services of other applications from the Services menu. If you have lots of services, you may decide to display some of these services and not others.

The next time you use an application, its Services menu lists only the services that are enabled.

For information about using services, see “Requesting the Service of Another Application” in Chapter 4. See also the list of NEXTSTEP application services in “Standard Commands” in the Reference at the end of this book.

For information about adding your own services to the list in the Services Preferences, see the NEXTSTEP Developer's Library.
Displaying large file systems

1. Start up Preferences and click the button for Expert Preferences.

2. Check Large File System.

3. Log out and log back in.

If you're working with disks and folders that contain several hundred files and folders, you can optimize the File Viewer to display them more quickly.

When you check Large File System, the File Viewer can open large folders faster than normal. So can the Open and Save panels. However, scrolling through the contents of large folders may take a little longer than normal. Also, you see the names of some additional files and folders in Open and Save panels, not just the ones your application can work with.

This option takes effect the next time you log in.
Displaying UNIX files

1 **Start up Preferences** and click the button for **Expert Preferences**.

2 **Check UNIX Expert.**

Your computer uses many files that don’t normally appear in the File Viewer. Some of these are UNIX system files, including files called *dot files*—their names begin with a period. If you’re a system administrator, programmer, or an advanced user, you may want to use these files. Otherwise, it’s best to leave them hidden.

The UNIX system files are immediately displayed in the File Viewer. They also appear in Open and Save panels as well as in any other panel that displays the contents of disks and folders.

**Tip:** Don’t give files names that begin with periods. They will be hidden with the other dot files when UNIX Expert is not checked.

For more information about UNIX files, see NEXTSTEP Network and System Administration and the NEXTSTEP Developer’s Library.
The Preferences application not only helps you custom-fit your workspace, as described in the previous chapter. It also helps you manage your hardware—from the keys on your keyboard to the speed of your mouse.
Managing Hardware

You love your car. But you might want to make just a few little adjustments.

For starters, you’d like the windshield tinted red, like the sunset. You might also want the horn to *ahoooga*, like an old police wagon. The steering wheel should really be on the other side—you know, like they are in England. The harder you step on the accelerator, the faster you should accelerate. And in the morning, the car should be warmed up and ready to go when you walk out your front door.

You can hear your mechanic now. *A tinted windshield, a new horn, an adjustable steering wheel, a touch-sensitive accelerator, an automatic starter!* Where’d you get all those crazy ideas?

Oh well. You turn to your computer. You love it, too. Of course, you had to make a few adjustments...
Selecting a keyboard arrangement

1. **Start up Preferences and click the button for Localization Preferences.**

2. **Select a type of keyboard in the list.**

The standard arrangement of keys on keyboards differs from country to country. If you’re used to working on a particular type of keyboard, you can choose its arrangement regardless of which keyboard you’re actually using.

For information about starting up Preferences, see the previous chapter, “Personalizing Your Workspace.”

For information about selecting fonts from the Font Panel, see “Setting a New Font” in Chapter 9.

See also “Previewing Special Characters” in Chapter 9.

When you click Keyboard Panel, a panel shows the arrangement of keys on the keyboard that is currently selected.

You can hold down the Shift or Alternate key—or both keys together—to see the effects of these keys on the keyboard. You can also click Set Font to open the Font Panel and see how different fonts use the selected keyboard arrangement.

The new keyboard arrangement takes effect immediately.
The NeXTUSA Keyboard Arrangement

As an alternative to the standard USA keyboard arrangement, you can select the NeXTUSA arrangement in the Preferences application’s Localization Preferences. You may find that this arrangement works particularly well with NEXTSTEP.

The keys in the NeXTUSA arrangement that are different from the USA arrangement are described and illustrated below. The USA arrangement is shown in “Keyboard Basics” in Chapter 9.

A Key for Turning Off the Computer

The NeXTUSA arrangement provides a key for turning off the computer. You can press this key as a shortcut to choosing the Log Out command or clicking the Power button in the login window. When you press the key, a panel asks if you really want to turn off the computer. Click Turn If Off in the panel. When a message tells you it’s OK to actually turn off the power, you can do so.

Brightness and Volume Keys

When you use the NeXTUSA arrangement, you can adjust screen brightness using the brightness keys. If your computer can play sounds, you can adjust its speaker volume with the volume keys. The longer you hold down one of these keys, the more brightness or volume changes.

You can turn the speaker off when you’re using the NeXTUSA arrangement by holding down the Command key and pressing the volume down key. Do this again to turn the speaker back on.

Additional Command and Alternate Keys

The NeXTUSA keyboard arrangement provides two Command keys and two Alternate keys, which make it easier to do things like use Command-key equivalents and type special characters.
Setting the rate for repeating characters

1 Start up Preferences and click the button for Keyboard Preferences.

2 Click a setting for the initial key repeat.

3 Click a setting for the key repeat rate.

4 Test your settings by pressing any character key.

Sometimes you need to repeat characters in a long string. Typical repeating characters are periods and asterisks, but you can repeat any character on the keyboard by holding the key down. The Backspace and Tab keys also repeat, as does the space bar.

Of course, you don’t want characters to start repeating too quickly when you press a key, or you’ll have double and triple characters scattered throughout your text. You may also want to control how quickly the character repeats.

The new settings take effect immediately.

You can click the Keyboard Panel button to open a panel that shows the location of characters on the current keyboard. If you’re looking for a particular character in a font, use the Set Font button to open the Font Panel, where you can change the font displayed in the Keyboard panel.

If you have a NeXT computer with a keyboard that has a Command bar, you can check “Switch Help and Command Keys” to switch the effect of pressing the Help key and Command bar.

For information on changing the current keyboard, see “Selecting a Keyboard Arrangement” earlier in this chapter.
Changing the responsiveness of the mouse

You can make the mouse more responsive to your movements in two ways. First, you can change the mouse speed—which is how fast and how far the cursor moves when you move the mouse. Second, you can change the double-click delay—the setting that determines when the computer responds to two clicks as a double-click, as opposed to two distinct clicks.

You should choose the shortest double-click delay that works for you. You can test it by double-clicking the word Test. Double-click at your normal speed. If Test is highlighted, you're double-clicking fast enough for the delay you've chosen.

The new mouse settings take effect immediately.
Setting the automatic screen dimmer

To protect your display, the screen dims automatically when you’re not using it. The screen normally dims if you don’t press a key or move the mouse for 30 minutes. You can change this delay or even turn off the dimmer completely.

You can set a delay from 5 to 59 minutes. You can turn off the dimmer completely by dragging the slider all the way to the right. The new setting takes effect immediately.

Screen dimming happens only when you’re logged in. When the login window is showing and you don’t use the computer for a while, the NeXT logo replaces the screen’s contents, instead.

Some computers have displays that don’t dim automatically and don’t respond to adjustments to the Brightness slider. You can only control the brightness of their displays with controls on the displays themselves.

The superuser (root) can also modify the login window screen saver. For more information, see “Setting Login Window Options” in the next chapter.
Changing the background color of the display

1. Start up Preferences and click the button for Display Preferences.

2. Click the Colors button.

3. Select a color in the Colors panel.

4. Drag the color from the well in the Colors panel to the Background Color well.

You can choose the background color for your workspace. It can be a color you pick up from the screen or a color you select from one of the color models.

If you work with some computers with color displays and others with monochrome displays on the same network, you set the background color separately for each kind of display.

**Tip:** If you want to save the current background color while you experiment with new colors, you can click in the color well in the Display Preferences and drag a color swatch to the row of swatches at the bottom of the Colors panel.

You can select colors from the Colors panel in several ways. See Chapter 10, "Working with Color."
Adjusting volume and input gain

1. Start up Preferences and click the button for Sound Preferences.

2. Drag the Volume sliders to adjust the volume and balance of the speakers and "line-out" jack.

3. Drag the Input Gain sliders to adjust the sensitivity and balance of the microphone and "line-in" jack.

If your computer can work with sounds, you can adjust the volume and balance of the speakers and "line-out" jack. You can also adjust the sensitivity (or "gain") of the microphone and "line-in" jack.

You can check Mute to turn off the speakers and line-out jack completely. The settings you make take effect immediately.
Selecting system beeps and warnings

1 Start up Preferences and click the button for Sound Preferences.

2 Click Audio for a sound beep or Visual for a warning flash.

3 If you clicked Audio, select the type of system beep from the list.

4 Check Use Voice Alerts if you want spoken warnings and notices.

NEXTSTEP has several ways to alert you when something requires your attention. A system beep may sound when you make a mistake typing. A panel may alert you to a problem or request additional information. You can tailor these system beeps and warnings to your needs.

Some applications have spoken versions of some panels. For example, PrintManager may tell you when your printer is out of paper. If you prefer to hear these messages as well as read them, you can check Use Voice Alerts to hear the spoken versions.

If you click Visual, the NeXT icon at the top of the application dock flashes whenever something needs your attention. No beeps sound.

You can adjust the volume of your system beeps and warnings with the Volume slider.

These choices take effect immediately.

Tip: You can add your own sounds to the list of possible system beeps by adding a sound (.snd) file to the /Library/Sounds folder in your home folder. You can use voice alerts or a custom system beep only if your computer can play sounds.

For information on adjusting the speaker volume, see “Adjusting Volume and Input Gain” on the previous page.

On some computers, you adjust the volume and style of system beep with the Configure application. See Installing and Configuring NEXTSTEP.
Managing power consumption

1 Start up Preferences and click the Power Management Preferences button.

2 Click the option you want.

If you’re running NEXTSTEP on a battery-powered computer that supports Advanced Power Management (APM), you can decrease the amount of power required to run NEXTSTEP—so your batteries last longer—in exchange for an occasional reduction in performance. You can also check the battery charge level.

When you click “Longest battery life,” NEXTSTEP uses a number of techniques to reduce power consumption. For example, NEXTSTEP stops the hard disk from spinning whenever it’s not in use. This decreases the drain on the battery but can cause a slight delay the next time NEXTSTEP needs information on the disk. When you’re not using battery power, you should click the “Best performance” option.

If you’re using a desktop computer that supports Advanced Power Management but doesn’t run on batteries, the “Longest battery life” option is replaced by “Energy efficiency.”

The Power Management Preferences are available only on computers that support Advanced Power Management, such as some battery-powered portables as well as some energy-efficient desktop models.

Tip: If your computer runs on batteries, you can use the Date & Time Preferences to pick a Preferences dock icon that displays the battery charge level as well as the current time.

For information on picking a Preferences dock icon, see “Setting the Date” in Chapter 20.
Setting the computer to turn on automatically

Some NeXT computers can be set to turn on automatically at a time and date you choose, or after a power failure.

You can click the month and year arrows to change the month and year. You can click a day in the calendar to set a date. To set the time, you can either type a new time in the time field or select the hours, minutes, or seconds and click the arrows.

If you check “After power off or failure,” the computer turns on automatically within 60 seconds after a power failure—or after you turn it off yourself. (Don’t check this option if you really do want to turn off the computer.)

The Startup Preferences are only available if your computer supports this feature.

**Why Turn the Computer On Automatically**

Having a computer turn on automatically is most useful if it acts as a server on a network—that is, a computer with files and folders that everyone shares.

For example, a computer may be a server for a printer that must always be available by 8:00 in the morning—whether anyone is there to turn on the computer or not.

The option to turn on automatically after a power failure is also particularly important for servers. If the server has a power failure, it can turn itself on as soon as the power is restored, minimizing the amount of time that service to people on the network is interrupted.
You can use the Preferences application to control access to your computer, your workspace, your folders, your display, even your sound system. You can share them or not. The choice is yours.

<table>
<thead>
<tr>
<th>Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Windows</td>
</tr>
<tr>
<td>Hide</td>
</tr>
<tr>
<td>Quit</td>
</tr>
</tbody>
</table>

Password changed.

Please type your new password again.

Alert

Password changed.
Controlling Access to Your Computer

It's been a quiet night. A few people came and went without incident. There was some excitement about a password change, but you got that straightened out.

You suddenly hear a loud noise coming from Sector B. You grab your flashlight and run to investigate. Then you remember. You opened the area up to an outside sound recording crew.

On the way back to your post, you check on the new restricted zones you set up last week. Everything looks secure.

You return to your post and update your report. *Just another quiet night,* you think. But then, that's the way you like it.
Setting a password

1 Start up Preferences and click the button for Password Preferences.
2 Click Change.
3 Type your current password and click OK.
4 Type your new password and click OK.
5 Type the new password again to verify it and then click OK.
6 Click OK in the confirmation panel.

If you work on a network, you typically have a user name and a password that you use every time you log in. You should change your password at least once a month. When you click the Password Preferences button, the closed padlock and “Password Secure” message show that your current password is in effect. If you don’t have a password the padlock is open.

You change your password or create a new one by clicking the Change button.

For information about starting up Preferences, see Chapter 20.

For more information about passwords and computer security, see NEXTSTEP Network and System Administration.
When you type your old password and click OK, the padlock opens to show your password is no longer secure. You’re asked to type a new password.

After you type your new password and click OK, Preferences asks you to type the new password again to make sure that what you typed the first time was what you meant to type.

If you type the same word the second time, a panel confirms that the new password is set. When you click OK in this panel, the original Password Preferences window returns—with the padlock closed—ready for the next time you want to change your password. If you make a mistake when you’re verifying the password, you must start over.

**What Makes a Password Secure**

Passwords should be easy to remember but difficult for others to guess. Here are some guidelines:

- Avoid names of your children, pets, or other obvious personal favorites.
- Choose a password with at least eight characters. The shorter a password is, the easier it is for someone to decode.
- Combine upper- and lowercase letters, numbers, symbols, and spaces in your password.

Here are some examples of good passwords:

*a*I*f*a
a#bcd ef
W$Bridge
bARnEgt!
Setting permissions for new files and folders

1. Start up Preferences and click the button for Expert Preferences.

2. Check the permissions you want for new files and folders.

3. Log out and log back in.

You can grant others permission to read and change your files and to execute programs that you own—or you can deny permission. You can make this choice for individual files and folders with the Inspector, but you can also preset the permissions you want for all new files and folders you create.

The permissions you set here take effect the next time you log in. They apply to all new files and folders you create, unless your application has built-in permission settings that override Preferences. In any case, you can change permissions for individual files and folders with the Inspector.

For information about using the Inspector to check and set permissions, see “Changing Permissions for a File or Folder” in Chapter 7.

Permissions affect many file operations. For an overview, see “Permissions Granted” in Chapter 6.
Sharing your workspace

1 Start up Preferences and click the button for Expert Preferences.

2 Uncheck Private Window Server.

3 Log out and log back in.

Sometimes you may want to run an application on another computer but display the application’s windows on your computer. For example, if you have access to an application on the network that runs on only one kind of NEXTSTEP computer and you’re using a different kind, you can run the application on the appropriate kind of computer but display its windows and menus on your computer. To do this, you need to make your computer a public window server.

This option takes effect the next time you log in.

Caution: When you uncheck Private Window Server, other users on the network can start up applications from your workspace and read and write files with the same permissions you have whenever you’re logged into your computer.
Sharing your sound system

1. **Start up Preferences and click the button for Expert Preferences.**

2. **Uncheck Private Sound Server.**

3. **Log out and log back in.**

You can let other computers have access to the sound recording and playback features of your computer for intercom-like applications or simply for extra processing capability. When you grant this access, your computer becomes a *public sound server.*

![Diagram of Expert Preferences settings]

This option takes effect the next time you log in.

**Caution:** When you uncheck Private Sound Server, other users on the network can not only play sounds on your computer but also record, using your microphone or line-in jack.
Displaying PostScript images securely

1. Start up Preferences and click the button for Expert Preferences.

2. Check Protected EPS Display.

3. Log out and log back in.

Encapsulated PostScript (EPS) files are files that contain image descriptions in the PostScript language. Because PostScript is a programming language, the instructions in EPS files represent a possible hazard to your computer system. If you receive EPS files from lots of different sources—for example, as images in Mail messages from outside your company—you may want to use the option to display them securely.

When this option is checked, a special environment is created just for running the PostScript programs that display your EPS files. In this environment, the PostScript programs can't interact with other programs. Also, EPS files enclosed in Edit documents and Mail messages appear as EPS file icons instead of as images. You can double-click the EPS icons to view their contents securely.

This option takes effect the next time you log into your workspace.

For more information about PostScript files, see “What Is a PostScript File?” in Chapter 15.
Setting login window options

1. Log in as root.
2. Start up Preferences and click the Login Window Preferences button.
3. Select the preferences you want for how users log in and out of the computer.
4. Restart the computer.

If you’re the system administrator for a computer, you can set a number of security options for logging in and out and for turning off the computer. The Login Window Preferences are only available when you’re logged in as the superuser (root).

You can drag the Automatic Screen Saver slider to set the delay (in minutes) before the login window is replaced by a moving NeXT icon. Drag the slider all the way to the right to turn off the screen saver.

When you check Disable Power Off, the Restart and Power buttons are disabled in the login window, clicking Power Off in the Log Out panel logs you out instead, and the power key is disabled (on computers that have one).

Advanced Login Window Preferences

You can use the Set buttons to replace standard NEXTSTEP software with your own software for the following purposes:

- **Login Hook** A script or application that runs when anyone logs in.
- **Logout Hook** A script or application that runs when anyone logs out.

- **Custom Screen Saver** A program that runs in place of the NEXTSTEP screen saver after the delay you set in this window.
- **Custom Authenticator** A program that verifies who can log into the computer.
- **Custom Login UI** A program that replaces the NEXTSTEP login window.

For more information about the options in the Login Window Preferences and about NEXTSTEP security, see NEXTSTEP Network and System Administration.
Standard commands

These are standard commands that are common to most applications.

Main menu

Info Lists commands for getting information about the application and setting preferences. See the Info menu below.

Document Lists commands for opening, creating, and saving files. The name of this command depends on what you create and save in the application. See the Document menu below.

Edit Lists commands for editing text, graphics, or whatever you work with in the application. See the Edit menu below.

Format Lists commands for setting fonts, aligning text, choosing ruler settings, and changing page layout options. See the Format menu below.

Windows Lists commands for managing windows in the application. See the Windows menu below.

Services Lists commands that request the service of another application. See the Services menu below.

Print Opens a panel that you can use to print or fax the contents of the main window. See Chapter 15, “Printing,” and Chapter 16, “Sending Faxes.”

Hide Hides the application, removing all its windows from view without closing them. You can unhide the application by double-clicking its icon. See “Hiding an Application” in Chapter 4.

Quit Quits the application, closing all its windows and any files they contain. See “Quitting an Application” in Chapter 4.

Info menu

Info Panel Displays general information about an application, such as which version you’re using and who wrote it.

Help Opens a panel where you can get step-by-step instructions for using the application. See “Getting Help by Topic” in Chapter 1.

Document menu

Open Opens a panel you can use to open a file in the application. See “Opening an Existing File” in Chapter 5.

New Opens an empty window where you can create a file. See “Creating a File” in Chapter 5.

Save Saves changes you’ve made to the file you’re working in, or opens a panel that you can use to save a new file. See “Saving Changes” and “Saving a New File” in Chapter 5.

Save As, Save To These commands each open a panel that you can use to save a new version of the file you’re working in. See “Saving Another Version of a File” in Chapter 5.

Save All Saves changes in all files that are open in the application. See “Saving Changes” and “Saving a New File” in Chapter 5.

Revert to Saved Discards changes you’ve made to the current file since you last saved it.

Close Closes the main window. If the current file is displayed in more than one window, this command closes all its windows.
Edit menu

Cut  Removes the current selection and puts it on the pasteboard. See “Moving and Copying” in Chapter 9.

Copy  Makes a copy of the current selection and puts it on the pasteboard. See “Moving and Copying” in Chapter 9.

Paste  Inserts the contents of the pasteboard at the insertion point or in place of the current selection. See “Moving and Copying” in Chapter 9.

Delete  Deletes the current selection without putting it on the pasteboard. See “Deleting and Replacing” in Chapter 9.

Undo  Reverses your last editing operation, such as typing or choosing the Delete command. Choosing Undo again redoes the operation. Sometimes this command is called Undelete, and it reverses and redoes only a deletion.

Find  Lists commands for locating text. See the Find Menu below.

Link  Lists commands for working with linked information. See the Link menu below.

Spelling  Opens a panel where you can check the spelling in the document you’re working in. See “Checking Your Spelling” in Chapter 9.

Check Spelling  Finds and selects the next misspelled word in the main window. Choosing the Check Spelling command has the same effect as clicking Find Next in the Spelling panel.

Select All  Selects the entire contents of the window or the section of the window that you’re working in. This command selects not only what’s showing but also contents you can scroll to see.

Find menu

Find Panel  Opens a panel that you can use to search for text. See “Finding Text” in Chapter 9.

Find Next  Finds the next occurrence of the text in the Find field of the Find panel. This command does the same thing as the Next button in the Find panel. You can use this command even if the Find panel isn’t open. See “Finding Text” in Chapter 9.

Find Previous  Finds the previous occurrence of the text in the Find field of the Find panel. This command does the same thing as the Previous button in the Find panel. You can use this command even if the Find panel isn’t open. See “Finding Text” in Chapter 9.

Enter Selection  Copies selected text from the main window into the Find field of the Find panel, whether it’s open or not. You can then choose Find Next or Find Previous to search for the text.

Jump To Selection  Scrolls to display the insertion point or current selection in the main window.

Link menu

Paste and Link  Inserts the contents of the pasteboard at the insertion point and links it to the original. See “Adding Linked Graphics” in Chapter 11.

Paste Link Button  Inserts a diamond-shaped button in the document. The button is linked to the last thing you copied. See “Adding a Link Button” in Chapter 11.

Publish Selection  Opens a panel where you can create and name a file that is a link to the selection in the main window. See “Publishing an Image as a Link File” in Chapter 11.
**Show Links**  Highlights each link in a document window with a chain-link pattern. If links are already shown, the command changes to Hide Links and removes the highlighting.

**Link Inspector**  Opens a panel that you can use to update and get information about links. See “Editing and Updating Links” in Chapter 11.

### Format menu

**Font**  Lists commands for changing the appearance of text. See the Font menu below.

**Text**  Lists commands for aligning text and choosing ruler settings. See the Text menu below.

**Page Layout**  Opens a panel that you can use to choose basic page layout options for printing documents. See “Preparing a File for Printing” in Chapter 15.

### Font menu

**Font Panel**  Opens a panel that you can use to change the font of text or preview a font before using it. See “Setting a New Font” and “Previewing a Font” in Chapter 9.

**Bold**  Makes text bold. This command sets or removes the standard bold typeface for text you type at the insertion point or for selected text. If the current font is already bold, the command changes to Unbold and removes bold.

**Italic**  Makes text italic. This command sets or removes the standard italic typeface for text you type at the insertion point or for selected text. If the current font is already italic, the command changes to Unitalic and removes italic.

**Underline**  Underlines selected text or text you type at the insertion point. If text is already underlined, the command removes underlining.

**Superscript**  Moves selected text up slightly in relation to the baseline. You can choose the command again to move the text higher.

**Subscript**  Moves selected text down slightly in relation to the baseline. You can choose the command again to move the text lower.

**Unscript**  Returns superscripted or subscripted text to a normal position.

**Colors**  Opens a panel that you can use to change the color of text or graphics you’re working with. In some applications, this command is in the Tools menu. See Chapter 10, “Working with Color.”

**Copy Font**  Copies the font at the insertion point or at the beginning of the text selection so you can apply the font elsewhere with the Paste Font command. This command doesn’t copy text, so it doesn’t change the contents of the pasteboard.

**Paste Font**  Applies the font you copied with the Copy Font command to the selected text or text you type at the insertion point.

### Text menu

**Align Left**  Aligns text in a paragraph with the left margin, leaving the right margin ragged. This command aligns the paragraph where you last clicked or made a selection. If the selection spans more than one paragraph, all of them are aligned.

**Align Right**  Aligns text in a paragraph with the right margin, leaving the left margin ragged. This command aligns the paragraph where you last clicked or made a selection. If the selection spans more than one paragraph, all of them are aligned.
Center  Centers text in a paragraph between the left and right margins. This command centers the paragraph where you last clicked or made a selection. If the selection spans more than one paragraph, all of them are centered.

Show Ruler  Displays a ruler at the top of the document window you're working in. See “Setting Margins, Indentation, and Tabs” in Chapter 9.

Copy Ruler  Copies the ruler settings of the paragraph that begins the current selection or contains the insertion point. You can then apply the ruler settings to other paragraphs with the Paste Ruler command. The Copy Ruler command doesn't copy text, so it doesn't change the contents of the pasteboard. You don’t need to show the ruler to use Copy Ruler.

Paste Ruler  Applies ruler settings you copied with the Copy Ruler command to the paragraph that contains the insertion point or the current selection. If the selection spans more than one paragraph, ruler settings are applied to all of them.

Windows menu

The Windows menu lists the names of all standard windows that are open in the application. Choosing a name brings the window forward.

An X marks a window that contains no unsaved work. A partial X means the window contains unsaved work.

The Windows menu also lists these commands:

Arrange in Front  Neatly stacks all standard windows that are open in the application.

Miniaturize Window  Changes the key window to a miniwindow at the bottom of the screen, if the key window has a miniaturize button. See “Miniaturizing a Window” in Chapter 2.

Close Window  Closes the key window if it has a close button. See “Closing a Window” in Chapter 2.

Services menu

The exact commands in this menu depend on which applications you have. Services provided by NEXTSTEP applications are listed below. See also “Requesting the Service of Another Application” in Chapter 4, and “Customizing the Services Menu” in Chapter 20.

Define in Webster  Looks up the selected word or phrase in Digital Webster. See “Looking Up a Definition or Synonym” in Chapter 12.

Edit  Replace Selection  Provides a quick way to insert the contents of an Edit file in the document you're working in. When you choose this command, an Open panel appears in the Edit application. Opening a file from this panel inserts the contents of the file in your document at the insertion point or in place of the current selection.

Edit  Save Selection  Opens a new document window in the Edit application and inserts the current selection in the window. This command also opens a Save panel that you use to save the selection in an Edit file. See “Saving a New File” in Chapter 5.

Grab  Screen  Takes a picture of the whole screen and inserts it as a TIFF image in your document. See “Grabbing the Screen” in Chapter 11.
Grab [Selection] Turns the cursor into a right angle that you can use to select and grab a portion of the screen. This command then inserts the selection as a TIFF image in your document. See “Grabbing a Portion of the Screen” in Chapter 11.

Grab [Timed Screen] Takes a picture of the whole screen after giving you time to set things up as you want them. This command then inserts the picture as a TIFF image in your document. See “Grabbing the Screen with a Time Delay” in Chapter 11.

Grab [Window] Takes a picture of a window and inserts it as a TIFF image in your document. See “Grabbing a Window” in Chapter 11.

Librarian [Search in (Target)] Uses the Digital Librarian application to search the target named for files that contain the selected word or words. You must set up this service for each target you want to have available for searches. See “Setting Up a Search Service” in Chapter 12.

Librarian [Jot selection in (Target)] Uses the Digital Librarian application to insert the current selection in the target named. The selection is inserted as a file with a date and time stamp. You can use Digital Librarian to search the target by topic. You must set up this service for each target you want to jot information in. See “Setting Up a Jotting Service” in Chapter 12.

Librarian [Jot document in (Target)] Uses the Digital Librarian application to insert the current document—a file you’ve selected in the File Viewer or a Mail message, for example—in the target named. If the document is a named file, it’s inserted with its file name. If you jot a Mail message, it’s inserted in the target with a time and date stamp. You must set up this service for each target you want to jot information in. See “Setting Up a Jotting Service” in Chapter 12.

Librarian [Update Index] Updates the index for the current document if it’s included in a target on one of your bookshelves. You can use this command to maintain an up-to-date index of your documents as you work. The command may not be available in some applications.

Mail [Document] Opens a Compose window in Mail and inserts the current file in it as an attachment. The current file can be the one you’re working in or the file or folder selected in the File Viewer. For information on attachments, see “Attaching a File or Folder” in Chapter 13.

Mail [Selection] Opens a Compose window in Mail and inserts text you’ve selected in it. For more information, see “Sending a Message” in Chapter 13.

Open in Workspace Opens the file or folder with the selected pathname. See “Opening a Folder” and “Opening a File” in Chapter 3.
Workspace Manager commands

**Workspace menu**

**Info** Lists commands for getting information and setting preferences. See the Info menu below.

**File** Lists commands for working with files, folders, and on-line address books. See the File menu below.

**Edit** Lists standard editing commands. See the Edit menu below.

**Disk** Lists commands for working with disks. See the Disk menu below.

**View** Lists commands for changing the way you view the contents of folders. See the View menu below.

**Tools** Lists commands that open panels and windows you can use as tools in the Workspace Manager. See the Tools menu below.

**Windows** Lists commands for managing Workspace Manager windows. See the Windows menu in “Standard Commands” in this Reference.

**Services** Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.

**Hide** Hides the Workspace Manager application, removing its windows and menus from view. You can double-click the NeXT icon at the top of the dock to restore the windows and menus to view.

**Log Out** Quits all running applications. This command returns you to the login window or, if you don’t have to log in, to your workspace. You also use this command to turn off your computer. See “Ending Your Work Session” in Chapter 1.

**Info menu**

**Info Panel** Displays information about the Workspace Manager application and your system in general.

**Legal** Displays the Workspace Manager application’s copyright notice.

**Preferences** Opens a panel that you can use to personalize your workspace. You can set applications to start up automatically (see “Starting Up an Application Automatically” in Chapter 4); customize the arrangement of icons and columns in the File Viewer (see “Personalizing Your File Viewer” in Chapter 3); choose how disks appear (see “Creating a Folder Window for a Disk” in Chapter 8); and choose how links are copied (see “Setting Options for Copying Links” in Chapter 6).

You can also personalize the Finder. Choose the Finder option from this panel and check “Use Librarian indexes to search for files by content.” Then when you use the Finder to search for files by content, you can enter two or more words—such as *emily festival*—to find files that contain both words, even if they don’t appear together. To find a phrase or partial word, enclose it in quotation marks, as in “*emily festival*”. See also “Finding Files and Folders” in Chapter 3.

**Help** Opens a panel where you can get step-by-step instructions for using the Workspace Manager. See “Getting Help by Topic” in Chapter 1.
**File menu**

**Open** Opens the selected file or folder.

**Open as Folder** Opens the selected folder in a separate window or displays the contents of a file package. See “Opening a Folder in Its Own Window” in Chapter 3.

**New Folder** Creates an empty folder and puts it in the current folder. See “Creating a Folder” in Chapter 6. When you’re working in an address book, this command changes to New Address.

**Duplicate** Creates a copy of the selected file or folder and puts it in the current folder. The copy is labeled CopyOf. You can rename it. If you select more than one file or folder, Duplicate creates a copy of each one. When you’re working in an address book, the command changes to New Group.

**New Address** Adds a new address to the current address book. This command replaces the New Folder command when you’re working in an address book. See “Adding an On-Line Address” in Chapter 12.

**New Group** Creates a new group in the current address book. A group is a folder that contains one or more addresses. This command replaces the Duplicate command when you’re working in an address book. See “Adding an On-Line Address” in Chapter 12.

**Compress** Compresses the selected file or folder into a format that requires less space on the disk. When you select a compressed file or folder, the command changes to Decompress and it returns the selection to its original format. See “Compressing and Decompressing a File or Folder” in Chapter 6.

**Destroy** Permanently deletes one or more selected files or folders. A panel asks you to confirm the deletion or cancel it.

**Empty Recycler** Permanently deletes all files and folders in the recycler so you can’t retrieve them. Emptying the recycler frees disk space.

**Edit menu**

**Cut, Copy, Paste, Delete** These are standard commands for moving, copying, or deleting text. In the Workspace Manager, you can use these commands when renaming a file or folder or when typing in a panel. See “Moving and Copying” and “Deleting and Replacing” in Chapter 9.

**Select All** Selects the entire contents of the area of a window you’re working in. In the File Viewer, this command can select the contents of the current folder. If you’re editing a file or folder name, the name is selected. If you’re typing in a text field, text you’ve typed is selected. This command selects what’s showing as well as what you can scroll to see.

**Disk menu**

**Eject** Removes the contents of a floppy disk from your file system so you can safely eject the disk from its disk drive. See “Ejecting a Disk” in Chapter 8.

**Initialize** Opens a panel that you can use to erase a disk you want to reuse. You can also rename the disk and choose a format for storing files and folders. See “Reusing a Disk” in Chapter 8.

**Check for Disks** Detects any floppy disk you’ve inserted so it appears in the File Viewer. This command appears only if your computer needs it. See “Inserting a Floppy Disk” in Chapter 8.
**View menu**

**Browser** Changes the current view in the main window to the browser view. See “Browsing Files and Folders” in Chapter 3.

**Icon** Changes the current view in the main window to the icon view. The icon view is the standard view. It represents files and folders as icons. File and folder names appear under the icon.

**Listing** Changes the current view in the main window to the listing view. See “Listing Files and Folders” in Chapter 3.

**Sort Icons** Sorts the icons in the current folder according to the category you choose with the Inspector command. This command applies only to the icon view. See “Sorting Files and Folders” in Chapter 7.

**Clean Up Icons** Lines up icons in the current folder to remove empty spaces. This command applies only to the icon view.

**New Viewer** Opens a duplicate of your File Viewer. You can use multiple File Viewers to view different parts of your file system at the same time. Unlike your original File Viewer, the duplicate has a close button you can use to get rid of it.

**Update Viewers** Updates the contents of folder windows to include changes made elsewhere. This command can show the correct icon for files associated with a newly installed application, if the correct icon doesn’t appear automatically. Choosing Update Viewers gives the files their correct icon so they can open in the right application. Update Viewers can also show changes made to the file system with a UNIX command in the Terminal application. For example, if you change the permission of a file in Terminal, you may need to choose Update Viewers in order for the change to appear in the File Viewer.

**Tools menu**

**Inspector** Opens a panel where you can get information about the selected file or folder and specify some options for using it. See Chapter 7, “Inspecting Files and Folders.”

**Finder** Opens a window that you can use to find files and folders. See “Finding Files and Folders” in Chapter 3.

**Processes** Opens a panel where you can track and manage processes—such as copying a file—that are going on in the background. You can also use this panel to quit an application if you have a software problem. See “Managing Several File Operations” in Chapter 6 and “When the Quit Command Doesn’t Work” in Chapter 4.

**Console** Opens a special UNIX window that shows you the version of the system software you’re using and error messages or other status messages that may occur.
Digital Librarian commands

**Librarian menu**

**Info** Lists commands for getting information and setting preferences. See the Info menu below.

**Bookshelf** List commands for working with bookshelves. See the Bookshelf menu below.

**Target** Lists commands for working with targets on your bookshelf. See the Target menu below.

**File** Lists commands for opening files and folders that you find in searches. See the File menu below.

**Edit** Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

**Format** Lists standard commands for changing fonts and page layout options. See the Format menu in “Standard Commands” in this Reference.

**Windows** Lists the standard window management commands. See the Windows menu in “Standard Commands” in this Reference.

**Print** Opens a panel that you can use to print or fax a file you find. See Chapter 15, “Printing” and Chapter 16, “Sending Faxes.”

**Services** Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.

**Hide** Hides the Digital Librarian application, removing its windows and menus from view. You can double-click the Librarian icon in the dock to restore the windows and menus to view.

**Quit** Quits the Digital Librarian application, closing all its windows. If you haven’t saved changes in any window, a panel asks if you want to save before quitting.

**Info menu**

**Info Panel** Displays the version number, author, and copyright notice for the Digital Librarian application.

**Preferences** Opens a panel where you can choose which application opens the files you find. You can also choose to hide Librarian when you start it up automatically. See “Viewing Results” in Chapter 12 and “Starting Up an Application Automatically” in Chapter 4.
**Bookshelf menu**

**Open**  Opens a panel that you use to open a bookshelf. Your workspace comes with a bookshelf called Librarian.bshlf. You can create others. See “Creating a New Bookshelf” in Chapter 12.

**New**  Creates a new bookshelf where you can put targets and search for information. See “Creating a New Bookshelf” in Chapter 12.

**Save**  Saves changes to your bookshelf, including new targets that you’ve added and indexed.

**Save As**  Opens a panel that you can use to save a copy of a bookshelf with a new name.

**Revert to Saved**  Discards all the changes you’ve made to the bookshelf since you last saved it, including adding targets and indexing them.

**Close**  Closes the main window. If you haven’t saved changes in the window, Librarian asks if you want to save them before closing the window.

**Target menu**

**Inspector**  Opens a panel that you can use to index targets on your bookshelf, to sort the results of searches, to choose a search language, and to set up Services menu commands for searching and jotting information from other applications. See “Indexing Targets,” “Sorting Results,” “Choosing a Search Language,” “Setting Up a Search Service,” and “Setting Up a Jotting Service,” all in Chapter 12.

**Copyright**  Opens a panel that displays copyright information, if any, for the selected target.

**File menu**

**Open File**  Opens a file that you select from the list of results in a bookshelf window. The file opens in its standard application or in a Librarian window, depending on the option you set in the Librarian Preferences panel. See “Viewing Results” in Chapter 12.

**Open Folder**  Opens a Workspace Manager folder window for the file or folder that you select from the list of results in a bookshelf window. See “Viewing Results” in Chapter 12.
Digital Webster commands

**Webster menu**

- **Info** Lists commands for getting information about the application and for setting preferences. See the Info menu below.
- **Edit** Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.
- **Find** Lists commands for finding words in a dictionary definition or list of synonyms. See the Find menu below.
- **Page Layout** Opens a panel that you can use to prepare the contents of the Digital Webster window for printing. See “Preparing a File for Printing” in Chapter 15.
- **Print** Opens a panel where you can print or fax the contents of the Digital Webster window. See Chapter 15, “Printing” and Chapter 16, “Sending Faxes.”
- **Services** Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.
- **Hide** Hides the Digital Webster application, removing its windows and menus from view. You can double-click the Digital Webster icon to restore the windows and menus to view.
- **Quit** Quits the Digital Webster application, closing all its windows.

**Info menu**

- **Info Panel** Displays the version, author, and copyright notices for the Digital Webster application.
- **Pronunciation** Displays information about the pronunciation symbols used in definitions.
- **Preferences** Opens a panel where you can choose search options and set a font size for the contents of the Digital Webster window. See “Looking Up a Definition or Synonym” in Chapter 12.
- **Help** Opens a panel where you get information about using the on-line dictionary and thesaurus.

**Find Menu**

- **Find Panel** Opens a panel that you can use to search for text within a definition or list of synonyms. See “Finding Text” in Chapter 9.
- **Find Next** Finds the next occurrence of the word defined in the Digital Webster window or the next occurrence of text you type in the Find field of the Find panel. This command does the same thing as clicking the Find button in the Digital Webster window.
- **Find Previous** Finds the previous occurrence of the word defined in the Digital Webster window or the previous occurrence of text you type in the Find field of the Find panel.
- **Enter Selection** Copies selected text from the Digital Webster window into the Find field in the Find panel, whether or not the panel is open. You can then choose Find Next or Find Previous to search for the text.
Edit commands

These are the basic Edit application commands. For information on other commands that are available in developer mode, see NEXTSTEP Development Tools and Techniques.

Edit main menu

Info Lists commands for getting information and setting preferences. See the Info menu below.


Edit  Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

Format  Lists commands for setting fonts, aligning text, and changing page layout options. See the Format menu in “Standard Commands” in this Reference. See also the Text menu, below.

Windows  Lists commands for managing Edit windows. See the Windows menu in “Standard Commands” in this Reference.

Print  Opens a panel where you can print or fax an Edit document. See Chapter 15, “Printing,” and Chapter 16, “Sending Faxes.”

Services  Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.

Hide  Hides the Edit application, removing its windows and menus from view without closing them. You can double-click the Edit application icon to restore the windows and menus to view.

Quit  Quits the Edit application, putting all its windows away. If a document window contains unsaved changes, a panel asks if you want to save them before quitting.

Info menu

Info Panel, Help  These are the standard commands for getting information. See the Info menu in “Standard Commands” in this Reference.

Preferences  Opens a panel that you can use to personalize the Edit application. If you’re an application developer, you can choose to start up Edit in developer mode, which provides features for working with programming code. Just select the Developer Mode option.

You can also have new documents open as plain text files rather than RTF files. Select the Plain Text (ASCII) option. You can choose a default font for RTF or plain text files—that is, the font that appears when you first type in a document. Click the Set button for the type of file. Then set a font in the Font Panel. For plain text files, you must choose a fixed-width font family, such as Courier or Ohlfs. See “Setting a New Font” in Chapter 9.

Text menu

Align Left, Center, Align Right  These are the standard commands for aligning text. See the Text menu in “Standard Commands” in this Reference.

Show Ruler, Copy Ruler, Paste Ruler  These are the standard commands for making ruler settings in a document. See the Text menu in “Standard Commands” in this Reference.

Make ASCII  Changes the document you’re working in from RTF to plain text format. All formatting is lost, and text appears in a fixed-width font. When you choose this command, it changes to Make RTF. You can then choose the command again to set fonts and formatting in the document.
FaxReader commands

FaxReader menu

Info Lists commands for getting information and setting preferences. See the Info menu below.

Fax Lists commands for opening, saving, deleting, and assigning faxes. See the Fax menu below.

Fax Modem Opens a panel that lists available fax modems. See “Checking for Faxes” in Chapter 17.

Edit Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

Page Layout Opens a panel that you can use to prepare a fax for printing. See “Preparing a File for Printing” in Chapter 15.

Display Lists commands for displaying faxes in a fax window. See the Display menu below.

Windows menu Lists commands for managing FaxReader windows. See the Windows menu in “Standard Commands” in this Reference.

Print Opens a panel that you can use to print or fax the fax displayed in the fax window. See Chapter 15, “Printing,” and Chapter 16, “Sending Faxes.”

Services Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.

Hide Hides FaxReader, removing its windows and menus from view. You can double-click the FaxReader icon to restore the windows and menus.

Quit Quits the FaxReader application.

Info menu

Info Panel, Help These are the standard commands for getting information about the application. See the Info menu in “Standard Commands” in this Reference.

Preferences Opens a panel where you can choose options for displaying faxes when you first open them. You can display them at normal or double size. You can choose to trim oversize pages, divide them in two, or scale them to fit on a standard sheet of printer paper whose size you specify. You can also select a font size to use in the fax modem log.

Fax menu

Open Opens a panel that you can use to select and open a fax file you’ve saved as a file.

Save As Opens a panel that you can use to name and save a copy of a fax as a file. See “Saving a Fax” in Chapter 17.

Delete Deletes selected faxes from the list in the fax modem window you’re working in.

Assign Opens a panel that you can use to assign faxes to others. See “Managing New Faxes” in Chapter 17.

Assign to Me Assigns selected faxes to you.

Close Closes the window you’re working in if it has a close button.

Display menu

Inspector Opens a panel you can use to change how an individual fax is displayed. See “Changing How a Fax Is Displayed” in Chapter 17.

Page Forward Displays the next page in a fax.

Page Backward Displays the previous page in a fax.

Select Page Number Selects the page number in the fax window you’re working in. You can then type a new page number and press Return to display that page.
Grab commands

**Grab main menu**

*Info*  Lists commands for getting information about Grab and for turning Grab’s sound effects on and off. See the Info menu below.

*Document*  Lists commands for saving and closing windows that display grabbed screen images. See the Document menu in “Standard Commands” in this Reference.

*Edit menu*  Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

*Grab menu*  Lists commands for grabbing screen images and for selecting a cursor to include in the images you grab. See the Grab menu below.

*Inspector*  Opens a panel that displays information about an image you grabbed. See “Inspecting an Image You Grabbed” in Chapter 11.

*Windows*  Lists commands for managing Grab windows. See the Windows menu in “Standard Commands” in this Reference.

*Print*  Opens a panel that you can use to print or fax an image. See Chapter 15, “Printing,” and Chapter 16, “Sending Faxes.”

*Services*  Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.

*Hide*  Hides the Grab application, removing its windows and menus from view. You can double-click the Grab icon to restore the windows and menus to view.

*Quit*  Quits the Grab application, closing all its windows. If a window contains an unsaved image, a panel asks if you want to save it before quitting.

**Info menu**

*Info Panel*  Displays the version number, author, and copyright notice for the Grab application.

*Turn Sound Off*  Turns off the sound effects Grab uses when you grab a screen. If the sound effects are already turned off, the command changes to Turn Sound On, and you can choose it to turn the sound effects on again.

*Help*  Opens a window with information about the Grab application.

**Grab menu**

*Selection*  Changes the cursor to a right-angle, which you can use to select and grab a portion of the screen. See “Grabbing a Portion of the Screen” in Chapter 11.

*Window*  Provides an easy way to grab a window. See “Grabbing a Window” in Chapter 11.

*Screen*  Grabs the entire screen. See “Grabbing the Screen” in Chapter 11.

*Timed Screen*  Grabs the entire screen after a 10-second delay. The delay gives you time to arrange your workspace the way you want it in the image. See “Grabbing the Screen with a Time Delay” in Chapter 11.

*Choose Cursor*  Opens a panel you can use to choose the cursor you want to appear in the images of windows, screens, and timed screens you grab. See “If You Want to Grab the Cursor” in Chapter 11.
Installer commands

 Installer menu

Info  Lists commands for getting information about the Installer application and setting preferences. See the Info menu below.

Package  Lists standard commands for working with Installer packages. See the Document menu in “Standard Commands” in this Reference.

Edit  Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

Views  Lists commands for changing the view in package windows. See the Views menu below.

Windows  Lists standard window management commands. See the Windows menu in “Standard Commands” in this Reference.

Hide  Hides the Installer application, removing its windows and menus from view. You can double-click the Installer icon to restore the windows and menus to view.

Quit  Quits the Installer application, closing all its windows.

 Info menu

Info Panel  Displays the version number, author, and copyright notice for the Installer application.

Preferences  Opens a panel where you can select the view you switch to when you click a button in a package window. Or you can select not to switch views. You can select how much information to include when you list the contents of a package. You can also select what computer types are initially selected in the Install Package panel when you install a package—either just the type of computer you’re working on, or all types the software in the package can run on. Finally, you can select what languages are initially selected in the Install Package panel—just your language or all the languages included in the package.

 Views menu

Info  Displays information in the package window about the current package, including its name, status, size when installed and when compressed, version number, location, and a brief description.

Progress  Displays messages in the package window about the progress of the current operation or the most recently completed operation.

Log  Shows a record in the package window of each operation you’ve performed since you opened the package.
Mail buttons and commands

**Buttons in a mailbox window**

- **Up Arrow, Down Arrow** These buttons open the previous or next message listed in the summary area of a mailbox window. See “Opening Messages” in Chapter 13.
- **Delete** Deletes selected messages from a mailbox window. See “Deleting Messages” in Chapter 14.
- **Compose** Opens a window where you compose and deliver a message. See “Sending a Message” in Chapter 13.
- **Mailboxes** Opens a panel where you create and manage mailboxes. See “Organizing Messages in Mailboxes” in Chapter 14.
- **Find** Opens a panel that you can use to search for text in a message or messages in a mailbox. See “Finding Text” in Chapter 9 and “Finding a Message” and “Focusing On a Group of Messages” in Chapter 14.
- **Get Mail** Retrieves new messages and puts them in your Active mailbox. This button appears in place of Find if you retrieve messages manually. See “Tailoring How You Get New Messages” in Chapter 14.

**Buttons in a Compose window**

- **Deliver** Sends the message displayed in the Compose window to the recipients listed in the To and Cc fields. See “Sending a Message” in Chapter 13.
- **Lip Service** Opens a panel you use to listen to or send a recording. See “Listening to a Recording,” “Recording and Inserting Sound in a Message,” and “Editing Sound” in Chapter 13.
- **Addresses** Opens a panel with addresses of other people who are on your network or share your computer. You can also create your own address book and create group addresses. See “Looking Up Mail Addresses,” “Creating a Mail Address Book,” and “Creating Your Own Group Address,” in Chapter 14.
- **Reply, Reply All** Automatically enters addresses in your Compose window so you can quickly reply to the current message in your mailbox window. This button alternates between Reply and Reply All when you click it. See “Replying to a Message” in Chapter 13.
- **Forward** Copies the current message into your Compose window so you can quickly forward it to other addresses. See “Forwarding a Message” in Chapter 13.
- **No Receipt, Receipt** Gives you the option of receiving a notification message when your message has been read by each NEXTSTEP recipient. The button alternates between No Receipt and Receipt when you click it.
- **NeXT Mail, MIME Mail, Plain Text** Prepares a message for NEXTSTEP, MIME, or plain text format. The button switches between NeXT Mail, MIME Mail, and Plain Text when you click it. See “Sending a Message” and “Sending a MIME or Plain Text Message” in Chapter 13.
Mail menu

Info  Lists commands for getting information about Mail and setting preferences. See the Info menu below.

Mailbox  Lists commands for working with mailboxes. See the Mailbox menu below.

Message  Lists commands for working with individual messages. See the Message menu below.

Compose  Lists commands for sending messages. See the Compose menu below.

Edit  Lists the standard editing commands. See the Edit menu below.

Format  Lists standard commands for changing fonts, ruler settings, and page layout options. See the Format menu below.

Windows  Lists commands for managing Mail windows. See the Windows menu in “Standard Commands” in this Reference.

Print  Opens a panel you can use to print or fax a message. See Chapter 15, “Printing” and Chapter 16, “Sending Faxes.”

Services  Lists commands that request the services of other applications. See the Services menu below.

Hide  Hides the Mail application, removing its windows and menus from view. You can double-click the Mail icon in the dock to restore the windows and menus to view.

Quit  Quits the Mail application, putting all its windows away. If a Compose window contains an undelivered message, a panel asks if you want to deliver it.

Info menu

Info Panel, Help  These are standard commands for finding out about the Mail application. See the Info menu in “Standard Commands” in this Reference.

Preferences  Opens a panel where you can personalize the Mail application. You can receive messages automatically or retrieve them yourself, and you can get a sound announcement of new messages. See “Tailoring How You Get New Messages” and “Setting a Sound to Announce New Messages” in Chapter 14.

To have all your mailboxes display the total number of messages in them, choose General from the pop-up list at the top of the panel and check the Show Message Totals box.

To have all mailboxes display the size of each message and the total size of messages in the mailbox, check Show Message Sizes.

To open all mailboxes with dimmed summaries of deleted messages showing (messages deleted since you last compacted the mailbox), check Show Deleted Messages.

To type all plain text messages using a fixed-width font, such as Courier or Ohlfs, check Use Fixed Pitch Font for Plain Text.

If you’ve used the Workspace Manager to have Mail start up automatically, check the “Hide on Auto-Launch” box to have Mail start up hidden.

If you don’t want to see the number of unread messages displayed in the Mail icon, uncheck Show Unread Count in Icon.

You can also set preferences for sending messages and for developers and system administrators. See “Preferences for Messages You Send” and “Expert Preferences” in Chapter 14.
Mailbox menu

Mailboxes This command does the same thing as the Mailboxes button in a mailbox window. See “Buttons in a Mailbox Window” in this Reference.

Get New Mail Retrieves all new messages and puts them in your Active mailbox—just like the Get Mail button in a mailbox window. If you’ve used the Preferences command to retrieve messages manually, you must use this command to get messages. If you receive messages automatically, you can choose this command to speed up message retrieval. See “Tailoring How You Get New Messages” in Chapter 14.

Sorting menu

Sort by Date Sorts the messages in your mailbox window in the order in which they were sent. This order may differ from the order in which they were received.

Sort by Name Sorts the messages in your mailbox window alphabetically by sender, with uppercase letters preceding lowercase letters.

Sort by Number Sorts the messages in your mailbox window sequentially in the order in which they were received.

Sort by Size Sorts the messages in your mailbox window sequentially by size, listing the smallest message first.

Sort by Subject Sorts the messages in your mailbox window alphabetically by subject title. You can use this command to collect messages on a certain topic, for example, to delete them or move them to another mailbox.

Compact Permanently removes from the disk all messages you’ve deleted from the mailbox you’re working in. See “Compacting a Mailbox to Free Disk Space” in Chapter 14.
### Message menu

**Mark as Unread**  Marks the selected message in the mailbox window you’re working in with an unread symbol 📨. When you choose this command, it changes to Mark as Read and you can choose it again to remove the unread symbol from the message. See “Options for Showing Information about Messages” in Chapter 13.

**Show All Headers**  Displays all headers in the current message in the mailbox window you’re working in. When you choose Show All Headers, it changes to Show Filtered Headers and displays the original set of headers. See “Options for Showing Information about Messages” in Chapter 13.

**Undelete**  Undeletes the last message you deleted in the mailbox you’re working in. You can also select a dimmed summary of a deleted message and choose this command to undelete that message. See “Compacting a Mailbox to Free Disk Space” in Chapter 14.

**MIME**  Lists commands for working with messages in MIME format. See the MIME menu below.

**Decode Foreign Attachment**  Decodes any file encoded with the UNIX uuencode command that you receive in the current message in your mailbox window. This command opens a Workspace Manager folder window that contains a temporary copy of each file, which you can open in your workspace and copy elsewhere.

An encoded file appears as unintelligible text until you decode it. The Decode Foreign Attachment command decodes only files that were encoded with the UNIX uuencode command. If no such files are in the message, this command has no effect.

**Add Private User**  Adds the sender’s address from the current message in your mailbox window to the Private Users list in the Addresses panel, even if the panel isn’t open. See “Creating a Mail Address Book” in Chapter 14.

### MIME menu

Use these commands to work with messages in MIME format. See also “MIME Messages and Encoded Attachments” in Chapter 13.

**Show First Alternative**  Displays each part of the current MIME message in your mailbox window in its first available format, which is usually the plainest format. For example, it displays the plain text version of text rather than a formatted version. This command applies when parts of the message are included in multiple formats.

**Show Best Alternative**  Displays each part of the current MIME message in your mailbox window in the last format, which is usually the richest. For example, this command displays the formatted version of text rather than a plain text version.

Mail shows the “best” alternative of a MIME message when you first open it. You can choose this command after choosing Show First Alternative or Show All Alternatives to return to the “best” view.

**Show All Alternatives**  Displays all versions of each part of the current MIME message. If parts of the message are included in multiple formats, those parts may appear multiple times.

**Combine Messages**  Combines the pieces of a MIME message whose summaries are selected in your mailbox window into one message. Use this command when you receive a MIME message that’s been split into multiple messages to see the original message.
Compose menu

New, Reply, Reply All, Forward, Addresses, Lip Service, Deliver These commands do the same thing as the Compose, Reply, Reply All, Forward, Addresses, Lip Service and Deliver buttons in a Compose window. See “Buttons in a Compose Window” in this Reference.

Send Options Opens a panel where you can enter a long list of addresses, send a hidden copy of a message, reroute replies to a message you send, or archive a copy of a message you send. See “Options for Sending Messages” in Chapter 13.

Make ASCII Converts all text in the message area of a Compose window to plain text. If the message contains any graphic images, sound icons, or file or folder attachments, a panel asks you to confirm that you want them removed. The Make ASCII command doesn’t enforce a line length or change text to a fixed-width font, as does the Plain Text button in a Compose window. Use that button rather than Make ASCII to send a message to a computer that can display only plain text messages.

Drafts Lists commands for saving drafts of messages. See the Drafts menu below.

Drafts menu

Save in Drafts Saves the contents of your Compose window as a message in the Drafts mailbox. Mail creates this mailbox if it doesn’t already exist. Each time you save a draft of the same message, Mail saves another version of the message—it doesn’t replace the last version you saved. See “Saving a Draft” in Chapter 13.

Restore Draft Restores the last draft of a message you saved in the Drafts mailbox in a Compose window, so you can keep working in it. The command restores your addresses and subject, too. Or if a message is selected in the Drafts mailbox, this command restores that message, instead. See “Restoring a Draft” in Chapter 13.
Edit menu

Cut, Copy, Paste These are standard commands that you can use to move or copy text, graphic images, icons, or segments of a waveform in the Lip Service panel. You can also use these commands to move or copy messages from one mailbox to another by selecting the messages in one mailbox window and choosing Cut or Copy. Then you can click in the summary area of another mailbox window and choose Paste. See the Edit menu in “Standard Commands” in this Reference.

Delete Deletes the current selection. In a Compose window, you can use the Delete command to delete text, graphic images, icons, or segments of a waveform in the Lip Service panel. In a mailbox window, the Delete command deletes selected messages—just like the Delete button in the window.

Undo Restores the last text you deleted from the message in a Compose window. Repeated use of Undo inserts copies of the last deleted text. Undo doesn’t reverse any other editing actions.

Find Lists commands for locating text and messages. See the Find menu below.

Spelling, Check Spelling These are standard commands you can use to check spelling in a message in a Compose window. See the Edit menu in “Standard Commands” in this Reference.

Select All Selects the entire contents of the last area you clicked in. This can be the summary area of a mailbox window, a message in a mailbox or Compose window, a text field, or a waveform in the Lip Service panel.

Find menu

Find Panel Opens a panel you can use to find text in a message and find messages in a mailbox. See “Finding Text” in Chapter 9 and “Finding a Message” and “Focusing On a Group of Messages” in Chapter 14.

Find Next, Find Previous, Enter Selection These are standard commands you can use to find text in a message or in a summary area of a mailbox. See the Find menu in “Standard Commands” in this Reference.

Format menu

Font Lists the standard Font menu commands. See the Font menu below.

Text Lists commands you can use to align text in a message. See “Standard Commands” in this Reference.

Page Layout Opens a panel where you can define how a message looks on the printed page. See “Preparing a File for Printing” in Chapter 15.
Font menu

Font Panel Opens the standard panel for setting and previewing fonts. In a Compose window, settings in the Font Panel apply to text you type or select in a message. In a mailbox window, they apply to all the text in the summary area or all the text in the message area—wherever you clicked last. The font you set in the message area of a mailbox window also becomes the font you get automatically in Compose windows. See “Setting a New Font” and “Previewing a Font” in Chapter 9.

Bold, Italic These are the standard Font menu commands for changing the typeface of text. In a Compose window, these commands apply to text you type or select in a message. In a mailbox window, they apply to all text in the summary area, or all text in the message area—wherever you clicked last. See the Font menu in “Standard Commands” in this Reference.

Underline Adds or removes underlining from selected text or text you’re about to type. The Underline command works only in a message you’re composing.

Superscript, Subscript, Unscript These are the standard commands for moving selected text up or down in relation to the baseline, and for returning it to normal. These commands work only in a message you’re composing.

Colors Opens a panel you can use to set the color of text in a message you’re composing. See Chapter 10, “Working with Color.”

Copy Font, Paste Font These are standard commands for copying the font of selected text and applying it to other text. See the Font menu in “Standard Commands” in this Reference.

Text menu

This menu lists the standard commands for aligning text in a message. You can use these commands in a message you’re composing or one opened in a mailbox window. See the Text menu in “Standard Commands” in this Reference.

Services menu

This menu lists the standard commands that request services from other applications. (See the Services menu in “Standard Commands” in this Reference.) In addition, it lists two commands that are available only in the Mail application.

Edit ► Open Message Provides a quick way to insert the contents of an Edit file into a message you’re composing. When you choose this command, an Open panel appears in the Edit application. Opening a file from this panel inserts the contents of the file into a Compose window.

Edit ► Save Message Opens a new document window in the Edit application and inserts the current message in the window. This command also opens a Save panel that you use to save the message in an Edit file. For more information, see “Saving a New File” in Chapter 5.
Preferences buttons and commands

Preferences buttons

Localization Preferences Displays options for choosing an application language, specifying a keyboard arrangement, and setting default units of measure and paper size. See “Working in Your Own Language” and “Choosing Units of Measure and Paper Size” in Chapter 20. See also “Selecting a Keyboard Arrangement” in Chapter 21.

Date & Time Preferences Displays options for setting the date and time, changing time zones, and choosing a display for the date and time. Or if you work on a network, this button may display an option to synchronize your clock with the network clock. See “Setting the Date” and “Setting the Time” in Chapter 20.

Password Preferences Displays options for setting a new password or changing your current password. See “Setting a Password” in Chapter 22.

Keyboard Preferences Displays options for setting and testing the responsiveness of the keyboard for repeating characters. See “Setting the Rate for Repeating Characters” in Chapter 21.

Mouse Preferences Displays options for setting the responsiveness of the mouse. You can also choose a mouse button to display hidden menus. See “Changing the Responsiveness of the Mouse” in Chapter 21 and “Hiding Menus” in Chapter 20.

Display Preferences Displays options for setting the delay for the automatic screen dimmer. You can also adjust the brightness of the screen and choose a background color. See “Setting the Automatic Screen Dimmer” and “Changing the Background Color of the Display” in Chapter 21.

Sound Preferences Displays options for adjusting the volume and balance of your speakers or line-out jack and the sensitivity (“gain”) and balance of your microphone or line-in jack. You can also select a system beep, choose visual warnings, and request voice alerts. See “Adjusting Volume and Input Gain” and “Selecting System Beeps and Warnings” in Chapter 21.

Font Preferences Displays options for choosing the fonts that appear on the screen and in applications. See “Changing the Fonts on the Screen” and “Selecting a Font for Applications” in Chapter 20.

Menu Preferences Displays options for hiding your menus, choosing a standard location for menus, and creating your own Command-key equivalents. See “Hiding Menus” and “Creating Command-Key Equivalents” in Chapter 20.

Services Preferences Displays options for you to choose the services you want to appear in the Services menu for all applications. See “Customizing the Services Menu” in Chapter 20.
**Expert Preferences** Displays options for displaying large file systems and UNIX files. You can also set options for controlling access to new files and folders, to your workspace, to your sound system, and to the programs that display PostScript images on your screen. See “Displaying Large File Systems” and “Displaying UNIX Files” in Chapter 20. See also “Sharing Your Workspace,” “Sharing Your Sound System,” and “Displaying PostScript Images Securely” in Chapter 22.

**Login Window Preferences** Displays security options for logging in and out and for turning off the computer. You can also set programs to run in place of default NEXTSTEP software. This button appears in Preferences only when you’re logged in as root. See “Setting Login Window Options” in Chapter 22.

**Startup Preferences** Displays an option for setting a time and date for your computer to turn on automatically. This panel also has an option for having the computer turn on automatically after a power failure. This button appears in Preferences only if your computer supports these options. See “Setting the Computer to Turn On Automatically” in Chapter 21.

**Power Management Preferences** Displays an option for decreasing the amount of power required to run NEXTSTEP in exchange for an occasional reduction in performance. You can also check the battery charge level. This button appears in Preferences only if your computer supports Advanced Power Management (APM). See “Managing Power Consumption” in Chapter 21.

**Preferences menu**

**Info** Lists standard commands for getting information about the application. See the Info menu in “Standard Commands” in this Reference.

**Edit** Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

**Windows** Lists standard window management commands. See the Windows menu in “Standard Commands” in this Reference.

**Hide** Hides the Preferences application, removing its windows and menus from view. You can double-click the Preferences icon in the dock to restore the windows and menus to view.

**Quit** Quits the Preferences application, closing all its windows and panels.
Preview commands

**Preview menu**

- **Info** Lists commands for getting information about Preview. See the Info menu below.

- **File** Lists commands for opening and saving graphic files. See the Document menu in “Standard Commands” in this Reference. See also “Previewing Pages” and “Previewing Graphic Images” in Chapter 11.

- **Edit** Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

- **Format** Lists the Page Layout command. See the Format menu in “Standard Commands” in this Reference.

- **Display** Lists commands for switching pages in multiple-page files and for changing the way the current page is displayed in the window. See the Display menu below.

- **Windows** Lists commands for managing Preview windows. See the Windows menu in “Standard Commands” in this Reference.

- **Print** Opens a panel where you can print the image in the main window or fax it. See “Printing a File” in Chapter 15 and “Sending a Fax” in Chapter 16.

- **Services** Lists commands that request the services of other applications. See the Services menu in “Standard Commands” in this Reference.

- **Hide** Hides the Preview application, removing all its windows and menus from view without closing them. You can double-click the Preview application icon to restore the windows and menus to view.

- **Quit** Quits the Preview application, putting all its windows away.

**Info menu**

- **Info Panel** Displays the version number, author, and copyright notice for the Preview application.

- **Help** Opens a window with information about the Preview application.

**Display menu**

- **Page Backward** Displays the previous page in a page-oriented PostScript file.

- **Draw Page** Redraws the page in the main window.

- **Page Forward** Displays the next page in a page-oriented PostScript file.

- **Cancel** Stops Preview from drawing or redrawing the image in the main window. This command is useful when the image is very complicated and takes a long time to display.

- **Zoom In** Increases the magnification of the image in the main window.

- **Zoom Out** Decreases the magnification of the image in the main window.

- **Disable Image Caching** Changes the method Preview uses to redraw pages. If image caching is already turned off, the command changes to Enable Image Caching, and you can choose it to switch Preview back to the original drawing method.
PrintManager buttons and commands

Printers window buttons

Queue Opens a window where you can view and manage the queue for a printer. See “Checking the Print Queue” and “Managing the Print Queue” in Chapter 15.

Create Opens a panel that you can use to add a new printer. See Chapter 18, “Managing Printers and Fax Modems.”

Modify Opens a panel where you can change settings for a printer. See Chapter 18, “Managing Printers and Fax Modems.”

Test Prints a test page on the printer selected in the Printers window. See “Testing a Printer” in Chapter 18.

Fax Modems window buttons

Queue Opens a window where you can view and manage the queue for a fax modem. See “Managing the Fax Queue” in Chapter 16.

Create Opens a panel that you can use to add a new fax modem. See Chapter 18, “Managing Printers and Fax Modems.”

Modify Opens a panel that you can use to change the settings for a fax modem. See Chapter 18, “Managing Printers and Fax Modems.”

PrintManager menu

Info Displays the version number, author, and copyright notice for the PrintManager application.

Printers Opens the Printers window, which lists available printers. See Chapter 18, “Managing Printers and Fax Modems.”

Fax Modems Opens the Fax Modems window, which lists available fax modems. See Chapter 18, “Managing Printers and Fax Modems.”

Edit Lists standard editing commands. See the Edit menu in “Standard Commands” in this Reference.

Windows Lists commands for managing PrintManager windows. See the Windows menu in “Standard Commands” in this Reference.

Hide Hides the PrintManager application, removing all its windows and menus from view. You can double-click the PrintManager icon to restore the windows and menus to view.

Quit Quits the PrintManager application, putting all its windows away.
Special characters

The diagram below shows the characters you can use when you type in any of the standard font families, such as Times or Helvetica.

The green characters = belong to the Symbol font family. You can use the Alternate key to get these characters without having to change to the Symbol family.

The characters with gray shading above or below them are accent marks. To type an accented character, type the accent, then type the character.

To make sure that two or more words fall on the same line, you can put a nonbreaking space between them—hold down the Alternate key as you press the space bar.

To find out which is your keyboard’s Alternate key, see “Keyboard Basics” in Chapter 9.

Notice that the Alternate and Shift keys don’t have the same effect with keys on the keypad as they do with the equivalent characters on the main part of the keyboard.
Symbol font characters

This diagram shows the characters that are available in the Symbol font family. The Symbol family contains scientific and mathematical symbols and letters from the Greek alphabet.

Notice that the Alternate and Shift keys don’t have the same effect with keys on the keypad as they do with the equivalent characters on the main part of the keyboard.
DOS and Macintosh files

You can work with files in a DOS or Macintosh file system, or you can copy the files to your NEXTSTEP file system. A DOS file system can be on a NetWare network or a floppy disk in DOS format. A Macintosh file system can be on a disk in Macintosh format.

You work with DOS and Macintosh files much as you work with your NEXTSTEP files. You may want to be aware of a few differences, which are as follows.

**File and folder names**

When you copy a DOS or Macintosh file to your NEXTSTEP file system, make sure the file has the appropriate extension before you try to open it. In some cases, you might have to change the extension or even add one to open the file in the application you want.

File and folder names in DOS file systems are limited to 8 characters plus a 3-character extension. Also, you can’t use periods in DOS file names except to mark the extension, as in jazznote.str. Before you copy a file or folder to a DOS file system, make sure its name conforms to these rules.

File and folder names in Macintosh file systems are limited to 31 characters and may not contain a colon.

A few characters in your NEXTSTEP file system correspond to different characters in other file systems. Some file or folder names may therefore appear slightly different as you move them from one file system to another.

For information on changing names or extensions, see “Renaming a File or Folder” in Chapter 6.

**Plain text files**

Each file system has its own conventions for ending lines in plain text files. So when you copy plain text files from a DOS or Macintosh file system to your NEXTSTEP file system, you might find unexpected lines between paragraphs, no lines between paragraphs, or unfamiliar characters. The conventions for ending lines are shown here:

<table>
<thead>
<tr>
<th>File System</th>
<th>Convention</th>
<th>ASCII character</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEXTSTEP</td>
<td>Linefeed</td>
<td>LF</td>
</tr>
<tr>
<td>Macintosh</td>
<td>Return</td>
<td>CR</td>
</tr>
<tr>
<td>DOS</td>
<td>Return and Linefeed</td>
<td>CR and LF</td>
</tr>
</tbody>
</table>

You can edit a file to fix line spacing and delete extra characters.

**RTF files**

When you copy an RTF file from a Macintosh or DOS file system, a few characters in the file might not be the same in the NEXTSTEP file system. The NEXTSTEP file system supports most of the characters from other file systems, but it might change a few.

If you copy an RTF file from the NEXTSTEP file system to one of these other file systems, non-ASCII characters may not appear at all.
Macintosh files and resource forks

You can work in a Macintosh file while it's in its own file system—that is, on a disk in Macintosh format. You can also copy the file to your NEXTSTEP file system. However, when you move a file from a Macintosh file system, the file's Finder and resource fork information—special parts of the file that are used only by the Macintosh—aren't copied.

The Finder information determines which application starts up when you open the file. So if you copy a Macintosh file to a NEXTSTEP computer and then copy it back, you need to open it from within the appropriate application and save it to restore this information.

Most data files don't use the resource fork, so you don't usually need to worry about this information when you transfer data files from a Macintosh system to a NEXTSTEP system. If you know that you need the resource fork information, you can get it by adding the extension .#rsrc# to the file name in the Macintosh file system and opening the file from your NEXTSTEP File Viewer before you move it into your own file system.

Attributes and permissions

In general, attributes of a DOS or Macintosh file or folder, such as its size and the date it was last changed, apply in your NEXTSTEP file system just as in the original file system. You can find this information with the Inspector command in the Workspace Manager's Tools menu. (See “Getting Information about a File or Folder” in Chapter 7.)

Ownership and permissions differ in some ways from system to system. Here's a summary.

Ownership of files on removable disks Files and folders on DOS and Macintosh disks are owned by the person using the computer.

Ownership of files on networks On DOS files systems on NetWare networks, files and folders appear to be owned by the NEXTSTEP user. However, they are actually owned by a NetWare account on the server. Your ability to work with these files depends on how you logged in to the server. See your system administrator for details.

Permissions for files on disks Anyone can read all files and folders on a Macintosh or DOS disk. You can't change Macintosh files that are locked or DOS files that are marked read only. But anyone can change any other file on a Macintosh or DOS disk. Hidden files on such disks are displayed the same as normal files. You can't use a NEXTSTEP computer to change permissions for files and folders on a Macintosh or DOS disk.

Permissions for files on NetWare networks On NetWare networks, file and folder permissions and the ability to change them depend on the rights assigned to the files and folders by the NetWare system administrator. See your system administrator if you need help with the permissions on NetWare networks.
Glossary

**active application**  The application that you’re currently working in. It’s the only application with any menus showing. The key window belongs to it.

**application**  A program with a graphical user interface that you can start up from the workspace, such as Edit, FaxReader, or Preferences.

**application dock (or dock)**  A column along the right edge of the screen that contains application icons you can use to start up applications. The dock also contains the recycler.

**arrow keys**  Four keys, labeled with arrows, that cause movement (usually of the insertion point) in the indicated direction.

**ASCII characters**  A standard set of the characters that can be used in plain text files.

**attention panel**  A panel where you must perform an action before you can continue to work in an application. An attention panel can’t be covered by any other window or icon.

**Backspace key**  A key used to remove individual characters, words, graphics, or other items.

**bookshelf**  A collection of targets in a digital library. Digital Librarian searches the targets you select in a bookshelf.

**brightness keys**  Two keys in the NeXTUSA keyboard arrangement that control the brightness of the screen. The upper key increases the brightness, the lower key decreases it.

**browser**  A multiple-column area of a window in which you can browse through hierarchically organized information by clicking names in the columns.

**busy cursor**  A spinning disk that means the application you’re working in is busy. You have to wait or switch to another application.

**button**  A graphic object that you click to make something happen or press for a continuous action. Buttons are labeled with text, graphics, or both.

**byte**  A unit of information in the computer. In a plain text file, for example, each character occupies one byte.

**CD-ROM**  Compact Disk Read-Only Memory, which is a removable disk that is physically identical to an audio CD but holds computer files.

**click**  To position the cursor on something and, without moving the mouse, quickly press and release a mouse button. See also double-click.

**close**  To make a window disappear from the workspace when you’re done using it. When you close a window, you usually have a chance to save changes first.

**close button**  A button in a window’s title bar that, when clicked, closes the window. When the close button is partially drawn, it means that the window contains unsaved changes or that its contents aren’t up to date.

**CMYK color model**  A method of specifying colors by simulating a mix of cyan, magenta, yellow, and black inks.

**command**  A word or phrase in a menu that describes something you can do or a panel that you can open in an application.

**Command-key equivalent**  A combination of keys, including the Command key, that you can use instead of the mouse for choosing a command.
**current folder** The folder that you’re currently working in. If you’re working in a file, the current folder is the one that contains that file. In the File Viewer, the current folder is usually the rightmost folder in the icon path.

**current font** The font of either the text you’re about to type at the insertion point or the first character in the selected text.

**current message** The message that’s currently open in a mailbox window in the Mail application.

**cursor** The image on the screen that moves as you move the mouse. It’s usually an arrow.

**depth** A measure of how much color information there is for each pixel in an image.

**detach** To drag a submenu away from its associated menu.

**digital library** An on-line collection of information—such as reference works, documentation, and literature—that you can access with the Digital Librarian application. See also bookshelf.

**dimmed** Gray, faded, or otherwise made to recede into the background. You can’t choose a command or operate a button when it’s dimmed.

**disk** A magnetic medium on which the computer stores information. See also floppy disk and hard disk drive.

**dock** See application dock.

**dot file** A file or folder whose name begins with a period and that typically contains information you don’t need to access. Dot files are normally hidden from view in the File Viewer and folder windows.

**double-click** To click an object twice in quick succession. A double-click often extends the action of a click. See also click.

**drag** To press and hold down a mouse button, move the cursor by sliding the mouse, and then release the mouse button.

**EPS** Encapsulated PostScript, which is a standard format for storing graphics.

**Ethernet** An industry-standard physical medium for transmitting network signals between computers.

**extension** The last period in a file name and all characters that follow. A file’s extension indicates the type of information in it and the applications that can open it.

**fax modem** A device that you can connect to your computer or network so that you can receive and send faxes from your workspace.

**file** A collection of related information stored on a disk, such as a document, graphic image, or application.

**file package** A special folder containing files that aren’t normally shown in folder windows. Instead, a file package looks and behaves like a file (when you open it by double-clicking, for example).

**file system** The collection of all the files you can access through your computer. See also hierarchical file system.

**File Viewer** A Workspace Manager window that you can use to view and open the files in your file system.

**floppy disk** A plastic disk, encased in a protective cartridge, that holds information you can access with a floppy disk drive.
**floppy disk drive** A mechanism that can store and retrieve information on a floppy disk.

**folder** A place in the file system that contains files and other folders. Opening a folder displays the names of the files and folders it contains.

**folder window** A Workspace Manager window that displays the contents of one or more folders and that you use to locate, open, and organize files.

**font** A set of properties that describe the appearance of text: font family (such as Times), typeface (such as bold or italic), and size (in points). See also point.

**font family** A collection of characters with a consistent design, such as Helvetica and Times.

**group** A class of users for whom permissions are assigned for a file or folder. A group is set up by a system administrator.

**group address** A shorthand address used in the Mail application to identify a single user or a group of users.

**hanging indent** First-line indentation to the left of the subsequent lines of a paragraph. A hanging indent is useful for bulleted or numbered items.

**hard disk drive** A device that can store and retrieve information from metal disks permanently encased within it. A hard disk drive is usually installed inside your computer.

**hide** To temporarily remove the windows of a running application from view.

**hierarchical file system** A file system in which folders can contain other folders. See also folder.

**highlight** To make something—such as a command, text, icon, or title bar—stand out visually. Highlighting usually indicates that something has been chosen to perform an action or selected to receive an action.

**home folder** Your home base in the file system. Your home folder holds your personal files. Its name is the same as your user name.

**host name** The name by which a computer on a network is known to the other computers on the network. The host name is assigned by the system administrator. It appears as the name of your root folder.

**HSB color model** A method of specifying colors by adjusting hue, saturation, and brightness. See also hue and saturation.

**hue** The quality of a color that distinguishes its class, such as red, green, or blue.

**icon** A small pictorial representation of an application, file, folder, disk, or other item.

**icon path** An area in the File Viewer that displays the selected file or folder and the folders along its branch of the file system hierarchy.

**initialize** To prepare a disk so it can hold information. When you initialize a disk, any information already on it is destroyed.

**insertion point** The place where text and graphics may be entered, usually represented by a blinking vertical bar.

**justify** To adjust all the lines of a paragraph (except the last line) so that they’re aligned with both the left and the right margins.
key window  The standard window or panel that currently receives keystrokes. Its title bar is highlighted in black. You make a window the key window by clicking in it.

kilobyte  A unit of measurement equal to 1024 bytes. See also byte.

link  A special file that looks and acts like an ordinary file or folder. When you open it, however, you actually access the contents of a file or folder that’s somewhere else in the file system.

log in  To gain access to a computer by providing a user name and a password.

log out  To quit all running applications and (if you had to log in to use the computer) return to the login window.

Mail address book  A list of Mail addresses that you can compile in the Private Users list in the Mail application’s Addresses panel. See also on-line address book.

mailbox  A file package (in the Mailboxes folder in your home folder) in which the Mail application stores messages. Everyone has an Active mailbox where all incoming messages are delivered.

main menu  The menu that appears in your workspace when an application is active. Its title bar displays the application’s name (or an abbreviation).

main window  The standard window that you’re currently working in. If it’s not also the key window, it has a dark gray title bar. Actions you perform in a panel usually apply to the main window.

menu  A list of commands.

MIME  Multipurpose Internet Mail Extensions. MIME is an Internet standard that people using different kinds of computers can use to exchange formatted images, sound, files, folders, and even video attachments.

miniaturize button  A button in a window’s title bar that, when clicked, shrinks the window into a miniwindow.

miniwindow  An icon that represents a miniaturized window.

mouse buttons  The two buttons on the mouse that you use for clicking and dragging.

network  Two or more computers connected electronically so that people using them can share files and devices (such as printers and fax modems), and exchange electronic mail. See also server.

nonbreaking space  A space you can type between words so that they’ll always be on the same line. You type a nonbreaking space by holding down the Alternate key and pressing the space bar.

on-line address book  A tool available in the Workspace Manager and FaxReader applications. You can create and maintain multiple on-line address books to save and look up information about people on your network or business and personal contacts.

open  To display a window in your workspace. Opening a file or folder displays a window with the contents of the file or folder.

owner  The person (represented by a user name) who created a file or folder. The owner may also be a class of users for whom permissions are assigned for a file or folder.
panel A window that typically appears in response to a command and that you use to control what the application does or to get information about the application.

password A secret sequence of characters that you must enter along with your user name when logging in. It can consist of three or more letters, numbers, symbols, and spaces.

pasteboard The place where the computer stores what you last cut or copied with the Cut or Copy command.

pathname A name—or a sequence of names separated by slashes (/)—that specifies a file or folder in the file system.

permissions Characteristics of a file or folder that determine what certain users can do with the file or folder—for example, whether they can view a file’s contents or remove a file from a folder.

pixel The smallest unit of light on a computer’s screen.

plain text A data format consisting solely of characters from the ASCII character set. These include text characters (with no font properties) and control characters.

point A unit of measurement equal to 1/72 of an inch.

pop-up list A list of options that you can choose from. You open the list by pressing a button with a on it.

press To position the cursor on something and, without moving the mouse, hold down a mouse button and keep it down until the desired effect is achieved.

program A set of coded instructions that a computer follows to perform a specific task.

public sound server A NEXTSTEP computer whose sound recording and playback features can be accessed by other computers on a network.

public window server A NEXTSTEP computer that can display the windows of an application that’s running on another computer on a network.

pull-down list A list of commands that you can choose from to cause an action. You open the list by pressing a button with a on it.

read-only A file that has read permission, but not write or execute permission, for one or more classes of users. Those users can see the file’s contents, but they can’t save changes to it.

read permission A characteristic of a file or folder that allows certain users to view its contents. See also permissions.

recycler An icon that you use to delete files and folders from the file system. It’s either in the dock or at the lower left of the screen.

resize bar The narrow strip at the bottom of a window that you can drag to change the size of the window.

resolution The number of dots per inch of images on a computer screen or in printed output. The higher the resolution, the clearer the image.

Return key A key used to start a new line or paragraph. You can also press Return to operate a button with a on it.

RGB color model A method of specifying colors by blending red, green, and blue lights.
root folder  The folder at the top of the file system hierarchy. This folder is represented by a slash (/). It's physically located on the startup disk.

RTF  Rich Text Format, a standard text format that includes font and formatting properties. See also plain text.

ruler  The numerical scale you can use to change the format of a paragraph (for example, its indentation and tab stops).

saturation  The intensity of a color—how much of a particular hue is in the color. See also hue.

save  To store information on a computer's disk.

scroll  To move the information in a window or section of a window when there's more than can be displayed at one time, so that a different part of the information is visible.

scroll button  A button, usually in a scroller, that you click or press to scroll by small increments. You can Alternate-click a scroll button to scroll by a windowful.

scroll knob  A box in a scroller that moves as you scroll and that you can drag to scroll. Its length varies to indicate how much of the scrollable contents are currently displayed, and its position indicates what part of the contents are displayed.

scroller  A dark gray vertical or horizontal bar that contains a scroll knob and scroll buttons. Scrollers appear along the left side or bottom of an area that you can scroll through.

server  A computer on a network that contains files and folders that many people on the network can use.

shelf  An area at the top of the File Viewer where you can keep files and folders that you access frequently.

Shift key  The key used to produce the uppercase letters on letter keys and the upper character on keys labeled with two characters.

slider  A control that lets you set a value in a range by dragging a knob within a bar.

standard window  A window where you do the primary work of an application.

startup disk  The disk that contains the system files that your computer needs in order to operate. It's usually a hard disk inside your computer.

submenu  A menu that's opened by a command in another menu.

system administrator  The person who sets up and maintains a computer network or a computer used by more than one person.

system files  Files that the computer needs in order to operate and that must be loaded into the computer after it's turned on.

Tab key  A key used to move to the next stopping point in a sequence, such as a tab stop in a document or a text field in a panel.

text field  A box where you can enter text. A text field is usually labeled with text that identifies what information should go in it.

TIFF  Tag Image File Format, a standard format for storing graphics.

title bar  The bar at the top of a window that contains its title and possibly buttons for manipulating the window. It's highlighted in black if it's the key window or in dark gray if it's the main window but not the key window.
**typeface**  A variation of a font family, such as Bold, Italic, or Bold Italic.

**user name**  The name by which the computer identifies you. This is the name you log in with, the name used to identify you as the owner of files and folders, and the name of your home folder.

**volume keys**  Two keys in the NeXTUSA keyboard arrangement that control the volume of your computer speaker. The upper key increases the volume, the lower key decreases it.

**window**  A rectangular area in which information is presented on the screen. See standard window and panel.

**word**  Any sequence of characters between spaces or punctuation marks. You can select a word by double-clicking it.

**word wrap**  The automatic breaking of lines between words. With word wrap, you can type without having to press Return to end each line.

**workspace**  The screen environment in which you do your work on a NEXTSTEP computer.

**write permission**  A characteristic of a file or folder that allows certain users to change its contents. See also permissions.
良心标记，录入 130, 362
访问
- 到传真 modem，设置 281
- 到传真 255
- 到文件和文件夹 80
- 到计算机，控制 327-334
活动应用 57
Active mailbox 194
删除 220
Add Private User command 354
address See Mail address, on-line address，或 fax address
地址 book
Mail，创建 218
on-line 188-189
icon for 38
- 选择一个传真地址从 245
- 更新为传真 251
See also Mail address, on-line address，或 fax address
Addresses button 351
Addresses command 355
Advanced Power Management 324
Align Left command 338
Align Right command 338
alpha 169
Alternate key
NeXTUSA 键盘 arrangement 317
USA 键盘 arrangement 124
application dock 8, 37
covering 60
customizing 60-61
removing from view 56
starting up applications from 56
application language，选择 304
application 8, 55-66
active 57
default font for，选择 309
hiding 59
in the dock
- locating 61
- removing 60-61
- reordering 60
starting up 56
NEXTSTEP 66
quitting 64
running several at once 57
service of，要求 63
starting up automatically 62
startup，for a file
- changing 103
determining 36
switching to another 58
See also specific application
archiving
- faxes 262, 284
- Mail messages 203, 229
Arrange in Front command 339
Assign command 348
Assign to Me command 348
attention panel 21
auto-indentation，设置 in Mail 229
B
Backspace key 124, 126
- battery power，使用 324
- baud rate，设置 for printers 269
blind carbon copy of a Mail message 203
Bold command 338
bookshelf in Digital Librarian 173
- adding targets to 181
- creating 185
Bookshelf menu 345
boot disk 4
brightness keys 317
brightness of screen，调整 317, 320
browser 39
Browser command 343
browser view in the File Viewer 39
- adjusting column width in 50
bulleted paragraph，录入 137
busy cursor 8
buttons 10-11
- adding link 159
dimmed 11
C
Cancel button 21
Cancel command 360
carbon copy of a Mail message 200
CD-ROM
- icon for 109
- NEXTSTEP，内容 297
Center command 339
changes in a file，保存 29, 74-75
characters
- repeat rate for typing，设置 318
Symbol font 363
See also special characters
Check for Disks command 108-109, 342
Check Spelling command 337
Choose Cursor command 349
Clean Up Icons command 343
clicking 9
close button 29
Close command 336
Close Window command 339
CMYK color model 146
color models 146-147
color palettes
- adding an image to a list of 149
- using images as 148
color swatches 142
- creating 143
color well 142
color wheel 144
colors 141-153
in a document, using 142
layers of 150
list of 152-153
mixing custom 146-147
of the background display,
changing 321
opacity of 150
PANTONE, simulating 151
printing 144
selecting
from an image 148
from the color wheel 144
from the screen 145
transparency of 150
Colors command 338
locating 143
Combine Messages command 199, 354
Command key
NeXTUSA keyboard arrangement 317
USA keyboard arrangement 124
using to choose commands 12
Command-key equivalent 12
creating 310
commands 8, 12
choosing 12-13
from a pull-down list 10
dimmed 13
standard 336-340
See also specific command
Compact command 355
Compose button 200, 208, 209, 351
Compose menu 355
Compress command 342
cursor 8
busy 8
copy 83, 85
I-beam 8, 123
in the Grab application, choosing 164
link 88
moving the 9
question mark 8, 14
Cut command 127, 337
Console command 343
Copy command 127, 337
Copy Font command 338
Copy Ruler command 339
copying
files and folders 83
to or from a disk 112
graphic images 127
links, Workspace Manager 90, 97
text 127
Copyright command 345
cover sheet for a fax 246, 247
Create button
in a Fax Modems window 274, 361
in a Printers window 268, 270, 361
creating
address book in Mail 218
bookshelf in Digital Librarian 185
color list 152-153
color swatch 143
Command-key equivalent 310
fax cover sheet 247
file 69-77
folder 81
group address in Mail 219
headers for Mail messages 226-227
link, Workspace Manager 88
mailbox 220
on-line addresses 188
group of 189
TIFF file 164-168
current folder 33, 36
current view in the File Viewer 34
current view in the Workspace Manager 88
deleted Mail messages
showing 215, 352
undeleting 215
deleting
file 92
corpus 92
graphic images 126
Installer package 299
Mail messages 214
mailbox 220
text 126
Deliver button 200, 351
Deliver command 355
Destroy command 342
developers, Mail preferences for 230
dictionary, spelling 139
See also Digital Webster application
Digital Librarian application 66, 173,
176-187
commands 344-345
indexes, how they’re used 184
looking up information with 176
searching with
choosing a language for 180
options for 177
sorting results of 179
viewing results of 178
starting up 173
target
adding to the bookshelf 181
indexing for searches 182-183
selecting 176
D
Date & Time Preferences 306, 307
date, setting 306
Decode Foreign Attachment command 354
definitions, looking up in Digital Webster 174-175
Delete button 351
Delete command 126, 337
deleted Mail messages
showing 215, 352
undeleting 215
deleting
file 92
corpus 92
graphic images 126
Installer package 299
Mail messages 214
mailbox 220
text 126
Deliver button 200, 351
Deliver command 355
Destroy command 342
developers, Mail preferences for 230
dictionary, spelling 139
See also Digital Webster application
Digital Librarian application 66, 173,
176-187
commands 344-345
indexes, how they’re used 184
looking up information with 176
searching with
choosing a language for 180
options for 177
sorting results of 179
viewing results of 178
starting up 173
target
adding to the bookshelf 181
indexing for searches 182-183
selecting 176
Digital Webster application 66, 172, 174–175
commands 346
looking up definitions or synonyms in 174–175
starting up 172
using as a service in the Services menu 175, 339
Disable Image Caching command 360
Disk menu 342
disk space
freeing up 116
monitoring in file system 116
taken up by faxes 257
taken up by Mail messages 196
disks 107–118
appearance in file system, options for 111
copying files to and from 112
DOS 108, 113, 365
ejecting 117, 118
icons for 109, 113
Macintosh 108, 113
opening in a folder window 111
See also CD-ROM, disks, floppy and
disks, hard
disks, floppy
icons for 109, 113
initializing 110, 115
inserting 108–109, 118
naming 110
opening and saving files on 118
reusing 115
disks, hard
freeing space on 116
icon for 109
Display menu
in FaxReader 348
in Preview 360
Display Preferences 320, 321
display, changing background color 321
dock See application dock
Document menu 336
documents
adding graphic images to 156–157
adding link buttons to 159
using color in 142
See also files
domains on a network 279
DOS disks 108, 113, 365
DOS files 364–365
DOS, running on the computer 17
dot files 313
double-click delay, changing 319
double-clicking 9
down arrow button 195, 351
draft of a Mail message
restoring 207
saving 206
Drafts mailbox 206–207
Drafts menu 355
dragging 9
Draw Page command 360
Duplicate command 342
DOS
DOS files 364–365
DOS, running on the computer 17
DOS, running on the computer 17
dot files 313
double-click delay, changing 319
double-clicking 9
down arrow button 195, 351
draft of a Mail message
restoring 207
saving 206
Drafts mailbox 206–207
Drafts menu 355
dragging 9
Draw Page command 360
Duplicate command 342

E
Edit application 66
commands 347
how it saves a backup file 75
starting up 122
See also documents and files
Edit main menu 347
Edit menu 337
in Mail 356
in the Workspace Manager 342
editing text 121–139
Eject command 117, 342
Emacs commands, enabling in Mail 229
Empty Recycler command 92, 93, 342
Encapsulated PostScript (EPS)
format 157
See also EPS file
encoded file or folder
receiving in Mail 199
sending in Mail 205
Enter Selection command 337
EPS file 36, 157, 240
icon for 38
previewing 101
sending in a Mail message 201
See also graphic images
Escape key
NeXTUSA keyboard arrangement 317
USA keyboard arrangement 124
using to type Mail addresses 201
using to type pathnames 48
Expert Preferences 312, 313, 330, 331, 332, 333
extensions
of chunks 114
of file names 36, 72
F
fax address
selecting 245
updating 251
See also on-line address
fax archive
options for 284
retrieving a fax from 262
Fax menu 348
Fax Modem command 256, 348
fax modem log 263
fax modems
access to, setting 281
adding 274–275
choosing 248
managing 265–285
modifying 276
options for, setting 283
removing 277
sharing 278–279
Fax Modems command 250, 361
Fax panel 244–245
fax phone numbers 244
fax queue, managing 250
faxes 243–263
access to
sharing 280–281
types of 255
addresses for
selecting 245
updating 251
archived, retrieving 262
archiving, setting options for 284
assigning new 261
checking for 256–257
cover sheet for 246, 247
disk space taken by 257
display of, changing 259
opening 258
phone numbers for, typing 244
printing automatically 282
range of pages, selecting 245
saving 260
sending 243–251
sending scheduled 249
FaxReader application 66, 253–263
commands 348
starting up 254–255
FaxReader menu 348
File menu
in Digital Librarian 345
in the Workspace Manager 342
file names 32
changing 82
DOS and Macintosh 364
extensions of 36
guidelines for choosing 72
file operations 81–97
managing several at once 95
solving problems during 96–97
file packages 47, 100
file system 32
as seen in the File Viewer 33
displaying large 312
DOS 364–365
icons in 38
Macintosh 364–365
File Viewer 8, 33
browser view in 39
current view in 34
icon view in 34
listing view in 40–41
personalizing 50–51
shelf 33, 42, 51
using 31–53
files 8, 32
application that opens 36
changing 103
assigning to a new group 104
browsing 39
compressing 91
copying 83
to and from a disk 112, 114
creating 69–77
decompressing 91
deleting 92
distinction from links and file packages 100
DOS 113, 364–365
EPS 36, 38, 157, 240
finding 48–49
handling several at once 94
in a Mail message
opening 197
sending 204–205
information about, getting 100
inspecting 99–105
linking 88
Macintosh 113, 364–365
moving 84–85
naming 72
opening 36–37, 43, 71
in another application 103
files (continued)
permissions for
changing 105
setting global 330
plain text 36, 38, 364
PostScript (PS) 157, 240
previewing contents of 101
printing 236
preparing for 234–235
renaming 82
replacing 86
retrieving from the recycler 93
RTF 36, 38, 364
saving 69–77
another version of 76
changes in 29, 74–75
tax as 260
new 72–73
selecting several at once 44–45
sorting 102
TIFF 38, 157, 164–168
Find button, in a mailbox window 222, 223, 351
Find menu 337
in Digital Webster 346
in Mail 356
Find Next command 337
Find Panel command 128, 129, 337
Find Previous command 337
Finder command 48–49, 343
floppy disks See disks, floppy
Focus command 223, 353
folder names 32
changing 82
guidelines for choosing 72

377
Index

folder window
  opening disks in 111
  opening for a file package 47
  opening for a folder 46
folders 32
  assigning to a new group 104
  browsing 39
  compressing 91
  copying 83
to and from a disk 112, 114
  creating 81
  current 33, 36
  decompressing 91
  deleting 92
dimmed 38
  finding 48–49
  handling several at once 94
home folder 33, 290
in a Mail message
  opening 197
  sending 204–205
information about, getting 100
inspecting 99–105
linking 88
Local 290
merging 87
moving 84–85
naming 72
NeXT 290
opening 34–35, 43, 46
permissions for
  changing 105
  setting global 330
renaming 82
replacing 86
retrieving from the recycler 93
root 32
selecting several at once 44–45
size of, computing 100
sorting 102
font 134
default for applications, setting 309
default in Compose windows 357
of message summaries in Mail 357
previewing 135
setting a new 132–133
system, changing 308
font family 134
Font menu 338
  in Mail 357
Font Panel command 132–133, 135, 338
Font Preferences 308, 309
Format menu 338
  in Mail 356
Forward button 208, 351
Forward command 355
G
Get Mail button 351
Get New Mail command 353
Grab application 66, 164–169
  commands 349
  starting up 164
  See also grabbing
Grab main menu 349
Grab menu 349
grabbed images, inspecting 169
grabbing
  entire screen 165
  portion of the screen 168
  screen with a time delay 166
  transparency 167
  window 167
graphic images 155–169
  adding to documents 156–157
  copying 127
  deleting 126
  file formats of 157
  grabbing 165–168
  linking 158
  moving 127
  previewing 163
  publishing as link files 160
  replacing 126
  sending in a Mail message 201
  using as color palettes 148, 149
grayscale 147
group
  assigning files and folders to 104
  of on-line addresses, creating 189
  permissions for, changing 105
  See also group address
group address
  creating your own in Mail 219
  replying to a private, in Mail 229
  sending a fax to 244
  sending a Mail message to 200
H
handshake options for printers 269
hanging indent, creating 137
hardware, managing 315–325
headers in Mail messages
  creating 226–227
  displaying 196, 228
Help command 15, 336
Help panel, buttons in 15
help, getting on-line 14–15
hidden copy of a Mail message, sending 203
Hide command 59, 336
hiding an application 59
HP JetDirect printer, adding 270–271
HSB color model 147
hue 144
I
I-beam cursor 8, 123
Icon command 343
icon path 33
icon view in the File Viewer 34
   adjusting spacing in 50
icons 8, 33
   for a remote MIME attachment 199
   for disks 109, 113
   for NEXTSTEP applications 66
   in the file system 38
images See graphic images
indentation
   creating hanging 137
   setting 136–137
indentation markers 137
index in Digital Librarian 182–183, 184
Info menu 336
Info Panel command 336
Info view in Installer 292
Initialize command 115, 342
initializing disks 110, 115
input gain, adjusting 322
insertion point 123
Inspector command
   in Digital Librarian 186, 345
   in FaxReader 348
   in Grab 169, 349
   in the Workspace Manager 100–105, 343
Installer application 66, 292–299
   commands 350
   starting up 292–293
Installer menu 350
Installer packages 292
Italic command 338
K
key window 22
keyboard
   basics of using 124
   repeat rate for, setting 318
   See also keyboard arrangement
keyboard alternative See Command-key equivalent
keyboard arrangement
   NeXTUSA 5, 317
   selecting 5, 316
   USA 124
Keyboard panel 131, 316
Keyboard Preferences 318
L
language, selecting 5, 304
left margin, setting 136
Legal command 341
Librarian menu 344
link button, adding 159
link file, publishing an image as 160
Link Inspector command 161, 338
Link menu 337–338
linked graphic image
   adding 158
   editing 161
   updating 161
   when you can use 158
links in the Workspace Manager 89
   copying 97
      setting options for 90
      creating 88
      icon for broken 38
      inspecting 100
Lip Service button 210, 351
Lip Service command 355
Listing command 40, 343
listing view in the File Viewer 40, 41
Localization Preferences 304, 305, 316
Log command 350
Log Out command 16, 341
   when it doesn’t work 17
Log view in Installer 296
log, fax modem 263
logging in 4, 6
   options for 334
logging out 16
Login Window Preferences 334
M
Macintosh disks 108, 113
Macintosh files 364–365
Mail address
   entering in messages 200, 216
      shortcuts 201, 217
   group
      creating 219
      replying to a private 229
   looking up 216–217
   shorthand, creating 219
   types of 216
Mail application 66, 193–211, 213–230
   buttons 351
   commands 352–357
   creating an address book in 218
creating mailboxes in 220
Expert Preferences for 230
looking up addresses in 216–217
opening messages in 195
options for showing information about messages 196
   starting up 194
Mail menu 352
Mail messages See messages, Mail
mailbox
   Active 194
   compacting to free disk space 215
   creating 220
deleting 220
Drafts 206–207
finding messages in 222–223
opening 220
organizing messages in 220–221
showing message sizes and totals 196, 352
Index

Mailbox menu 353
Mailboxes button 220, 351
Mailboxes command 353
main menu 12
main window 22
Make ASCII command
  in Edit 347
  in Mail 355
Make RTF command 347
margin markers 136
margins, setting 136–137
Mark as Unread command 354
measurement, changing units of 305
Menu Preferences 303, 310
menus 8, 12
  choosing a standard location for 303
  hiding 303
merging folders 87
Message menu 354
message summaries in Mail
  setting the font of 357
  sorting 353
messages, Mail
  addressing 200, 216
    shortcuts 201, 217
  announcing new with a sound 225
  archiving 203, 229
  deleting 214
  deleting sound from 210
  encoded attachments in 199
  finding 222–223
  forwarding 208
  headers in
    creating 226–227
    displaying 196, 228
  information about, showing 196
messages (continued)
  listening to a recording in 198
  marking as unread 196
  MIME 199, 202
  opening 195
  opening a file or folder in 197
  organizing in mailboxes 220–221
  plain text 199, 202, 205, 230
  read receipt for 229, 351
  receiving, tailoring how 224
  replies, rerouting 203
  replying to 209, 229
  restoring a draft of 207
  saving a draft of 206
  selecting 214
  sending 200–203
    carbon copies of 200
    files or folders in 204–205
    graphic images in 201
    hidden copies of 203
    sound in 210
    to non-NEXTSTEP computers 202
  sizes of, showing 196, 352
  sorting 222
  total in a mailbox, showing 196, 352
  undeleting 215
  MIME Mail button 351
  MIME menu 354
  MIME messages 199, 202
  miniaturize button 28
  Miniaturize Window command 339
  miniwindow 28
  Modify button
    in a Fax Modems window 280, 282, 283, 284, 361
    in a Printers window 276, 277, 278, 361
  mouse 9
    changing responsiveness of 319
    changing speed of 319
  Mouse Preferences 303, 319

N
naming
  disk 110, 115
  file 72
  folder 72, 81
  headers in Mail messages 227
NetWare network 53, 272
NetWare printer, adding 272–273
NetWareManager application 272
network 52
  NetWare 53
  New Address command 342
  New Folder command 81, 342
  New Group command 342
  New Viewer command 343
  NeXT Mail button 351
  NeXTUSA keyboard arrangement 5, 317
No Receipt button 351
nonbreaking space 362

O
OK button 21
on-line address
  adding 189
  looking up 188
  updating for faxes 251
on-line references, using 171–189
  See also Digital Librarian application
  and Digital Webster application
Opacity slider 150
Open as Folder command 46, 47, 342
Open command 71, 336
Open File command 345
Open Folder command 345
Open in Workspace command 340
opening
fax 258
file 36-37, 71
folder 34-35
folders and files
by typing 43
on a floppy disk 118
Mail message 195
mailbox 220
orientation, changing for printing 234
Outgoing mailbox 203, 229

password
choosing, guidelines for 329
setting 328-329
using to log in 6
Password Preferences 328
Paste and Link command 158, 337
Paste command 127, 337
Paste Font command 338
Paste Link Button command 159, 337
Paste Ruler command 339
pathnames 32
pasting in a plain text Mail message 205
shortcuts typing 48
typing in the Save panel 73
permissions
for DOS files 365
for files and folders 80
changing 105
seeing in the listing view 41
setting global 330
for Macintosh files 365
for working with faxes 280
pixel 145
pixel depth 169
Plain Text button 351
plain text file 36
DOS 364
icon for 38
Macintosh 364
plain text Mail message 202
decoding a file in 199
encoding a file in 205
line length of, setting a limit 230
sending 202
pop-up lists 10
ports, choosing for printers 269
PostScript (PS) file 157, 240
saving a file as 240-241
PostScript (PS) format 157, 240-241
PostScript Printer Description (PPD) files 267, 297
power consumption, managing the computer's 324
Power Management Preferences 324
Preferences application 66, 131
buttons 358-359
commands 358-359
Date & Time Preferences 306, 307
Display Preferences 320, 321
Expert Preferences 312, 313, 330, 331, 332, 333
Font Preferences 308, 309
Keyboard Preferences 318
Localization Preferences 304, 305, 316
Login Window Preferences 334
Menu Preferences 303, 310
Mouse Preferences 303, 319
Password Preferences 328
Power Management Preferences 324
Services Preferences 311
Sound Preferences 322, 323
starting up 302
Startup Preferences 325
Preferences command
in Digital Librarian 344
in Digital Webster 346
in Edit 347
in Installer 350
in Mail 352
in the Workspace Manager 50, 61, 62, 90, 111, 341
Preferences menu 359
pressing 9
Preview application 66, 162, 163
commands 360
Preview menu 360
previewing
contents of a file 101
font 135
Print command 236, 336
print queue
  checking 238
  managing 239
printer
  adding 268–271
  changing settings of 276
  HP JetDirect, adding 270–271
  managing 265–285
  NetWare, adding 272–273
  removing 277
  selecting 236
  sharing 278–279
  testing 285
Printers command 238, 361
printing 233–241
  colors 144
  file 236
  options for 237
  orientation for, changing 234
  paper size, changing 234, 305
  paper source, choosing 237
  pausing during 239
  preparing files for 234–235
  range of pages 236
  resolution 237
PrintManager application 66, 266–271,
  274–285
  buttons 361
  commands 361
  starting up 266
PrintManager menu 361
problems
  if Log Out command doesn't work 17
  if Quit command doesn't work 65
  working with files and folders 96–97
Processes command 65, 95, 343
Progress command 350
Progress view in Installer 295
Pronunciation command 346
pronunciation, looking up in Digital Webster 174
PS file See PostScript (PS) file
public sound server 332
public window server 331
Publish Selection command 160, 337
pull-down lists 10
Q
  Queue button
    in a Fax Modems window 250, 361
    in a Printers window 238, 361
Quit command 64, 336
  when it doesn’t work 65
R
  read receipt for a Mail message 229, 351
Receipt button 351
recording See sound
recorder 56, 92
  emptying 92
  removing from the dock 61
retrieving a file or folder from 93
references, using on-line 171–189
renaming
  disk 115
  file or folder 82
Repeat box in Processes panel 97
repeat rate for typing characters, setting 318
replace options in Edit and Mail 129
Reply All button 209, 351
Reply All command 355
Reply button 209, 351
Reply command 355
resize bar 20, 25
resolution for printing 237
resource forks, Macintosh 365
restarting the computer 16–17
  to free up disk space 116
Restore Draft command 355
restricted access to faxes 255
Revert to Saved command 336
RGB color model 146
Rich Text Format (RTF) 36
  See also RTF file
right margin, setting 136
root folder 32
  icon for 38
RTF file 36
  DOS 364
  icon for 38
  Macintosh 364
  previewing 101
  that's a file package 47
ruler, use of 136–137
S
  saturation, color 144
Save All command 74, 336
Save As command 76, 336
Save command 72, 74, 336
Save in Drafts command 355
Save To command 76, 336
saving 77
  before logging out 16
  Edit documents 75
  fax 260
  file
    another version of 76
    changes in 29, 74–75
    new 72
    on a floppy disk 118
    PostScript (PS) version of 240–241
Mail message, draft of 206
tips for 75
screen brightness, adjusting 320
colors on, selecting 145, 321
fonts on, changing 308
image of, grabbing a portion of 168
the entire 165
, with a time delay 166
Screen command 165, 349
screen saver, setting 320
scroll bar 26
scroll button 26
scroll knob 27
scroller 20, 26
scrolling 26-27
search options
in Digital Librarian 177
in Edit and Mail 128
search service with Digital Librarian 186
searching
for files and folders 48-49
for help by keyword 15
for information in Digital Librarian 176-177
for Mail addresses 217
for Mail messages 222-223
for PANTONE Colors 151
for text 128
Select All command 337
Select Page Number command 348
selecting (continued)
Mail messages 214
paragraph 125
printer 236
several files and folders 44-45
target in Digital Librarian 176
text 125
window to work in 22
word 125
Selection command 168, 349
Send Options command 203, 355
server 52
service, requesting from another application 63
Services menu 339-340
customizing 311
in Mail 357
Services Preferences 311
shelf, File Viewer 33
adding files or folders to 42
adjusting space on 51
enlarging 42, 51
removing files or folders from 42
Show All Alternatives command 199, 354
Show All Headers command 196, 354
Show Best Alternative command 354
Show Deleted command 215, 353
Show First Alternative command 199, 354
Show Links command 338
Show Ruler command 136, 339
Show Sizes command 196, 353
sliders 11
software
installing new 289-299
where to install new 290-291
software packages, where to find 297
Sort by Date command 353
Sort by Name command 353
Sort by Number command 353
Sort by Size command 353
Sort by Subject command 353
Sort Icons command 343
sorting
files 102
folders 102
Mail messages 222
Sorting menu 353
sound
for the system beep, setting 323
in a Mail message
deleting 210
editing 211
listening to 198
recording 210
input gain of, adjusting 322
to announce new Mail messages, setting 225
volume of, adjusting 322
Sound Preferences 322, 323
sound system, sharing 332
special characters 362
changing the font of 133
previewing 131
typing 130
Spelling command 138, 337
spelling, checking 138-139
standard window 20
startup disk 4
Startup Preferences 325
submenus 12
detaching 13
Subscript command 338
Superscript command 338
swatches See color swatches
Symbol font characters 363
synonyms, looking up in Digital Webster 174-175
system administrator 4
Mail preferences for 230
system beeps and warnings, changing 323
system files 4
Index

T

tab markers 137
tabs, setting 136–137
Tag Image File Format (TIFF) 157
   See also TIFF file
target
   in the Finder 48–49
   indexing for Digital Librarian searches 182–183
   selecting in Digital Librarian 176
Target menu 345
Terminal application 46
Test button 285, 361
text
   copying 127
   deleting 126
   finding 128
   font of, changing 132–133
   moving 127
   replacing 126
      with the Find panel 129
   selecting 125
   spelling, checking 138–139
   typing 123
text field 11
Text menu 338–339
   in Edit 347
TIFF file 157
   creating 164–168
   icon for 38
   sending in a Mail message 201
time, setting 307
Timed Screen command 166, 349
title bar 20
   dragging to move a window 24
Tools menu 343
transparency 150
   grabbing an image of 167
troubleshooting See problems
turn Sound Off command 349
turning the computer 16
   automatically 325
typeface 134
   See also font
typing text 121–139
   repeat rate for, setting 318
U
Unbold command 338
Undelete command 354
Underline command 338
Undo command 337
Unfocus command 353
unhiding the Workspace Manager 59
Unitalic command 338
units of measurement, changing 305
UNIX files, displaying 313
UNIX regular expressions 128
unrestricted access to faxes 255
Unscript command 338
up arrow button 195, 351
Update Viewers command 343
USA keyboard arrangement 124
user name 6
V
View menu 343
views in Installer
   Info 292
   Log 296
   Progress 295
views in the File Viewer
   browser 39
   current 34
   icon 34
   listing 40, 41
volume keys 317
W
waveform, editing 211
Webster menu 346
window 5, 19–29
   closing 29
   grabbing an image of 167
   key 22
   main 22
   miniaturizing 28
   moving 24
   reordering 23
   resizing 25
   scrolling to see more 26–27
   selecting 22
   standard 20
   types of 20–21
Window command 167, 349
Windows menu 339
word wrap 123
word, selecting 125
work session, starting and ending 3–17
workspace 4, 8
   personalizing 301–313
   sharing 331
Workspace Manager 8, 32–53, 61–62, 65, 80–117, 188–189
   commands 341–343
   unhiding 59
Workspace menu 16, 341
Z
Zoom In command 360
Zoom Out command 360